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SPECTRA SOFTWARE PRODUCT END USER 

LICENSE AGREEMENT (“EULA”)

IMPORTANT, READ THIS AGREEMENT CAREFULLY. BY INSTALLING OR US-
ING ALL OR ANY PORTION OF THE SOFTWARE, YOU ARE ACCEPTING ALL OF 
THE TERMS AND CONDITIONS OF THIS AGREEMENT. YOU AGREE THAT 
THIS AGREEMENT IS ENFORCEABLE LIKE ANY WRITTEN AGREEMENT.

IF YOU DO NOT AGREE TO ALL OF THESE TERMS AND CONDITIONS, DO NOT 
USE OR ACCESS THE SOFTWARE.

IF YOU HAVE PAID A LICENSE FEE FOR USE OF THE SOFTWARE AND DO NOT 
AGREE TO THESE TERMS, YOU MAY RETURN THE SOFTWARE (ALONG WITH 
ANY HARDWARE ON WHICH IT WAS EMBEDDED, IF APPLICABLE) FOR A 
FULL REFUND PROVIDED YOU (A) DO NOT USE THE SOFTWARE AND (B) RE-
TURN THE SOFTWARE WITHIN THIRTY (30) DAYS OF YOUR INITIAL PUR-
CHASE.

IF YOU WISH TO USE THE SOFTWARE AS AN EMPLOYEE, CONTRACTOR, OR 
AGENT OF A CORPORATION, PARTNERSHIP OR SIMILAR ENTITY, THEN YOU 
MUST BE AUTHORIZED TO SIGN FOR AND BIND THE ENTITY IN ORDER TO 
ACCEPT THE TERMS OF THIS AGREEMENT. THE LICENSES GRANTED UN-
DER THIS AGREEMENT ARE EXPRESSLY CONDITIONED UPON ACCEPTANCE 
BY SUCH AUTHORIZED PERSONNEL.

IF YOU HAVE ENTERED INTO A SEPARATE WRITTEN LICENSE AGREEMENT 
WITH US FOR USE OF THE SOFTWARE, THE TERMS AND CONDITIONS OF 
SUCH OTHER AGREEMENT SHALL PREVAIL OVER ANY CONFLICTING 
TERMS OR CONDITIONS IN THIS AGREEMENT.

This Spectra Software Product End User License Agreement (“Agreement”) is 
between You and us (both being defined below) (each a “Party” and collectively 

the “Parties”). This Agreement covers any Software and supporting technical 
documentation provided with the Software (“Documentation”).

1.Definitions. 

“Affiliate” shall mean any entity that directly or indirectly through one or more 
entities, controls, is controlled by, or is under common control with a Party.  For 
purposes of this definition, the term "control" as applied to any entity, means the 
possession, directly or indirectly, of the power to direct or cause the direction of 
the management of that entity, whether through ownership of voting securities 
or otherwise.

“Effective Date” means the earlier of the date You sign an Order Form or the 
date on which the Software is first made available to You.

“Order Form” means any order which is entered into by us (or an authorized 
Spectra products distributor or reseller) and You under which You are provided 
the Software. Each Order Form for the Software shall be deemed a part of this 
Agreement. This Agreement is binding on You whether or not You executed an 
Order Form with us. Order Forms may not vary the terms of this Agreement. Only 
a written agreement, signed by us (not a Spectra products distributor or reseller) 
may vary the terms of this Agreement.

“Software” means the Spectra software product(s) provided in connection with 
this Agreement in object code form (or as otherwise specified in any related Or-
der Form). “Software” shall also include any releases provided to or purchased 
by You under any separate support and maintenance agreement You may enter 
into with us. Unless otherwise noted, the Software and Documentation are re-
ferred to collectively herein as “Software”.

“Our”,  “we” and “us” means Trimble Inc. (935 Stewart Drive, Sunnyvale, Cal-
ifornia 94085, U.S.A.) and/or its Affiliates, including, without limitation, Trim-
ble Europe B.V. (Meerheide 45, 5521 DZ Eersel, The Netherlands);

“Supplier” means either us or an authorized distributor or reseller of Spectra 
products or services which has entered into an Order Form with You.

“Third-Party Software” means any third-party software that we provide to You  
under this Agreement or under separate terms and conditions.

“You” means the customer (individual or entity) that has downloaded or other-
wise procured the licensed Software for use as an end user.

2.License.

2.1.Grant of License. Subject to all of the terms and conditions of this Agree-
ment, we grant You a non-transferable, non-sublicensable, non-exclusive license 
to use the Software in machine-readable form on any computer and operating 
system for which it was intended, but solely (a) for your own internal business 
purposes at the location specified in the applicable Order Form or otherwise 
agreed to by us (the “Site”); (b) in accordance with the Documentation; and (c) 
in accordance with any additional license term, subscription term or other user, 
seat, computer, field of use or other restrictions set forth in the applicable Order 
Form or otherwise specified by us.

2.2.Installation and Copies. We shall make available the Software and Docu-
mentation by disk, other media, or as embedded in a device, or make it available 
for download in electronic form. We shall also provide You with electronic pass-
words or other enabling mechanisms if necessary to permit the licensed usage 
of the Software. All licenses shall commence, and delivery shall be deemed to 
occur, as of the Effective Date (or, if later, such date on which the Software and 
license keys are first made available to You). If your Order Form is with a Spectra 
products distributor or reseller, that distributor or reseller (and not us) is solely 
responsible for delivery to You and we have no liability for any failure to deliver. 
If the Software requires license keys to operate as licensed to You, our applica-
ble Supplier will deliver such license keys to You.

2.3.Software Intended to be Installed on Computers. The Software is licensed 
as a single product.  You may not separate its component parts for use on more 
than one computer except as specifically authorized in this Agreement.  You may 
copy and install on your computers for use only by your employees the number 
of copies of the Software for which You have paid the applicable license fee or 
have been authorized in writing by us.  You may transfer the Software from one 
computer to another computer provided that the computer to which the Software 
is transferred is located at the Site and the Software is completely removed and 
de-installed from the prior computer.  If You are permitted by us to install the 
Software on a network server, and You transfer the Software from the Site to a 
new location, You must provide us with written notice of the new site prior to 
such transfer.  You may also make a reasonable number of copies of the Software 
only for back-up and archival purposes. This Paragraph 2.3 does not apply to 
any software embedded on our devices.

2.4.License Restrictions.

2.4.1.You shall not (nor shall allow any third party to): (a) decompile, disassem-
ble or otherwise reverse engineer the Software or attempt to reconstruct or dis-
cover any source code, underlying ideas, algorithms, file formats or 
programming interfaces of the Software by any means whatsoever (except and 
only to the extent that applicable law prohibits or restricts reverse engineering 
restrictions). To the extent any applicable mandatory laws give You the right to 
perform any of the aforementioned activities without our consent in order to gain 
certain information about the Software for purposes specified in the respective 
statutes (e.g., interoperability), You hereby agree that, before exercising any 
such rights, You shall first request such information from us in writing detailing 
the purpose for which You need the information.  Only if and after we, at our sole 
discretion, partly or completely deny your request, may You exercise such stat-
utory rights; (b) distribute, sell, sublicense, rent, lease or transfer the Software 
(or any portion thereof), nor use the Software (or any portion thereof) for time 
sharing, hosting, service provider or like purposes; (c) provide the Software to a 
third party on a temporary basis and/or use the Software for the benefit or pur-
poses of a third party whether by means of lease, loan, data processing services 
(e.g. “fee for service”) or otherwise, unless You are a reseller of Spectra products 
under separate written agreement with us and authorized by us to do so; (d) re-
move any product identification, proprietary, copyright, or other notices con-
tained in the Software; (e) modify any part of the Software, create a derivative 
work of any part of the Software, or incorporate the Software into or with other 
software, except to the extent expressly authorized in writing by us; (f) attempt 
to circumvent or disable the security key mechanism that protects the Software 
against unauthorized use (except and only to the extent that applicable law pro-
hibits or restricts such restrictions) and/or any licensing control features; or (g) 
publicly disseminate performance information or analysis (including, without 
limitation, benchmarks or comparison testing or analysis) from any source relat-
ing to the Software or disclose to any third-party or release any results thereof 
(all of which information shall be considered our confidential information) with-
out our prior written consent.

2.4.2 If the Software has been provided to You as embedded in any hardware 
device, You are not licensed to separate the Software from the hardware device. 
If the Software has been provided to You separately from a hardware device but 
is intended to be loaded onto a hardware device specified by us (such as a firm-
ware update), your license is limited to loading the Software on the device spec-
ified by us in the Documentation, and for no other use.

2.4.3 You agree to use all reasonable efforts to prevent unauthorized use and 
disclosure of the Software.

2.5.Evaluation Software. Subject to the terms and conditions of this Agreement 
and during its term, we may, in our discretion, provide You with pre-release, beta 
or other software on an evaluation basis (“Evaluation Software”). You may use 
Evaluation Software solely for internal evaluation purposes for thirty (30) days 
from receipt of the Evaluation Software (unless otherwise agreed with us in writ-
ing) (the “Evaluation Period”). Unless You pay the applicable license fee for the 
Software, the Evaluation Software may become inoperable and, in any event, 
your right to use the Evaluation Software automatically expires at the end of the 
Evaluation Period. Evaluation Software shall be subject to all restrictions on 



Software set forth in this Agreement. You shall treat all Evaluation Software as 
Confidential Information of us and shall return or destroy any copies of Evalua-
tion Software upon expiration of the applicable Evaluation Period.  Any and all 
suggestions, reports, ideas for improvement and other feedback of any type You 
provide regarding the Evaluation Software are our sole property, and we may use 
such information in connection with any of our products or services without any 
obligation or restriction based on intellectual property rights or otherwise.  You 
acknowledge that all Evaluation Software is provided “AS IS” and may not be 
functional on any machine or in any environment.  THE WARRANTIES OF SEC-
TION 5 DO NOT APPLY TO EVALUATION SOFTWARE. WE AND OUR SUPPLI-
ERS DISCLAIM ALL WARRANTIES RELATING TO THE EVALUATION 
SOFTWARE, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE OR 
NON-INFRINGEMENT.

2.6.Internet-Based Services Components. Some features of the Software may 
require connection to the Internet directly or through a wireless connection in 
order to function. Such features may result in the transfer of certain data over 
such connections, which may or may not be secured or encrypted. You are solely 
responsible for obtaining any necessary Internet wireless subscription plans with 
the applicable service providers. You further acknowledge that we are not re-
sponsible for the availability of Internet or wireless connections or the security 
or integrity of data transmitted over such connections.

2.7.Ownership. Notwithstanding anything to the contrary contained herein, ex-
cept for the limited license rights expressly provided herein, we, our licensors 
and suppliers have and will retain all rights, title and interest (including, without 
limitation, all patent, copyright, trademark, trade secret and other intellectual 
property rights) in and to the Software and all copies, modifications and deriva-
tive works thereof (including any changes which incorporate any of your ideas, 
feedback or suggestions). You acknowledge that You are obtaining only a limited 
license right to the Software and that irrespective of any use of the words “pur-
chase”, “sale” or like terms hereunder no ownership rights are being conveyed 
to you under this Agreement or otherwise.

2.8.Copyright. All title, rights and copyrights in and to the Software (including, 
but not limited to, any images, photographs, animations, video, audio, music, 
and text incorporated into the Software, as well as all intellectual property 
rights), the Documentation and other accompanying written materials, and any 
copies of the Software are owned by us, our licensors and/or suppliers.  You shall 
not remove, cover, or alter any of our patent, copyright, or trademark notices 
placed upon, embedded in, or displayed by the Software or on its Documenta-
tion, packaging and related materials.

3.Payment. Unless a Software has been made available by us at no charge, You 
shall pay all fees associated with the Software licensed and any services pur-
chased hereunder as set forth in the applicable Order Form. All payments shall 
be made in the currency specified in the applicable invoice within thirty (30) 
days of your receipt of such invoice, unless otherwise specified in writing by our 
Supplier. Except as expressly set forth herein, all fees are non-refundable once 
paid. You shall be responsible for all taxes, withholdings, duties and levies aris-
ing from the order (excluding taxes based on the net income of our Supplier). 
Any late payments shall be subject to a service charge equal to 1.5% per month 
of the amount due or the maximum amount allowed by law, whichever is less.

4.Term of Agreement.

4.1.Term. This Agreement is effective as of the Effective Date and expires at 
such time as all license and service subscriptions hereunder have expired in ac-
cordance with their own terms (the “Term”). Either Party may terminate this 
Agreement (including all related Order Forms) if the other Party: (a) fails to cure 
any material breach of this Agreement within thirty (30) days after written notice 
of such breach; (b) ceases operation without a successor; or (c) seeks protection 
under any bankruptcy, receivership, trust deed, creditors arrangement, compo-
sition or comparable proceeding, or if any such proceeding is instituted against 
such Party and not dismissed within sixty (60) days. If You have entered into a 
separate written agreement with us which governs the Software and that agree-
ment is terminated, then this Agreement automatically terminates and You shall 
no longer have any right to use the Software. Termination is not an exclusive 
remedy and the exercise by either Party of any remedy under this Agreement will 
be without prejudice to any other remedies it may have under this Agreement, 
by law, or otherwise. For clarity, even if You have entered into an Order Form with 
a Spectra products distributor or reseller, we are a third party beneficiary to that 
Order Form and has the right to terminate this Agreement as set forth in this 
Section 4 (Term of Agreement).

If a Software has been made available by us at no charge, the license remains 
effective until terminated in accordance with subparagraphs (b) and (c) men-
tioned above; You decide to terminate this Agreement by ceasing all use of the 
Software and destroying or returning all copies; or, without prejudice as to any 

other rights, we decide to terminate this Agreement with or without notice if You 
fail to comply with the terms and conditions of this Agreement.

4.2.Termination. Upon any expiration or termination of this Agreement, You 
shall cease any and all use of any Software and Evaluation Software and destroy 
all copies thereof and so certify to us in writing. 

4.3.Survival. Paragraph 2.4 (License Restrictions), Paragraph 2.7 (Ownership), 
Paragraph 2.8 (Copyright), Section 3 (Payment), Section 4 (Term of Agreement), 
Paragraph 5.3 (Disclaimer of Warranties), Section 8 (Limitation of Remedies 
and Damages), Section 9 (Confidential Information), Section 10 (Export Com-
pliance) and Section 11 (General) shall survive any termination or expiration of 
this Agreement. 

5.Limited Warranty and Disclaimer.

5.1 Limited Warranty. We warrant to You that for a period of ninety (90) days 
from the Effective Date (the “Warranty Period”) the Software shall operate in 
substantial conformity with the Documentation. Because the Software is inher-
ently complex and may not be completely free of nonconformities, defects or er-
rors, You are advised to verify your work. We do not warrant that the Software will 
operate error free or uninterrupted, that it will meet your needs or expectations, 
that all nonconformities can or will be corrected, or the results obtained through 
use of the Software. Our sole liability (and your exclusive remedy) for any breach 
of this warranty shall be, in our sole discretion, to use commercially reasonable 
efforts to provide You with an error-correction or work-around which corrects the 
reported non-conformity, or if we determine such remedies to be impracticable 
within a reasonable period of time, to refund the license fee paid for the Soft-
ware.  Our Supplier other than us may fulfill our warranty obligations hereunder 
on our behalf.  Our Suppliers shall have no obligation with respect to a warranty 
claim unless notified of such claim within the Warranty Period. 

5.2 Exclusions. The above warranty shall not apply: (a) if the Software is used 
with hardware or software not specified in the Documentation; (b) if any modi-
fications are made to the Software by You or any third party; (c) to defects in the 
Software due to accident, abuse or improper use by You; (d) to Software provided 
on a no charge or evaluation basis; (e) to any Third Party Software; or (f) to any 
Software obtained as freeware, whether from us, our Supplier or otherwise.

5.3 Disclaimer of Warranties. THIS SECTION 5 IS A LIMITED WARRANTY AND, 
EXCEPT AS EXPRESSLY SET FORTH IN THIS SECTION 5, THE SOFTWARE 
AND ALL SERVICES ARE PROVIDED “AS IS.” NEITHER WE NOR OUR SUP-
PLIERS MAKE ANY OTHER WARRANTIES, CONDITIONS OR UNDERTAKINGS, 
EXPRESS OR IMPLIED, STATUTORY OR OTHERWISE, INCLUDING BUT NOT 
LIMITED TO WARRANTIES OF TITLE, MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE OR NONINFRINGEMENT. YOU MAY HAVE OTHER 
STATUTORY RIGHTS. HOWEVER, TO THE FULL EXTENT PERMITTED BY LAW, 
THE DURATION OF STATUTORILY REQUIRED WARRANTIES, IF ANY, SHALL 
BE LIMITED TO THE LIMITED WARRANTY PERIOD. YOU ASSUME THE EN-
TIRE RISK AS TO RESULTS AND PERFORMANCE OF THE SOFTWARE.  IN AD-
DITION, WE MAKE NO WARRANTY, EXPRESSED OR IMPLIED, TO SOFTWARE 
PROVIDED TO YOU FREE OF CHARGE INCLUDING WITHOUT LIMITATION 
FOR ACCURACY, COMPLETENESS, SUITABILITY, PERFORMANCE OR USE. 
ANY SOFTWARE PROVIDED BY US AT NO COST IS PROVIDED "AS IS."; ALL 
IMPLIED WARRANTIES ARE IN SUCH CASE DISCLAIMED.

6.Support & Maintenance. We shall provide the support and maintenance ser-
vices, if any, as separately purchased by You and specified in the applicable Or-
der Form. Such support and maintenance shall be provided pursuant to our 
standard service terms which are available upon request to us. Our Suppliers 
may provide additional support services under separate written agreement, but 
we are not responsible for any such support unless being a contracting party.

7.Professional Services. Our Supplier shall provide the number of person-days, 
if any, of professional consulting services (“Professional Services”) purchased in 
the applicable Order Form and related statement of work. If we are providing 
Professional Services, unless agreed in a separate written agreement, all Profes-
sional Services shall be provided pursuant to our standard service terms which 
are available upon request to us. If your Order Form is with our Supplier other 
than us, that party (and not us) is solely responsible for providing Professional 
Services and we, not being a contracting party, have no liability related to such 
services.

8.Limitation of Remedies and Damages.

8.1.NEITHER WE NOR OUR SUPPLIERS SHALL BE LIABLE FOR ANY LOSS 
OF USE, LOST DATA, FAILURE OF SECURITY MECHANISMS, INTERRUPTION 
OF BUSINESS, OR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUEN-
TIAL DAMAGES OF ANY KIND (INCLUDING LOST PROFITS), REGARDLESS OF 
THE FORM OF ACTION, WHETHER IN CONTRACT, TORT (INCLUDING NEGLI-
GENCE), STRICT LIABILITY OR OTHERWISE, EVEN IF INFORMED OF THE 
POSSIBILITY OF SUCH DAMAGES IN ADVANCE.



8.2.NOTWITHSTANDING ANY OTHER PROVISION OF THIS AGREEMENT, WE 
AND OUR SUPPLIERS’ ENTIRE LIABILITY TO YOU UNDER THIS AGREEMENT 
SHALL NOT EXCEED THE AMOUNT ACTUALLY PAID BY YOU TO US UNDER 
THIS AGREEMENT.  

8.3.THE SOFTWARE IS NOT FAULT TOLERANT AND IS NOT DESIGNED, MAN-
UFACTURED OR INTENDED FOR USE IN LIFE SUPPORT, MEDICAL, EMER-
GENCY, MISSION CRITICAL OR OTHER STRICT LIABILITY OR HAZARDOUS 
ACTIVITIES (“HIGH RISK ACTIVITIES”). WE SPECIFICALLY DISCLAIM ANY 
EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES. 
YOU REPRESENT AND WARRANT THAT YOU WILL NOT USE THE SOFTWARE 
(OR PERMIT IT TO BE USED) FOR HIGH RISK ACTIVITIES, AND AGREE THAT 
WE WILL HAVE NO LIABILITY FOR USE OF THE SOFTWARE IN HIGH RISK 
ACTIVITIES. YOU AGREE TO INDEMNIFY AND HOLD US HARMLESS FOR ANY 
DAMAGES, LIABILITIES OR OTHER LOSSES RESULTING FROM SUCH USE.

8.4.The Parties agree that the limitations specified in this Section 8 will survive 
and apply even if any limited remedy specified in this Agreement is found to 
have failed of its essential purpose.

9.Confidential Information. Any software, Documentation or technical informa-
tion provided by us (or our suppliers and agents) shall be deemed our “Confi-
dential Information” without any marking or further designation. Except as 
expressly authorized herein, You will hold in confidence and not use or disclose 
any of our Confidential Information. Without limiting the foregoing, You ac-
knowledge that the Software constitutes the valuable confidential information 
and trade secrets of us and, accordingly, You shall at all times, both during the 
term of this Agreement and thereafter keep in trust and confidence all the Soft-
ware, and shall not disclose the same to any third party without our prior written 
consent.  You acknowledge that disclosure of our Confidential Information would 
cause substantial harm to us that could not be remedied by the payment of dam-
ages alone and therefore that upon any such disclosure by You, we shall be en-
titled to appropriate equitable relief in addition to whatever remedies we might 
have at law.

10.Export Compliance. You agree to comply with all applicable laws and regula-
tions of the United States of America (“U.S.”) and of other jurisdictions (nation-
al, state, and local) to the extent that they may govern your use of the Software.  
In addition, You acknowledge that the Software may be subject to export restric-
tions by the U.S. government and by certain other governments. You shall not, 
and shall not allow any third party to, directly or indirectly, remove or export or 
allow the export or re-export of any part of the Software or any direct product 
thereof: (a) into (or to a national or resident of) any embargoed or terrorist-sup-
porting country; (b) to anyone on the U.S. Commerce Department’s Table of De-
nial Orders or U.S. Treasury Department’s list of Specially Designated Nationals; 
(c) to any country to which such export or re-export is restricted or prohibited, 
or as to which the U.S.  government or any agency thereof requires an export 
license or other governmental approval at the time of export or re-export without 
first obtaining such license or approval; or (d) otherwise in violation of any export 
or import restrictions, laws or regulations of any U.S. or foreign agency or au-
thority laws, or in violation of any applicable export control laws in the country 
where the Software has been obtained or is used.   You agree to the foregoing 
and warrant that You are not located in, under the control of, or a national or 
resident of any such prohibited country or on any such prohibited party list. The 
Software is further restricted from being used for the design or development of 
nuclear, chemical, or biological weapons or missile technology, or for terrorist 
activity.

11.General.

11.1.Assignment. This Agreement will bind and inure to the benefit of each Par-
ty’s permitted successors and assigns. We may assign this Agreement to any Af-
filiate or in connection with a merger, reorganization, acquisition or other 
transfer of all or substantially all of our assets or voting securities. You may not 
assign or transfer this Agreement, in whole or in part, without our written con-
sent. Any attempt to transfer or assign this Agreement without such written con-
sent will be null and void. If You obtain such written consent from us, You shall 
permanently assign or transfer all of your rights under this Agreement, provided 
You retain no copies and You transfer all of the Software (including all compo-
nent parts, the media and printed materials, any upgrades, and this Agreement), 
and the recipient agrees to the terms of this Agreement. If the Software portion 
is an upgrade, any assignment or transfer must include all prior versions of the 
Software.

11.2.Partial Invalidity. If any provision of this Agreement is held to be invalid, 
illegal or unenforceable to any extent, that provision shall, if possible, be con-
strued as though more narrowly drawn, if a narrower construction would avoid 
such invalidity, illegality or unenforceability, or, if that is not possible, such pro-
vision shall, to the extent of such invalidity, illegality or unenforceability, be sev-
ered, and the remaining provisions of this Agreement shall remain in effect, 
provided, however, that the court shall have authority and jurisdiction to, and 

shall, add to this Agreement a provision as similar in terms and intended to ef-
fect to such severed provision as may be possible and be legal, valid and en-
forceable.

11.3.Governing Law; Jurisdiction and Venue.

11.3.1.If You obtained this Software in the U.S., this Agreement is governed by 
the laws of the State of California (state where Trimble Inc. is located) and the 
U.S. without regard to conflicts of laws provisions thereof, and without regard to 
the United Nations Convention on the International Sale of Goods (“UNCISG”). 
In such case the jurisdiction and venue for actions related to the subject matter 
hereof are the State of California and U.S. federal courts located in Santa Clara 
County, California, and both Parties hereby submit to the personal jurisdiction 
of such courts.

11.3.2.If You obtained this Software outside the U.S., this Agreement is gov-
erned by the laws of The Netherlands (country where Trimble Europe B.V. is lo-
cated), excluding its rules governing conflicts of laws and without regard to the 
UNCISG. In such case each jurisdiction and venue for actions related to the sub-
ject matter hereof are the Dutch courts of the District of Oost-Brabant, The 
Netherlands, and both Parties hereby submit to the personal jurisdiction of such 
courts.

11.4.Attorneys’ Fees and Costs. The prevailing Party in any action to enforce 
this Agreement will be entitled to recover its attorneys’ fees and costs in con-
nection with such action.

11.5.Notices and Reports. Any notice or report hereunder shall be in writing. If 
to us, such notice or report shall be sent to the attention of “General Counsel – 
Legal Notice – Spectra Products” to “Trimble Inc., 935 Stewart Drive, Sunny-
vale, California 94085, U.S.A.”. If to You, such notice or report shall be sent to 
the address You provided upon placing your order or at the time the Software has 
been first made available to You. Notices and reports shall be deemed given: (a) 
upon receipt if by personal delivery; (b) upon receipt if sent by certified or reg-
istered U.S. mail (return receipt requested); or (c) three (3) business days after 
being sent by a reputable international courier requiring signature for receipt, 
addresses to the Party at its notice address. Either Party may change its notice 
address by written notice to the other.

11.6.Amendments; Waivers. No supplement, modification, or amendment of 
this Agreement shall be binding, unless executed in writing by a duly authorized 
representative of each Party to this Agreement. No waiver will be implied from 
conduct or failure to enforce or exercise rights under this Agreement, nor will 
any waiver be effective unless in a writing signed by a duly authorized represen-
tative on behalf of the Party claimed to have waived.

11.7.Entire Agreement. This Agreement is the complete and exclusive state-
ment of the mutual understanding of the Parties and supersedes and cancels all 
previous written and oral agreements and communications relating to the sub-
ject matter of this Agreement. No provision of any purchase order or in any other 
business form employed by You will supersede the terms and conditions of this 
Agreement, and any such document issued by a Party hereto relating to this 
Agreement shall be for administrative purposes only and shall have no legal ef-
fect. Notwithstanding the foregoing, if You have entered into a separate written 

license agreement signed by us for use of the Software, the terms and conditions 

of such other agreement shall prevail over any conflicting terms or conditions in 

this Agreement.

11.8.Independent Contractors. The Parties to this Agreement are independent 
contractors. There is no relationship of partnership, joint venture, employment, 
franchise or agency created hereby between the Parties. Neither Party will have 
the power to bind the other or incur obligations on the other Party’s behalf with-
out the other Party’s prior written consent.

11.9.Force Majeure. Neither Party shall be liable to the other for any delay or 
failure to perform any obligation under this Agreement (except for a failure to 
pay fees) if the delay or failure is due to unforeseen events, which occur after 
the signing of this Agreement and which are beyond the reasonable control of 
the Parties, such as strikes, blockade, war, terrorism, riots, natural disasters, re-
fusal of license by the government or other governmental agencies, in so far as 
such an event prevents or delays the affected Party from fulfilling its obligations 
and such Party is not able to prevent or remove the force majeure at reasonable 
cost.

11.10.Government End-Users. The Software is commercial computer software.  
If the user or licensee of the Software is an agency, department, or other entity 
of the U.S. Government, the use, duplication, reproduction, release, modifica-
tion, disclosure, or transfer of the Software, or any related documentation of any 
kind, including technical data and manuals, is restricted by a license agreement 
or by the terms of this Agreement in accordance with Federal Acquisition Reg-
ulation 12.212 for civilian purposes and Defense Federal Acquisition Regula-
tion Supplement 227.7202 for military purposes. The Software was developed 
fully at private expense. All other use is prohibited.



11.11.Third-Party Software. If designated in the Documentation, the Software 
may contain or be provided with certain Third-Party Software (including software 
which may be made available to You in source code form). Such Third-Party 
Software is not licensed hereunder and is licensed pursuant to the terms and 
conditions indicated in the Documentation and/or on the Third-Party Software 
conditions (“Third-Party License”). Except as may be set forth in the Third-Party 
License, neither we nor our Suppliers offer any warranty in connection with any 
Third-Party Software and neither we nor our Suppliers shall be liable to You for 
such Third-Party Software.

11.12.Official Language. The official language of this Agreement is English. For 
purposes of interpretation, or in the event of a conflict between English and ver-
sions of this Agreement in any other language, the English language version 
shall be controlling.

11.13.Reservation of Rights. We reserve all rights not expressly granted by this 
Agreement.

If an executed agreement exists between You and us at any time regarding the 
Software, the terms of that agreement shall supersede the terms of this Agree-
ment in its entirety. Thus, if You enter into a separate written agreement with us 
regarding the Software, that agreement (not this one) will control your use of the 
Software; and further if that agreement is terminated, You will not have the right 
to use the Software under the terms of this Agreement after termination.  Not-
withstanding the foregoing, pre-printed terms and conditions on your Order form 
shall not supersede this Agreement.

Data Collector Warranty Program 

Spectra would like to make you aware of the warranty program. A new data col-
lector that has been purchased and is still under the one year factory warranty 
or under an extended warranty will be authorized for software updates. Data col-
lectors that are not currently under a warranty plan are eligible to purchase an 
extended warranty. There are Survey Pro software only warranties that will au-
thorize the data collector for software updates, and there are warranties that cov-
er both the data collector hardware and Survey Pro software. The extended 
warranties are a good way to protect your investment in your equipment.

The Survey Pro installation program will use your internet connection to compare 
the data collector's serial number against a data base that contains the warranty 
status on all units. If the unit is under a valid warranty, the installation will pro-
ceed. If the unit is not covered under warranty, then a message will be displayed 
informing you of this and the installation will stop.

To receive Survey Pro minor improvement releases, identified by the version 
numbering system, you only need to be on the current version of the latest minor 
update. In other words, if you have version 5.0.x you are authorized for a version 
5.0.5 improvement release automatically. For minor updates, 5.0 to 5.1 for ex-
ample, it is now required that the data collector or Survey Pro software be on a 
current warranty plan.

The warranty plans are listed on Spectra price lists. Data collector serial num-
bers are required in order to generate the proper registration codes for your unit 
and to log the warranty plan into the database.

Changes to this User Guide from Survey Pro v6.5 to v6.6

This new guide includes the following changes, reflecting the latest enhance-
ments made to Survey Pro:

• Traverse adjustment: A new section was added in chapter 5 to describe in 
more detail what traversing is, what the different field methods are and how 
a traverse can be adjusted.

• Customizable Map Context menu: When working from the map, a custom-
izable context-sensitive menu now exists so that you can conveniently and 
quickly access the routines you most frequently use. 

• Programmable hardware keys: Survey Pro now lets you program the func-
tion keys, if any, of the data collector you are using to run Survey Pro.

• Enhanced remote control for robotic total stations: Several speed modes 
now exist (low, fast, progressive) to turn the station, which you can now con-
trol either from the data collector keyboard or from its touch-sensitive 
screen.

• Other: A few screenshots in the guide were updated to show new icons (e.g. 
smart targets) or new symbols.
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1. Welcome to Survey Pro

Congratulations on your decision to purchase a Spectra Precision product. 
Spectra Precision is serious about providing the best possible products to its 
customers and knows that you are serious about your tools. We are proud to 
welcome you to the Spectra Precision family.

Scope This manual will guide you through your first steps using Survey Pro. Whether 
you are using optical or GNSS equipment, or whether you want to perform 
leveling fieldwork, you will find here key instructions and explanations for a 
successful start.
If you are new to Survey Pro, reading the first three sections will help you 
understand the organization and workflow of the software. Chapter 3 will also 
give all the details to understand what a “receiver profile” is and how it is used 
to easily connect to and configure a GNSS receiver for RTK and/or post-
processing data collection.
The rest of the guide is dedicated to helping you start your field work. 
• Station setup is an essential step when surveying with an optical instrument: 

this guide discusses the Known Point, Resection and Multiple Backsights 
routines, followed by a short description of a few standard surveying 
procedures (traverse/sideshot, repetition).

• Choosing the right coordinate system before starting a job with GNSS is also 
an essential step: the guide will take you through the different possible 
scenarios, followed by a short description of standard data collection 
procedures.

• Collecting elevations in level loops is explained in Chapter 7. Leveling on 
page 86.

• Stakeout routines are functions common to optical and GNSS surveying. 
These are introduced in 8. Stakeout Routines on page 96.

• The last section provides instructions specific to Survey Pro running on 
Nikon Nivo and Spectra Precision FOCUS total stations. 

From your first successful experience with Survey Pro, based on the 
information provided in this guide, you will be able to extend your knowledge of 
the software to its many other functions, relying on your own experience as a 
surveyor and referring to the on-line Help whenever necessary.
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Conventions Used The following conventions are used:
• Text strings in bold font represent the names of software items such as 

fields, buttons, check boxes, tabs, messages, screens, menus, etc.
• The symbol “>” is placed between menus, tabs and/or buttons to indicate 

that you have to tap on these parts successively in that order.
• When referring to both optical instruments and GNSS receivers, the term 

“instruments” will be used to encompass the two types of equipment.

The following acronyms and abbreviations are used:
• BS: Backsight
• EDM: Electronic Distance Meter
• NEE: Northing, Easting, Elevation (grid coordinates)
• HA: Horizontal Angle
• LLH: Latitude, Longitude, Height (geodetic coordinates)
• PPM: Part Per Million
• SD: Slope Distance
• SS: Side Shot
• ZA: Zenith Angle

The following conventions are used when inputting or outputting angles:
• Azimuths, latitudes, longitudes are entered in degrees-minutes-seconds 

format and are represented as DD.MMSSsss, where:
– DD: One or more digits representing the degrees
– MM: Two digits representing the minutes
– SS: Two digits representing the seconds
– sss: Zero or more digits representing the decimal fraction part of the 

seconds.

E.g.: 212.0805 would indicate 212 degrees, 8 minutes and 5 seconds.
• Bearings can be entered in either of the following formats:

– S32.0805W to indicate South 32 degrees, 8 minutes, 5 seconds West.
– 3 32.0805 to indicate 32 degrees, 8 minutes, 5 seconds in quadrant 3.

When a field accepts a time for its input, the time is entered in hours-minutes-
seconds format, which is represented as HH.MMSSsss, where:
– HH: One or more digits representing the hours
– MM: Two digits representing the minutes
– SS: Two digits representing the seconds
– sss: Zero or more digits representing the decimal fraction part of the 

seconds.
2



2. Introduction to the Survey Pro User Interface

Home Screen and Main
Menu

On launching Survey Pro, you will first be asked to open a job. When done, the 
software will open at the Home screen. The home screen shows a selection of 
the functions you will most frequently use in the field. You can customize the 
Home screen based on your needs.
If this is your first time using Survey Pro, a message box will inform you how you 
can customize the items and layout of the functions on the Home screen (see 
How to Customize the Home Screen on page 6).
Because some of the available Survey Pro functions are mode dependent 
(optical, GNSS), there is a different Home screen for each mode. That also 
means there is a slightly different default Home screen depending on which 
instrument is used. See below, from left to right: Optical, GNSS, Leveling.

The functions available from the Home screen are taken from the Main Menu, 
which contains all the possible Survey Pro functions.
You can access the functions available from each submenu by tapping the 
corresponding submenu icon.
Each submenu, and all the functions attached to the submenu, are represented 
by icons of the same background color. For example the File submenu and its 
functions are all in green.
3



Switching Between Home
Screen and Main Menu

The table below lists the buttons allowing you to navigate between the Home 
screen and the Main Menu and its submenus.

Command Bar Description The command bar is that portion of the Survey Pro screen that remains always 
displayed whether the Home screen, the Main Menu or one of its submenus is 
displayed. The command bar contains the following items:
• Map View [1]: This button will access the map view of the current job when 

it is tapped. The map view is available from many screens (see Map View on 
page 9).

• Central [2]: This icon shows the status of the connection to the Spectra 
Precision Central cloud file synchronization service. It will be in one of the 
four states below. 

Tap this icon to sign in to your organization’s cloud account, or to see more 
detailed information about the file sync state once you are signed in.

Icon / Check boxes Result

Takes you to the Home screen from the Main Menu or any submenu.

Takes you back to the Main Menu from the Home screen.

Takes you back to the Main Menu from an open submenu.

The default Home screen has only one page so there’s only one blue dot (a 
radio button), and it is necessarily checked.
When adding functions through customization, other pages may be created 
for the Home screen to accommodate all the added functions (see How to 
Customize the Home Screen on page 6). In that case, tap one of the radio 
buttons to display the desired page.

[1]

[2]

[3]

[4]

[5]

[6]

Icon Spectra Precision Central Status

Not signed into Spectra Precision Central

Signed into Spectra Precision Central and file sync state is normal, with no errors.

Signed into Spectra Precision Central; file synchronization in progress.

Signed into Spectra Precision Central, and there is some problem with the file sync state.
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• Instrument Used [3]: The Instrument icon indicates the mode (optical, 
GNSS or leveling) that the software is in, and the type of instrument the 
software is currently associated with.

This icon is also used to change the instrument and perform additional 
settings on this instrument. See 4. Choosing a Surveying Mode - Connecting 
Survey Pro to an Instrument on page 26.

• Battery Level [4]: The battery icon displays the condition of the data 
collector’s rechargeable battery. The icon has five variations depending on 
the level of charge remaining, and a sixth variation to indicate battery 
charging.

Tapping the battery icon is a shortcut to the Windows Mobile Power Settings 
screen.
 

• Quick Pick [5]: The Quick Pick button will open a customizable list of 
routines. To quickly access a routine, just tap on it (see Quick Pick on 
page 127).

• Online Help [6]: This button opens the online help, which allows you to 
access information for each screen.
 

Icon Current Instrument Selection

Optical instrument

GNSS receiver

Leveling

Icon Meaning

100% charge remaining

75% charge remaining

50% charge remaining

25% charge remaining

Less than 5% charge remaining

Battery charging from AC adaptor
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How to Customize
the Home Screen

A message is displayed right after opening or creating a job asking you to “Tap 
and hold on menu items to manage the Home screen”. This message prompts 
you to customize the Home menu so that only the functions you will most 
frequently be using in the field will be made available from this screen.
After you have become familiar with the customization process and next time 
you launch Survey Pro, you can dismiss the message by checking the Don’t 
show this again prompt before tapping OK to close the message.

Adding a Function
This is a three-step procedure:
• Go to the Main Menu, then to the submenu containing the function you would 

like to add to the Home screen.
• Tap and hold the corresponding function item and select Add to Home. 

Survey Pro then shows the Home screen with all the possible free locations 
for the new function, all represented as unnamed icons. Note at this point 
that all the icons are shown with the same background color (see example).

• Tap on a free icon (an unnamed one) or on the icon of an existing function. 
The new function is inserted at the tapped location. Icon colors are then 
restored.
If you tap on an existing function, this function and the next ones are shifted 
down by one location. Survey Pro will automatically create a new page of 
Home screen if the resulting number of functions on the screen is greater 
that what the screen can accommodate.

Removing a Function
On the Home screen, tap and hold the function you want to remove and select 
Remove Item. This instantly removes the function from the Home screen.

Moving a Function
• On the Home screen, tap and hold the function you want to move and select 

Move Item. Apart from the function you want to move, which keeps its 
original appearance, all other function items change color to blue.

• Tap on the location where you wish to move the function. This may be a free 
location, or the location of an existing function. If you tap on an existing 
function, the moved function will be inserted at the selected location and the 
function at that location and the ones that follow will be moved down. 
6



Home Screen Pages
The default home screen consists of a single page. You may add up to three 
additional pages as part of the Home screen in order to make your many favorite 
functions accessible from this set of pages.
• Adding a page is done by tapping and holding any function on the Home 

screen and selecting Insert Page Before or Insert Page After.
• Switching from one page to the other is done by tapping on radio buttons at 

the top of the screen.
• Removing a page is done by tapping any location on that page and selecting 

Remove Page. This action requires user confirmation.

Programmable Function
Keys For Data Controllers
Equipped with Keyboards

(Such as Spectra Geospatial Ranger 3 or Ranger 7.)
If Survey Pro is run on any such data controller, you can create shortcuts using 
their available function keys.
From Survey Pro’s Home screen, tap Settings, then tap on the Receiver Profiles 
tab and select Buttons.
On the left, select the menu containing the function you want to assign to a 
function key. Then select the desired function. On the right, tap on the function 
key to which you want to assign the function.
For example, in Menu Items, select Cogo. Then select Intersection.
On the right, double-tap on the key to which to assign the function. The name of 
this function then appears after the function key label (after “F3 in the example).

NOTE: On Ranger 3 and Ranger 7, there are only four hard functions keys. On Ranger 7 
however, you can extend the number of function keys by hitting the Fn hardware key 
(next to Ctrl key) before hitting any of the existing function keys. 
7



Screen Details The screen example below illustrates the different types of items you will 
usually encounter on the screen when using the different Survey Pro functions:

• Input Field [1]: An area where you can enter a specific value.
• Output Field: Only displays a value that cannot be changed.
• Simple Button [2]: Typically used to run the function described by its name. 

Just tap it to run the function. When the button name appears in red 
characters, you can alternately press the Enter key on the keypad to perform 
the same action.

• Power Button [3]: Typically used to provide context-sensitive functions to 
modify the corresponding field. Once you have tapped on it, a drop-down list 
will appear with several choices. Simply tap the desired choice from the 
drop-down list.

• Choose From Map Button [4]: Always associated with a field where an 
existing point is required. When the button is tapped, a map view is 
displayed. To select a point for the required field, just tap it from the map.

NOTE: If you tap a point from the map view that is located next to other points, 
another screen will open that displays all of the points in the area that was tapped. 
Tap the desired point from the list to select it.

• Scroll buttons [5]: When a button label is preceded with the > symbol, it 
indicates that the button label can be changed by tapping it, thus changing the 
type of value that would be entered in the associated field. As you continue 
tapping a scroll button, the label will cycle through all the available choices.

• Check boxes [6]: Tap on these boxes to successively check or clear the 
corresponding option.

[1]

[3]

[2] 

[4] 

[5] 

[7]

[6] 

[8][9]
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• Tabs [7]: Many screens show tabs, which look like the tabs on index cards. 
Tapping on a tab displays a subset of information part of the selected screen.

• A data field preceded by [9] means its value can freely be edited, whereas 
[8] indicates that the content of the field is locked to the current value. 
Toggling between [8] and [9] is simply achieved by tapping on the icon.

The following buttons will appear in the area usually occupied by the 
command bar.

Map View The map view is a graphical representation of the objects in the current job. It 
will show basemaps in the background if you are using one (see screen 
example).
Basemap files may be either raster images (such as a georeferenced TIFF file, 
or a JPG image with an associated world file), CAD drawings (DXF files) or Open 
Street Map files (OSM format).
There are different map views depending on how the map view is accessed. 
Each can display slightly different information, such as a vertical profile. A bar 
is shown at the bottom of every map view that indicates the scale. The buttons 
along the left edge of the screen allow you to change what is displayed in the 
map view.

TIP: You can pan around your map by dragging your stylus across the screen.

The “main” map view is the one you get after tapping  in the command bar 
(from the Home screen or Main Menu).

Item Function

OK button. Accepts the changes made and closes the window.

Cancels the changes made in the open window

Closes the current window

Quick access to the relevant Settings screen

Quick access to the Help system

Quick access to the Quick Pick list.
9



From all those screens including a  button, you will also display a map view 
after tapping this button.
The “main” map view, as well as any map view accessible from a survey routine, 
will also function as an “active” map. That means you can perform several 
actions directly from the map. Tap and hold on the map to bring up a context 
menu of available actions. The actions available will depend on what you have 
selected at the tap-and-hold location.
If Optical or GNSS is selected, the main map can also function as an interface to 
collect measurements:

• . Tap  and hold in the toolbar onto the left of the main map and then 
choose Set Survey Mode to enable the Measurement interface.
As a result, the content of the toolbar is extended to show all the available 
tools in that context:

– : Means the survey mode is active (optical).

– : Means the survey mode is active (GNSS; see on the left).

 (see screen example for GNSS).

When in Survey Mode, you can collect data from the main map by tapping on 
one of the available buttons (see table below).
You can also press the Enter key to trigger an observation. By default, the Enter 
key will trigger a “Topo” observation. You can change the Enter key to trigger a 
point observation by clearing the Use Enter Button for Topo SS prompt on the 
Job > Settings > Surveying tab.
10



Shortcut buttons are available to optimize your work. These are defined below:

The main map view includes two additional toolbars:
• The Zoom toolbar
• The Snap-To toolbar

These are described below.
• The Zoom toolbar is always shown.

• Tap  to show the Snap-To toolbar,  to hide it.

Optical Function GNSS Function

- Mechanical optical instrument: Triggers the 
instrument to take a shot in the current mode 
(fine or coarse).
- Robotic optical instrument: Similar to GNSS, 
i.e. takes the latest tracking mode data and 
stores a point.

One-epoch point measurement

- Mechanical optical instrument: Takes a fine 
mode observation.
- Robotic optical instrument: Opens up the 
remote control screen where you will hit the 
Take Shot button to take a fine mode observa-
tion.

Multi-epoch point measurement 
(static occupation)

Setting target height Setting antenna height

Station setup GNSS status

Means that the Survey Mode from the map 
view is ON.

Means that the Survey Mode from 
the map view is ON.

(Robotics only) Tap this button and then tap a 
point on the map view to automatically turn the 
total station to that point.

When activated (icon blackened) the 
computed GNSS position is kept at 
the center of the map screen.

When activated (icon blackened) the computed 
position of the prism is kept at the center of the 
map screen.
11



Displayed Coordinates
The last computed coordinates of the GNSS rover or rod (optical) are constantly 
displayed in the lower part of the active map screen as you move around in the 
working area. In addition, the name and coordinates of the last point saved (if 
any) will be displayed on top of the active map view.
Coordinates will all be expressed in either “NEZ”,”ENZ”, “XYZ” or “YXZ” coordinates, 
depending on your choice of Coord. Order in Job > Settings > Units tab.
Viewing coordinates on the active map view is activated by default. You can 
choose not to view coordinates by disabling the corresponding option:

• Tap  on the map view 
• Clear the Show Coordinate check box.

• Tap  to save your changes and close the Map Display Options window.

Zoom Toolbar

Snap-To Toolbar

Button Function

Zoom Extent button: By default, will set the map view so that all the points in the 
current job can be seen. If the last button in this table has been activated then tap-
ping this button will restore the zoom setting so the frame occupies the wole map 
view.

Will zoom the current screen in by approximately 25%.

Will zoom the current screen out by approximately 25%.

Allows you to drag a box across the screen. When your finger or stylus leaves the 
screen, the map will zoom to the box that was drawn.

Prompts you for a point name and then the map view will be centered to the speci-
fied point with the point label displayed in red.

Use this button after you have adjusted the zoom at your convenience. Tapping 
this button will draw a frame with blue dotted lines around the whole area. As long 
as you keep this button active, and whatever the zoom out value you apply to the 
map, you will be able to identify this area with its blue frame surrounding it.

Button Function

Snap to nearby point.

Snap to the midpoint of the selected line segment.
12



Snap to the nearest of the begin point or the end point of the selected line segment.

Snap to the intersection of two straight line segments. You cannot snap to the inter-
section of line segments that are curves or spirals.

Snap to the point of intersection (PI) of the selected curve segment.

Snap to the radius point (RP) of the selected curve segment.

Snap to the nearest point on the selected straight line or curve segment.

Remove all of the Snap To temporary points created on this map.

Button Function
13



Manage Context Menu
This menu is accessible from the map screen by simply holding down a finger 
anywhere on the map until a menu opens in which you can select Manage 
Context Menu (last option in the scroll-down list).
It is also available from the main menu by selecting successively Job, Settings 
and then by selecting Map Context Menu (last option in the scroll-down list 
attached to the central upper tab).
With this function, you can choose the functions (see  [1] below) you wish to see 
visible from within the context-sensitive menu (see [2] below) attached to the 
active map screen. 

NOTE: This menu should not be confused with the Map Display Options screen, 
which you can open by tapping on the button below:

[1] [2]
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3. Creating a Job

Survey Pro cannot start without a job being open. Upon launching Survey Pro, 
the Welcome to Survey Pro screen will guide you through the process of 
creating a new job or opening an existing job. 

NOTE: Upon launching the onboard version of Survey Pro, the initial screen allows you 
take measurements without having to open a job. Refer to 10. Survey Pro’s On-Board 
Version on page 112.

• Tap the New button. The New Job screen opens, which prompts you for a job 
name where the current date is the default name.

• Either type in a new job name or accept the default name.
• You can create the job in two different ways:

1. Tap the Create Job Now button. The new job will be created with the 
current default settings (as listed at the bottom of the screen) and will be 
stored in the default directory (\Survey Pro Jobs\).

2. Tap the Settings button to access the different job settings (see below). 
After you have gone through the different settings, tap the Finish button. 
This will create and store the new job.

NOTE: The job names listed in the upper portion of the screen are those of the most 
recent jobs you opened in Survey Pro. This list does not necessarily reflect the list of 
jobs stored in your data collector. If you are looking for a job stored in your data 
collector, use the Browse button.

1 2 
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Job Settings The settings and values entered for a new job become the default values for any 
subsequent new jobs. A short description of the jobs settings is given below.

• Units [1]: When creating a new job, set all the desired units for the job. You 
can also enable the setting for Earth Curvature and Refraction correction for 
optical measurements.

• Control/Reference File [2]: Control points can optionally be imported from 
another existing job by checking the Use a Control File check box. After 
tapping Finish to create the job, a message will indicate the number of 
imported points. If you are using a control file, by default the coordinate 
system of this control file will be used for the new job. You can override this 
default setting on the coordinate system page. A control file can be imported 
from either a .Job or .Survey file.
You can also use the points from a reference file (also a .Job or .Survey file) 
by checking the Use an External Reference File check box. Any of the points 
read from this file will be usable as a reference point in the new job.

About Control Files and Reference Files: A control file contains a list of control 
points. When selecting a control file during the job creation phase, you allow Survey 
Pro to import all the control points from this file into the job file. For example if the 
selected control file contains 10 control points, the newly created job file will 
contain 10 points (+1 if you optionally defined a start point; see below).
A reference file contains a list of reference points. When selecting a reference file 
during the job creation phase, you allow Survey Pro to show all the reference points 
stored in this file from within the open job (reference points will show up on the map 
view and in the list of points), but these points are not imported into the job file. 
That’s why they are not represented the same way as the other points (a different 
icon is used). But if you pick a reference point to be used as a setup point (whether 
in optical or GNSS), or for any reason that requires a point for calculations, this 
reference point – and only this one –  will be imported into the job (and will change 
icon).

[1] [2] 
16



NOTE: Basically, a reference file is not different from a control file because control 
points and reference points are not different by nature; Both types can be any point 
of interest, which you consider to be useful to complete your survey.

If you don’t need any points from another file for the job, select No control or 
reference file and tap Next>.

• Select Coordinate System [3]: When you are using a control file, you can 
start the job with the control file’s coordinate system, or you can pick a 
different coordinate system from the database. If you don’t have a control 
file, you need to choose the coordinate system for the job. To select the 
coordinate system for the new job: 
– Clear the check box when you are doing an optical survey with a ground 

scale factor of 1, or if you are doing a GNSS survey and there’s no known 
projection or datum for your local grid coordinates.

– Check this box when your local grid coordinates are defined by some 
known map projection and datum. In this case, select Zone from 
Database and specify the region (Region), zone (Zone) and datum 
(Datum) of your working area.
In GNSS Survey only, the datum may be defined in a different way using 
RTCM messages 1021 and 1023 received from some NTRIP networks that 
broadcast these messages. In this case, check Broadcast RTCM and 
specify the region (Region) and zone (Zone) of your working area. The 
datum will be provided by the RTK network.

Understanding Scale Factor for your coordinate system: 
– If your job has “no coordinate system”, Survey Pro automatically sets the 

scale factor for optical measurements to “1.0”. This means that the 
distance measured on the ground will be 1:1 to the distance on the grid. If 

[3] [4] 
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you start a GNSS survey, Survey Pro will use default Ground Calibration 
mode to calculate your grid coordinates from GNSS measurements. 

– If your job is using a map projection and datum, Survey Pro will 
automatically calculate the correct scale factor for each station setup so 
the distance measured on the ground will properly be reduced to the 
coordinate grid. If you start a GNSS survey, Survey Pro will use the 
selected projection to calculate grid coordinates from GNSS 
measurements.

NOTE: You can modify the default optical scale factor settings in the Job > 
Settings > Scale Factor tab.

• First Point [4]: A default point name and coordinates are prompted to 
become the first point in the job. You can freely change the name and 
coordinates of this point before creating it. You may also clear the box if you 
do not want to create a new point at this stage.

You may start your measurements now if you don’t need anything else in your 
job at this time. In that case, go directly to 4. Choosing a Surveying Mode - 
Connecting Survey Pro to an Instrument on page 26.
If you need to add data (points, polylines, alignments, etc.) into your job before 
starting, the sections below will tell you how to import or create/edit data from 
within the open job. The last section lists the possible formats in which the data 
stored in the job can be exported.

Importing Data Use the File > Import function to add points to the open job. The points may be 
imported from different file formats, using default importers:
• Survey Pro native formats (*.Survey, *.JOB, *.JXL, *.CR5). JXL is the 

extension for files in JobXML format, a Spectra Precision standard format 
for point, alignment, and measurement data.

• LandXML (*.XML), an industry standard format for point, alignment, and 
measurement data.

• Text format (*.TXT, *.CSV). An Import ASCII wizard will help you define the 
content of every TXT file you will import.

Data may also be imported form other formats (GDM, KOF, SFN, Surpac) using 
custom importers created in IXL (XML) format.
Survey Pro will parse and import all the known elements from the chosen file. 
These elements will be added to the current job as points, polylines and 
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alignments. See the definition of these elements in Editing Points on page 19, 
Editing Polylines on page 22 and Editing Alignments on page 23.

The File > Import Control function is used to import points onto the control layer 
of your job. Points on the control layer are protected from being modified. 
Control files should be in *.Survey or *.JOB format.
The File > Reference File function is used to add points to the current job 
without importing them into the job file. You see all of your reference points on 
the map and in point lists. You can use any reference point in Survey Pro as if it 
were a regular point stored in your job file.

Editing Points A point in Survey Pro has coordinates and properties. A point’s coordinates can 
be derived in one of two ways:
• Key-in point: The coordinates for this point were entered using the Job > 

Points function or this point was created by importing data to the job.
• Observed point: The coordinates for this point are calculated from 

measurements in the current job.

NOTE: To see the current coordinates and properties of a point, you can tap the 
point on the map. This will open the Point Details screen showing the Origin of the 
point, which describes how the point was created.

Managing Points
All points in a job file, whether keyed-in or computed from observations, can be 
viewed using the Job > Points function. Points in the job will be either active or 
deleted. Active points can be used in Survey Pro. Deleted points exist in the job 
file database, but must be undeleted before they can be used in Survey Pro.
The following icons are used to identify the different types of existing points: 

The drop-down list available from the right-upper corner of the screen allows 
you to view all the active –i.e. non-deleted– points (select Show Points), the 
previously deleted points (select Show Deleted), only the design points (select 

Icon Point type

Design point

Reference point

Staked point

Point (undifferentiated)

Deleted point
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Design Pts. only), only the staked points (select Staked Pts. Only), both design 
and staked points (select Design & Staked Pts. Only), or all of them (select Show 
All).
Use the three or four buttons located at the top of the screen to manage your 
points: 

• : Allows you to search for the first point in the displayed list meeting the 
search criterion you define. You may define a criterion on the point name or 
the point description. You can also search by point code (FXL auto linework 
and code).

: Will become active only after Survey Pro has found the first point in the 
list meeting your search criterion. Each new press on this button will view 
the next point in the list also meeting the search criterion.

• : Allows you to insert a new point to the list. A name will be prompted by 
default for the new point, based on the name of the currently selected point. 
Entering the definition of a new point is organized into three different tabs 
(see Creating a New Point on page 21). Note that defining a point as a design 
or staked point can only be done using Manage Design Points on the 
Stakeout menu.

• : Allows you to edit the selected point (see Modifying a Point on page 22).

Also, when you tap and hold a point in the Show Points list, a context-sensitive 
menu is displayed giving access to the following functions: 
• Delete Point: Allows you to delete the selected point.

A deleted point is marked with the ( ) icon, placed before its name.
• Delete Points: Prompts you to make a multi-selection of points and then 

deletes all these points.
• View Point Details: Allows you to get a read-only view of the point origin, 

coordinates, properties and notes. The information is split into three 
different tabs: Details, Derivation and Notes.

• View Raw: Takes you to the Raw Data view on which the step during which 
the point was created is highlighted. The Raw Data view can also be selected 
from the main menu by tapping Job > View / Edit Raw Data.

• View Map: Takes you to the map screen where the selected point is shown 
at the center of the screen.

Double-clicking a point in the list is equivalent to selecting View Point Details in 
the context-sensitive menu.
When you tap and hold a point in the Show Deleted list, a context-sensitive 
menu is displayed giving access to the following functions:
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• Undelete Point: Will take this deleted point back to the list of existing points. 
The undeleted point will recover its original icon.

• View Point Details: Same as above.
• View Raw: Same as above.

Creating a New Point

Select any point in the list and tap  to insert a new point:
• The General tab allows you to name the new point, add a description if 

necessary, assign a layer to the point and possibly attach a picture to it 
(using the built-in camera or by selecting an image file from the disk).

• The Location tab allows you to enter coordinates for the point. You can enter 
Grid, global geodetic (WGS84 LLH) or local geodetic (Local LLH) 
coordinates.
– Grid: This point’s local grid coordinates are the Northing, Easting, 

Elevation values that were keyed in or imported. This point’s global 
geodetic coordinates will be calculated by transforming grid coordinates 
into latitude, longitude, height coordinates using the current projection.

– Global geodetic: This point’s WGS84 coordinates are the latitude, 
longitude and height values that were keyed in or imported. This point’s 
local grid coordinates will be calculated by transforming geodetic 
coordinates into Northing, Easting, Elevation coordinates using the 
current projection.

– Local geodetic: This point’s local geodetic coordinates are the latitude, 
longitude and height values that were keyed in or imported. This point’s 
grid and global geodetic coordinates will be calculated by transforming 
the local geodetic coordinates with the current projection.

When there is no projection set or solved, there is no way to transform the 
keyed in values into grid or geodetic coordinates. You will see these 
coordinates are missing when you look at the point details.
If the point originates from an observation, the Position tab will show this 
point’s coordinates but will not allow you to change them.

• The Code tab allows you to associate one or more feature codes to the point. 
For more information on Descriptions, Layers, Codes and Notes, see Point 
Properties on page 118.
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Modifying a Point

Select the point you want to modify and tap .
• Survey Pro will show two additional tabs compared to when you inserted the 

point:
– Derivation: This is a read-only tab indicating the type and origin of the 

point.
– Notes: This tab allows you to add as many notes as needed to the point. 

Each note is date & time tagged.
– The data shown on the General, Code and Location tabs can normally be 

modified. 

• Transforming a computed point into a key-in point: Use the Edit Location 
button on the Location tab to change the two horizontal coordinates or/and 
the one vertical coordinate.
For example, using a total station or GNSS, you observe a point and measure 
its three coordinates. This point is in addition a benchmark providing an 
elevation reference. You may want to fix the vertical coordinate to what is 
written on the benchmark sheet rather than keep the measured elevation. 
Using the Edit Location button, you can change the measured vertical 
coordinate to a keyed-in coordinate while keeping the horizontal 
coordinates as measured.

Multi-Point Selection
With a selection of multiple points, you can use the same button to modify the 
description and layer of the entire selection in one operation.
Selecting several points not in sequence is obtained by first activating the 
Control key and then tapping successively on the points to edit. The Control key 
is accessible from either the virtual keyboard (CTL key on Nomad, Recon or 
ProMark 220) or the real keyboard (CTRL key on Ranger). The Shift key can also 
be used to select several points in sequence.

Editing Polylines A polyline in Survey Pro is a line connecting points together. Each vertex of the 
line is defined by an existing point, whether an observed or keyed in point. 
Points in polylines can be connected with either straight segments or horizontal 
curves.
You can use the polyline editor to modify polylines (go to Job > Edit Polylines). 
The polyline editor is described in the Online Help. 
22



Editing Alignments An alignment in Survey Pro is a line defined by vectors starting at a Point of 
Beginning (POB). The POB can be an existing point in the job, or just location 
coordinates. Alignments can have horizontal segments and optionally a vertical 
profile. Horizontal segments can be straight segments, circular curves or spiral 
curves. A vertical profile can be defined using a vertical curve and straight 
grade segments.
You can use the alignment editor to modify alignments (go to Job > Edit 
Alignments). The alignment editor is described in the Online Help. 
You can import alignments for staking, using Roads > Edit Roads menu. 
Alignments imported using this function can be viewed in the alignment editor 
but cannot be modified.

Exporting Data Use the File > Export function to export data from the open job to one of the 
supported file formats. For most formats (Survey, JOB, TXT, CSV, CR5 and DXF), 
you may select the portion of the current job you wish to export. For export to 
XML, Survey Pro 4.x (Job/RAW) or JobXML format, the entire job database will 
always be exported.

Generating Survey Reports Survey Pro can generate a report of your survey based on the content of the 
currently open job and formatted according to the template you chose at the 
beginning of the process.
About 20 templates are available (see list below) and most of them are 
customizable.
• Complete Survey Report, in html format
• Report in fbk format
• Report in kof format
• GNSS Points report in csv format
• LevelLoopReport_doubleSpaced
• Google Earth report in kml format
• LisCAD report in fld format
• Report in Nikon RAW format
• Optical observation report in htm format
• Two different points reports in csv format
• Nine different stakeout reports in csv or htm format

To generate, view, and save a survey report for the open job, follow the 
instructions below:
• Go to the Main Menu and tap Job, then View Report.
• Select the desired template, then tap Next.
23



• Whenever prompted, customize the report, then tap  to let Survey Pro 
generate and then view the report.

• Depending on the chosen template, do the following to access the screen 
from which you will be able to save the report:

– For html reports, tap ,  then . You then get the screen 
below.

– For Google Earth reports, in absence of an application capable of viewing 
the generated report, Survey Pro will take you directly to the screen 
below.

– For all other types of reports, tap  to access the screen below.

• Tap Save Report to save the report to the desired folder.
(On the same screen, the View Report button would take you back to the 
survey report view, and the Another Report button would allow you to ask for 
a new report, based on the same or a different template.)

Sharing Files Over the
Internet

Survey Pro allows you to share files over the Internet. This requires that you first 
set up an Internet connection on your data collector using Windows Mobile’s 
Settings > Connections > Connections function.
After the Internet connection has been established, go to File > Share and set 
an e-mail profile. You can send emails to one or more recipients, with your files 
attached to your e-mails. If several files are selected to be attached to an e-
mail, Survey Pro will automatically zip the files so there is always one single file 
attached to the email
Sending e-mails requires that you use an e-mail profile. You can set up your own 
e-mail account (e.g. Gmail) or use one of the default e-mail profiles (SMS, 
ActiveSync) set up by Windows Mobile. After you have set up your own e-mail 
account, it will appear as an additional option in the E-mail Profile list.
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Connecting to Spectra
Precision Central

Spectra Precision Central is a cloud file storage and synchronization service 
allowing an organization to synchronize files and folders across multiple 
desktop computers, data collectors running Survey Pro, and mobile devices.
Spectra Precision Central automatically keeps files synchronized across devices 
so that team members can easily exchange data, and everyone is always using 
the latest up to date copy of any data file.
To access Spectra Precision Central from Survey Pro, you need to connect your 
data collector to the Internet using WiFi, the cellular modem connection, or by 
plugging it into Windows Mobile Device Center (ActiveSync). 
To connect a data collector to Spectra Precision Central:
• Tap the icon in the command bar to open up the Central screen
• Type in your user name (Username), your company’s organization name 

(Organization), and your user password (Password).
• Tap Sign in.

When you are connected, the Central icon will change to 
• Once you are signed in to Central, the Central screen shows your sign-in 

status, as well as any current file sync activities going on in the background.
You can then go to Job > Settings and select the Central tab to configure 
your file synchronization connection usage preferences:
– Automatic - All: Files will get synchronized any time there is a data 

connection. This is for users who want the file synchronization to be 
continuous and don’t care about mobile data bandwidth usage.

– Automatic - WiFi: Files will get synchronized any time there is a data 
connection that is not cellular, for example, if you are using WiFi, or any 
time you plug into Windows Mobile Device Center (ActiveSync). This is for 
users who want automatic file synchronization any time, except when 
their data connection is using mobile data bandwidth.

– Manual: Synchronization takes place only when the Sync Now button on 
the central screen is tapped.

Whenever the Cloud button ( ) is shown on the screen, for example when you 
want to import files, you can tap on this button and select Central.
By doing this, you will be allowed to browse through the different folders on the 
cloud (and not only the subfolder specific to your data collector) so you can 
download a new file posted elsewhere in the cloud by your team.
After you will have saved this file to your data collector, the sync mechanism will 
in the background create a copy of this file to your specific data collector 
subfolder on the cloud.
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4. Choosing a Surveying Mode - Connecting Survey Pro to an Instrument

Before you start taking new measurements with Survey Pro, you must configure 
and activate your instrument. You can activate an optical total station, a GNSS 
receiver, a digital automatic level, or you can specify to use manual input for 
three-wire leveling.

NOTE: Selecting an instrument only makes sense when Survey Pro is running on a data 
collector. If it’s running in the instrument you are using (e.g. FOCUS 30), only this 
instrument can be used in Survey Pro.

Before you make this choice, power on the instrument. This will allow the data 
collector to detect it and establish a radio, Bluetooth or serial connection with 
it when asked to do so. Three-wire leveling using manual input does not require 
Survey Pro to be connected to an instrument.
With GNSS equipment, you may simply use a rover receiver, or both a base 
receiver and a rover receiver. In the latter case, it’s good practice to start your 
survey having both receivers running side by side. This way, you can complete 
the setup of both receivers and ensure they are communicating on the data link, 
and you are getting a fixed position at the rover.
When using a serial connection to start a base and rover, the data collector must 
be connected to the base receiver first. Once the base is set, disconnect the 
cable from the base and connect it to the desired rover.

Instrument Icon and
Options List

• Run Survey Pro.
• Open or create a job.
• Tap on the Instrument icon in the command bar.

(This icon may look like any of the following: ,  or ).
This opens a list of options (see screen example).

• Manage Instruments provides access to various functions allowing you to 
declare a new instrument and make advanced settings for each instrument.

• The available options below the Manage Instruments button are for 
selecting the desired operating mode for Survey Pro:
– Optical for optical instrument (the selected one in the example)
– GNSS for GNSS receiver used in RTK or/and post-processing
– Leveling allows Survey Pro to use the most accurate techniques for 

measuring elevations. Leveling can be done using an optical total station, 
a digital automatic level, or a manual automatic level.
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NOTE: In surveying, the term "automatic level" refers to a level that can be 
accurately plumbed without having to be accurately leveled. 
All levels built in the last 40 years or so have been automatic levels. They are 
automatic because the prism through which the light rays pass is suspended by a 
pendulum. Therefore, as long as the instrument is close to level (which can be 
achieved ± 60" using a bubble level), the pendulum mechanism ensures that the light 
rays are always passing through perpendicular to actual gravity, and they are very 
accurate.
This means that a digital instrument such as the Trimble Zeiss Dini level is called a 
digital automatic level, and a non-digital instrument, such as the Nikon AL2s, is also 
an automatic level.

• In the section above the Manage Instruments button is a list of all 
instruments that have been added to Survey Pro for the currently selected 
mode. The current active instrument is indicated with a check mark. An 
additional option is available (“Manual Mode” for optical and leveling; “Demo 
Mode” for GNSS) allowing you to use Survey Pro standalone.
In optical, you choose “Manual Mode” to manually enter horizontal angle, 
vertical angle, and slope distance any time Survey Pro is triggered to take an 
observation. This is useful for training and learning the software, and it can 
also be used to enter survey measurement data into a job from written field 
notes. 
In GNSS, you can choose “Demo Mode” for demonstration and training 
purposes only. The “Demo Mode” has no use for handling actual survey 
measurements.
In leveling, you must choose “Manual Mode” if you wish to do single-wire or 
three-wire leveling from rod readings.
The ”Manual Mode” and “Demo Mode” profiles cannot be deleted or renamed.

In summary, tapping the Instrument icon allows you to:
• Select Optical, GNSS or Leveling mode
• Quickly activate an instrument for use in the selected operating mode
• Quickly access the Instrument Settings screen
• Add a new instrument supported in the selected operating mode.
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Optical Mode - Connecting
Survey Pro to an Optical

Instrument

• Tap the Instrument icon and select Switch to Optical
• Tap the Instrument icon and select Manage Instruments. This opens the 

Settings screen listing all the current instrument profiles.
• Tap the Add Instrument button and define the new instrument: Choose its 

brand and model, and then name it.
Depending on the model you select, additional settings may be required 
(connection, radio, etc.) and status is also provided (port, connection, level 
bubble, etc.). An Instrument Settings button is also available giving access to 
advanced settings (collimation, EDM, lights, etc.).

• Tap  to create the new instrument and close the Instrument Setup screen. 
The new instrument is automatically selected in the list (the instrument 
name is highlighted in the list).

• Tap  to close the Settings screen.

The Settings screen for optical instruments includes the following buttons:
•  Instrument Settings: Gives quick access to the settings of the instrument 

selected in the list. The type and number of settings depend on the brand 
and model of the instrument selected. All instruments have a Precision tab 
through which you can read the expected precision values of the instrument 
(angles, distances, PPM). These values are used in the resection routine (see 
page 46) to weight the observations used in the computation process.

• GeoLock: Allows you to enable or disable GeoLock, a GPS-assisted target 
search function usable with some robotic instruments only.

• Export and Import: These buttons allow you to respectively save or load 
instrument profiles. Survey Pro saves instrument profiles as SPI files. 
Importing an SPI file is a quick way of adding a preset instrument in Survey 
Pro.
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Remote Control Screen
If you are using a robotic total station, use the Survey > Remote Control 
function to control the total station from the data collector running Survey Pro. 
In addition to providing the same level of control as Survey Pro’s onboard 
version, the Remote Control screen constantly provides information about:
• The charge status of the battery used in the total station
• The operating status of the total station (IDLE/ MEASURING/Locked)
• The quality of the radio link between the robotic total station and the data 

collector.

The following buttons are also available from this screen to control the instrument:

• : Launches a GPS-assisted search for the prism (GeoLock)

• : Launches a search for the prism starting at the current instrument 
direction

• : Enables or disables the lock-and-go feature (LockNGo)

• : Stops the current turn or search operation

• : Opens up the “Turn To” screen where you can select a point or angles 
to turn the instrument to

•   : Turns on or off the track light.

The following icons are made available next to the title bar:

Item Function

Visible laser pointer off. Tapping on this icon will turn the laser pointer on.
Note: Standard safety precautions should be taken to ensure that persons do not look 
directly into the beam.

Visible laser pointer on. Shown to indicate the visible laser is currently active. In the com-
mand bar, the instrument icon will then look like this:

        

Tapping  will turn the laser pointer off.
Note: Standard safety precautions should be taken to ensure that persons do not look 
directly into the beam. 

Provides access to the Instrument settings screen.

Shows or hides the on-screen keyboard.

Provides access to Geolock activation, status and reset.
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The arrow keys and radio buttons on the Aim tab of the Remote Control screen 
provides a very efficient way to control the way you turn your robotic total 
station:
• Progressive: If this option is selected, the total station will start turning 

slowly in the requested direction and will then gradually turn at a faster 
speed if you keep your finger on the button.

• Fast: If this option is selected, the total station will instantaneously turn at a 
fast and constant speed until you release the direction button.

• Slow: If this option is selected, the total station will instantaneously turn at 
a slow and constant speed until you release the direction key.

Alternately, if you are using a data collector fitted with a keyboard, you can 
obtain the same features in the way you turn the total station by using the arrow 
keys on the keyboard combined with one of the following keys (also on the 
keyboard):
• Control (Ctrl) key: Slow turn
• Shift key: Fast turn
• No other key held down: Progressive turn, gradually faster.
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GNSS Mode - Connecting
Survey Pro to a GNSS

Receiver

Introduction to Receiver Profiles
Survey Pro connects to a GNSS receiver through a receiver profile, which is a 
convenient way of connecting to and configuring a GNSS receiver in one click, 
using information previously saved as a receiver profile.
Receiver profiles allow you to use GNSS receivers for either RTK data collection, 
post-processing data collection, or both simultaneously. 
There are two ways of adding a receiver profile into Survey Pro:
• Using Spectra Auto-Configure. This procedure can only be used with 

Spectra Precision receivers. Survey Pro uses Bluetooth to detect all the 
nearby Spectra Precision receivers. For each detected receiver, Survey Pro 
will offer to create a base, rover, and network rover profile using the default 
settings for that receiver type. You can then choose the receiver profiles you 
would like to create for the newly detected receivers.
If the receiver has also RTX capability, be aware Survey Pro does not 
automatically create an RTX profile for a receiver. If you want to use the 
receiver in RTX mode, you can modify an existing profile, or add a new RTX 
profile to operate the receiver in this mode.

• Using Manual Configuration. This procedure allows you to connect to a 
single receiver either through a serial connection or over Bluetooth. This 
procedure is suitable for any of the supported manufacturers and models of 
GNSS receivers. Once the connection with the receiver is established, you 
have to define your receiver profile by yourself (see Modifying a Receiver 
Profile on page 35 for more information). In the last step, you will name the 
receiver profile and save it.

Example of Receiver Profiles List Later, when you start a survey, just select the desired receiver profile –and a 
network profile if you are working in a network; see also Managing Network 
Profiles on page 37– before you ask Survey Pro to connect to the receiver you are 
using. Survey pro will configure the receiver hardware according to the settings 
defined in the selected receiver profile.
When you are using Bluetooth to communicate with receivers, you will typically 
have a different profile for each receiver, since the Bluetooth address is part of 
the profile. However, you can change the receiver a profile connects to by 
changing the Bluetooth address.
You may have two or more different profiles for the same receiver. For example, 
if you use receiver “x” as a rover with a radio base on some days, and as a 
network rover with an NTRIP server on other days, then you would have two 
different profiles for this same receiver.
Receiver profiles can be imported or exported as SPR files allowing you to 
deploy consistent receiver profiles across your surveying crews.
Receiver profiles can be modified, renamed or deleted.
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Adding Receiver Profiles
• Tap the Instrument icon and select Switch to GNSS.
• Tap the Instrument icon and select Manage Instruments. This opens the 

Settings screen listing the currently existing GNSS receiver profiles.
Example of Detected Receivers • Tap Add Receiver Profile, then use of the two procedures described below.

Adding Receiver Profiles Using Spectra Auto-Configure:
• Tap on the Start button in the Spectra Auto-Configure pane. Survey Pro then 

scans automatically for new Spectra Precision GNSS receivers within 
Bluetooth range. After a while, the screen lists the names of all the detected 
receivers.

• Select each of the receiver for which you would like to add a receiver profile.

Example of Selected Standard Receiver
Profiles

• Tap Next. Survey Pro will in sequence connect to each of the selected 
receivers and will then return a list of standard receiver profiles, each of 
them corresponding to a possible usable profile for that receiver.

• Check each of the receiver profiles you would like to add.
• Tap Finish. Survey Pro comes back to the Receiver Profiles screen on which 

you can now see the added profile(s). Receiver profiles may be imported or 
exported at this point (see Managing Your Receiver Profiles on page 33 for 
more information).

• Tap  to return to the Home screen.

Adding a Receiver Profile Using Manual Configuration:
Example of Bluetooth Connection • In the Manual Configuration pane, do the following:

– Select the brand of your GNSS receiver
– Select the model of your GNSS receiver
– Select the type of connection to the receiver. 

1) If it’s a Bluetooth connection, select Bluetooth and then tap the 
Bluetooth Settings button. This button opens up the Bluetooth 
Instruments screen, from which you can scan for Bluetooth devices 
supporting a serial port service (or open up the Windows OS Bluetooth 
application).
Tap Start Scan and let the utility search for all the devices. When the 
search is complete, select the device corresponding to your GNSS 
receiver. Then tap Add Selected, change the Bluetooth name if you wish, 
set the Bluetooth PIN if required, and tap .
Tap  to return to the initial screen. The name of the chosen Bluetooth 
device now appears in the Bluetooth Device field.
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NOTE: The Bluetooth Device field lists the names of the previously detected 
Bluetooth devices. Use this field when the receiver you want to connect to was 
detected beforehand, is still running nearby, or you know its Bluetooth name 
and this name is still listed in the drop-down menu. Only in that case can you 
directly select the Bluetooth name from that list and quickly establish a 
connection with the receiver.

2) If it’s a serial connection, check Serial and select the port used on the 
data collector side for this connection.

• Tap Connect. You can now define a receiver profile for use in the connected 
receiver. Complete the four tabs (Survey, Modem, General, Reset). See 
Modifying a Receiver Profile on page 35 for more information on receiver 
profiles.

• Tap  to save the new receiver profile. This profile is now available from the 
list of receiver profiles. Receiver profiles may be imported or exported at 
this point (see Managing Your Receiver Profiles on page 33 for more 
information).

• Tap again  to return to the Home screen.

Managing Your Receiver Profiles
Do the following to access the list of existing receiver profiles in Survey Pro:
• Tap the Instrument icon and select Switch to GNSS.
• Tap the Instrument icon and select Manage Instruments. Survey Pro lists the 

receiver profiles as detailed below.

• [1]: Receiver profile name. By default, the name includes the receiver 
model first, followed by its serial number (last four characters), then its 
survey function.

[2] [1]

[3]
[4]

[7]

[5] [6]
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• [2]: Survey function icon: This may be one of the four icons below (see also 
Modifying a Receiver Profile on page 35).

• [3]: Connection icon: This may be one of the two icons below.

• [4]: Settings icon: . Provides access to the receiver profile’s Survey, 
Modem, General and Reset tabs. See Modifying a Receiver Profile on page 35 
for more information.

• [5]: Import. Tap on this button to import a receiver profile, then:
– Select the SPR file you want to import.
– Tap . Survey Pro returns the name of the receiver profile contained in 

the file.
– Select the profile name to continue.
– Tap Import to complete the import sequence.

• [6]: Export. Tap on this button to export a receiver profile, then:
– Select the receiver profile you want to export.
– Tap Export. 
– Name the file, then tap  to export the profile and save it as an SPR file 

in the chosen folder.

Icon Meaning

Rover.

Base.

Network Rover.

Network base.

RTX (prompted only if the receiver has RTX capability).

Icon Function

 or 

Shown when respectively a Bluetooth or cable connection has 
been set between Survey Pro and the receiver.
If the Bluetooth icon is shown, tapping this icon will provide the 
receiver brand and model as well as the receiver Bluetooth name.
If the Serial icon is shown, tapping this icon will provide the 
receiver brand and model as well as the serial line settings.
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Example of Receiver Information • [7]: This menu is displayed after you tap and hold a receiver profile in the 
list. From this menu you can do the following:
– Receiver Info: Use this function to view more information on the receiver 

connected to Survey Pro through this profile (see example). The possible 
capabilities of a receiver (shown as icons) are identified below.

– Rename: Used to rename the selected receiver profile.
– Delete: Used to delete the selected receiver profile. Then tap Yes to 

confirm that you really want to delete the profile.

Modifying a Receiver Profile

Tap on the corresponding  button in the receiver profiles list to make 
changes to a receiver profile. The receiver profile is described on four different 
tabs, the content of which is receiver-dependent.

IMPORTANT! All changes you make to a receiver profile will be effective only if a receiver 
is connected to Survey Pro through this profile. In addition, the changes made to a 
receiver profile will not be effective immediately in the connected receiver, but only 
next time you start a survey using the modified receiver profile to connect to and 
configure the receiver.

• The Survey tab is primarily used to define the following RTK survey 
parameters: 

Epoch 50’s Survey tab – Setup Type: Used to assign one of the four functions to the receiver:
1) Rover: Corrections received via radio.
2) Base: Corrections broadcast via radio.
3) Network Rover: Corrections received via modem.
4) Network Base: Corrections sent to an IP address.
5) RTX: RTX corrections received via modem (IP) or L band.

– Elevation Mask: Limits the use of satellites to those that are high enough 
in the sky, seen from the receiver antenna. All satellites located under 
this zenith angle will be rejected (default: 10°).

– Corrections: Used to set the format of corrections received (rover) or 
broadcast (base). This setting is not used for rover receivers that support 
automatic detection of correction format.

Icon Capability

The receiver has rover capability.

The receiver has base capability.

The receiver has data collection capability (for post processing).
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– Use Station Index: Used to assign a station ID to a base, or identify the 
base a rover is expected to use.

Epoch 50’s Modem tab – Set to Off mode: Sets the receiver idle, i.e. no more corrections are sent 
out if the receiver is a base –or network base– or the receiver stops 
listening for corrections if it’s a rover or network rover. There is an 
exception with ProMark receivers, which in all cases will keep on 
operating as rovers.

• The Modem tab allows you to configure the RTK data link.
– If Setup Type = Rover or Base, allows you to enter the UHF radio settings 

(i.e. baud rate, frequency channel and sensitivity for most radio models).

SP80’s Modem tab – If Setup Type = Network Rover, Network Base, or RTX, allows you to set 
the cell modem used, either the one internal to the data collector 
(Current Internet or Windows Networking option), the one internal to the 
receiver (Internal GPRS Modem option), or an external cell phone (IP 
Modem option).
Setting a cell modem mainly implies entering the service provider 
information (APN) and your connection profile (username & password).

ProMark 800’s General tab • The General tab allows you to configure settings that are specific to the 
brand and model of this receiver profile. For more information on brand- and 
model-specific settings, see the online help.

• The Reset tab provides additional control over the connected receiver. 
Three buttons may be available:
– Set Rx. to OFF mode: Same as Set to Off mode above.
– Soft Reset: Will reboot the receiver with its current settings.
– Hard Reset: Will reboot the receiver with its default settings (depends on 

the model of receiver used).
SP80’s Anti-Theft tab • For some Spectra Precision GNSS receivers, more tabs are available: When 

made visible, the Anti-Theft and Alerts tab can be used to protect a remote 
base receiver from theft and/or to authorize only certified users to operate 
the receiver at power up. 
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Managing Network Profiles
Network profiles are managed the same way as receiver profiles. Network 
profiles are required:
• To specify the source of RTK corrections a GNSS receiver acquires when it 

is set as a network rover.
• To specify the destination of the RTK corrections a GNSS receiver will 

generate when it is set as a network base.
Example of Network Profile To add a new network profile:

• Tap the Instrument icon and select Switch to GNSS.
• Tap the Instrument icon and select Manage Instruments. This opens the 

Settings screen listing the currently existing GNSS receiver profiles.
• Tap on the Networks tab
• Tap Add Network. Enter your network parameters (see below), then tap .

A network profile is defined by the following parameters:
• Name: Enter a name for your network profile.
• Setup Type: Tell whether the network profile is to be used by a base (choose 

Network Base) or a rover (choose Network Rover).
• Server Type: Depending on the selected Setup Type, define the type of IP 

connection used:
For a network rover:
– Automatic: Make this choice if you want Survey Pro to determine the type 

of connection and server from which the rover will acquire corrections  
(recommended).

– NTRIP: Make this choice if you want your rover to acquire corrections 
from an NTRIP server.

– Direct IP: Make this choice if you want your rover to connect directly to a 
Direct IP single base server or to a static IP base.

For a network base:
– Direct Connect: Make this choice for your base if you want the rover to 

connect directly to that base over the Internet.
– TCP/IP Forwarding: Make this choice if you want the base to forward its 

corrections to a TCP/IP server.
– NTRIP Forwarding: Make this choice if you want the base to forward its 

corrections to an NTRIP server.

• Address: IP address of the server that the receiver connects to for sending 
or acquiring corrections. With Direct Connect chosen for a network base, 
the IP address is assigned dynamically by the network provider. That’s why 
in that case, the Address field reads “Dynamic” and is read-only. 
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• Port: IP port of the server that the receiver connects to for sending or 
acquiring corrections.

• User Name and Password: Credentials required to be allowed to access the 
server.

• Mount Point: (for a network base in NTRIP Forwarding only) Enter the mount 
point where to send corrections to.

• Force NTRIP password (for a network rover in Automatic or NTRIP setup 
type). With this option enabled, you will be prompted for user name and 
password for every NTRIP mount point, even if the NTRIP table specifies that 
they are not required. This option is to deal with poorly formatted NTRIP 
tables, where the source table says that password is not required, but the 
selected mount point actually requires one.

• Corrections: Whenever required, specify the format of corrections (ATOM, 
CMR, RTCM) the receiver should generate (base) or receive (rover).

When later starting a survey, you will be requested to specify the network profile 
your receiver will work with. Choose the name of that network profile.
At this point, the Manage Networks button allows you to return to the list of 
existing network profiles to make changes if necessary. In the networks list, an 
icon placed ahead of each network profile name tells you the type of receiver 
the network profile is intended for:

• : Network base profile

• : Network rover profile

Checking the GNSS Status
Checking the GNSS status of the connected receiver is recommended before 
starting a job. This implies that the GNSS receiver is in real conditions of use, 
preferably in an open sky environment. 
Use the GNSS Status function on the Survey menu to read this information. The 
GNSS status is split into six different tabs:
• Receiver: Provides additional information describing the position solution 

computed by the receiver. In RTK, the Reset Ambiguities button allows you 
to re-initialize the computation of the position. For more information, see 6. 
GNSS Surveying on page 65.

• Data Link: Describes how a rover is provided with RTK corrections, or the 
type of RTK corrections generated by a base. For more information, see 6. 
GNSS Surveying on page 65.

• Post Process: This tab shows the data recording status (Yes/No), the 
recording interval (1 or 2 sec), the name of the point on which data recording 
takes place (only when static) and the time elapsed since data recording was 
started. Additionally, this tab shows the receiver’s battery and memory 
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statuses (plus remaining, estimated recording time for some receivers). When 
there is no data recording in progress, most of these fields are left empty.

• Sky View: Provides a polar view of the sky showing the location and type of 
each satellite being tracked and the total number being used in position 
solutions (see example). You may change the value of the elevation mask on 
this screen. This will update the value read on the General tab as well (see 
Managing Your Receiver Profiles on page 33).
Color code and letter code used for the different constellations:

• Sat Info: For each visible satellite, provides the satellite identifier (e.g. G8), 
the current status (Used/not Used) and the L1 signal strength (SNR) as a 
color-coded vertical bar. See table below.

The Tracking button allows you to enable or disable each of the 
constellations the receiver can track.
Depending on the receiver used, you may be given the ability to reject some 
satellites through a context-sensitive menu attached to each vertical bar 
(you may want to not use a satellite because the signal received from it is too 
weak, or because it is officially declared unhealthy). In this case, a filter is 
also available on this screen allowing you to show all the visible satellites or 
only those that are currently tracked.
(NOTE: The same satellite labels as on the Sky View above are shown on this 
screen.)

• Position: Provides the three coordinates of the position solution currently 
computed by the GNSS receiver, the solution status, as well as heading and 
speed if the receiver is currently moving. The position may be expressed in 
WGS84 (always possible), in a local coordinate system (if selected and 
solved) or as grid coordinates (if the grid is selected and solved). 

Before going any further in your work, you should check that at least 6 satellites 
are received and used, each satellite providing a good signal level, and the 
receiver delivers a 3D position solution. 
During your survey, should your GNSS receiver raise some alerts (loss of RTK 
position status, low memory or low battery), Survey Pro will automatically 
forward them to you in the form of message boxes. This is to make sure you get 
this information in a timely manner as some GNSS receivers may not be able to 
warn you directly.

Color Gray Blue Red Green Yellow Magenta Cyan

Satellites used in position Not used GPS GLONASS BeiDou Galileo QZSS SBAS

Sat label (“xx”= Sat PRN) - Gxx Rxx Cxx Exx Jxx Sxx

Vertical Bar L1 Signal Strength Used/Not Used Indicator Status

Green Very Good Solid dot Used

Yellow Good Hollow Dot Not Used

Red Poor
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Leveling Mode - Getting
Ready for Leveling

Leveling can be performed using one of two techniques:
• Automatic leveling: An automatic level is used to take readings on a 

graduated level rod. This is the traditional leveling technique for surveying. 
It can be performed by manually reading the rod, or by using a digital 
automatic level such as the DiNi to electronically read the rod.

• Trigonometric leveling: An optical total station is used to measure zenith 
angle and slope distance to a prism on a pole. This alternative leveling can 
be performed with a total station and a prism on a fixed height pole.

Depending on the technique you wish to use, you must configure your 
instrument and possibly select a leveling method.

Auto/Manual Leveling Methods
Survey Pro supports the following leveling methods:
• Three Wire: An automatic level is used and the operator observes the leveling 

rod at the upper, middle, and lower wire of the level stadia. This method is 
used with the “Manual Mode” instrument profile.

• Single Wire: Same as three-wire leveling, except that only the middle wire is 
read and entered using the “Manual Mode” instrument profile.

• Electronic: An electronic automatic level is used to digitally observe a bar-
coded level rod. This method is used with one of the supported electronic 
level instrument profiles.

• Trigonometric: An optical total station is used to observe a prism on a prism 
pole to measure vertical distance. This method is used with any electronic 
total station instrument profile. It can also be used with the “Manual Mode” 
instrument profile if you wish to hand enter zenith and slope distance 
observations from a field book.

NOTE: Trigonometric leveling (trig leveling) is a different survey technique than 
performing a 3D optical survey with a total station.
In trig leveling, you do not set up the optical total station on a known point, and you 
do not measure the height of the instrument or the height of the rod at any time 
during the survey.
Trig leveling is more like traditional leveling in that you set up the instrument in 
between the points in each turn, you observe the rod at the backsight to establish 
the height of the instrument, then you observe the rod at the foresight to establish 
the foresight elevation. Because the foresight observation is subtracted from the 
backsight observation, the height of the rod, which must be kept constant between 
the backsight and foresight of each turn, cancels out. Therefore, in trig leveling, you 
never need to enter the height of the rod. The height of the instrument above the 
ground at each location is also not used in this procedure.
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Choosing Leveling Mode
1. If your active instrument is an electronic automatic level, then Survey Pro 

will automatically use Electronic leveling method.
2. If your active instrument is an optical total station, then Survey Pro will 

automatically use the Trigonometric leveling method. Creating and 
activating either an electronic level instrument profile or an optical total 
station profile is the same procedure used to create an instrument profile in 
optical surveying mode (see Optical Mode - Connecting Survey Pro to an 
Optical Instrument on page 28).

3. If your active instrument is the “Manual Mode” profile, then you must choose 
your leveling method:
• Tap the Instrument icon and select Switch to Leveling.
• Tap the Instrument icon again and select Manage Instruments. This 

opens the Settings screen.
• Select Manual Mode and then tap Instrument Settings. This opens the 

Level Method screen.
• Select the desired leveling method among the four possible,
• Tap  to validate your choice. As a result, you can see that Manual Mode 

in the list of instruments has now been activated automatically.
• Tap  to close the Settings screen. Survey Pro is now ready to perform 

manual leveling.

Level Settings
• Now that you have selected the Leveling mode, go back to the main menu 

and select Job > Settings. This opens the Settings screen
• Select Level from the upper tab. This screen allows you to set the shooting 

sequence (BS1...BSn>FS1...FSn or [BS1 FS1>FS2BS2]n), the number of sets 
(n) and a few leveling tolerances (vertical distance, horizontal distance, etc.) 
Survey Pro will be using in Leveling mode.
The Load FGCS Defaults button allows you to specify a particular order and 
class for the level loop. This will automatically fill in all the tolerances on the 
Settings screen with the default FGCS values.
Setting tolerances allows Survey Pro to issue warning messages when 
tolerances are not met. It’s up to you to determine if the level loop meets the 
criteria for a particular standard. 

• Tap  to enter all your settings and close the Settings screen.
• Go to the main menu and select Survey to start your leveling work. Refer to 

Section 7. Leveling on page 86 for more information.
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5. Optical Surveying

What you have done already:
• You have set up the optical instrument on a tripod over a point of your choice 

and measured the instrument height.
• You have selected Optical from the instrument icon located on the Home 

screen or Main Menu.
• You have activated the instrument for use with Survey Pro. See Optical Mode 

- Connecting Survey Pro to an Optical Instrument on page 28.
• You have configured the proper settings in the Job > Settings > Surveying 

tab. This tab allows you to configure:
– Earth Curvature & Refraction correction: To adjust measured zenith 

angles for the effects of earth curvature and refraction.
– PPM: To adjust the measured slope distances for the atmospheric 

effects on the EDM. 
– Survey with True Azimuths: Automatically sets the Circle on the 

instrument to match the BS Azimuth that is set when pointed at the 
backsight.

What you should do now: You have to position and orient the total station in 
your local coordinate system before you start measuring points. This can be 
done using one of the methods below, by choosing whichever is most 
appropriate: 
• Known Point: Station setup on a point with known coordinates.
• Unknown Point /Resection: Station setup on an unknown point using the 

resection method to determine the position of the point.
• Multiple Backsights: Station setup on a known point using several backsight 

points to determine the orientation.
• Use Last Setup: This method is made available only after a station has been 

set up in the current job. Use it only if you are certain the tripod is still exactly 
at the same location as when the last setup was performed, and the same BS 
and Circle are being used.

The first three methods are described below. The point or points used should 
have previously been stored in or imported into the job.
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Instrument Setup Station Setup on a Known Point
The name and coordinates of the known point where the station is set up can be 
picked from within the open job. This method offers three different scenarios:
• BS Azimuth [1]: Backsight azimuth. The station location will be set from the 

coordinates of the known point. The backsight azimuth will be the value you 
enter in the BS Azimuth field.
Typically, this is an “assumed” backsight and the value will be 0 or North. The 
backsight circle orientation will be set to 0°00’00” automatically.

• BS Point [2]: Backsight point. The station location will be set from the 
coordinates of the known point. The backsight circle orientation will also be 
set to 0°00’00” in that case.

• New Point [3]: This is a variant of backsight azimuth in which the azimuth is 
given to a new point you would like to measure and add to the job.

The diagram below illustrates the three possible scenarios.

NOTE 1: A variant to this procedure exists (whatever the scenario used) if the Survey 
with True Azimuths setting is enabled (see Job > Settings > Surveying tab). In this case, 
the backsight circle will always be set automatically to the true azimuth, either the 
entered one (BS Azimuth then renamed “True Azimuth” scenario and New Point 
scenario) or the calculated one (BS Point scenario). 
NOTE 2: Whatever the method used, you can refine the station setup by making more 
measurements. This is done by activating the Perform Backsight Repetition Set check 
box allowing you to perform direct and reverse measurements. Before you tap on the 
Finish button to end the station setup, you can use the Backsight Sets button to 
perform additional measurements.

The three scenarios are detailed below with the Survey with True Azimuths 
option disabled.

[2]
Known Backsight Point

Known Station Point

[3]
New Backsight Point

Known Station Point

[1]

Known Station Point

Known Azimuth Direction
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Start the station setup as follows:
• Go to the Main Menu, then tap Survey > Station Setup.
• Choose Setup Type= Known Point.
• Enter the name of the station setup point in the Occupy Point field. The point 

name can be entered directly, picked from the map or point list. These 
options can be selected from the  button attached to the Occupy Point 
field. In MAX+ configuration (GNSS + Robotics), the point may have been 
collected using a GNSS receiver just before setting the base.

• If you wish to ignore elevations in your job, check the 2D Survey box. You will 
otherwise enter the height of instrument in the HI field.

• Tap Next.

Then, of the three possible options, choose the one that is suitable for your job:
1. If you choose BS Azimuth:

• Aim the instrument in the direction of a known or assumed azimuth.
• Enter the known or assumed value of azimuth in the BS Azimuth field.
• Tap Set Backsight. The screen provides a summary of what you have just 

done and prompts you to check the setup.

NOTE: If the equipment used is unable to set the backsight circle, the button is 
labeled “Read Backsight” instead of “Set Backsight”.

Check the Setup:
a. If you choose the By Angle option, just make sure the instrument is still 
aimed in the direction of known azimuth, then tap Check. You should 
read the previously set backsight circle.
b. If you choose the By Point option, enter the name of the point used for 
checking, specify the target used on that point, correct the target height 
if necessary and tap Check. A measurement is then made. Check the 
delta values reported on the screen, which should be as close as possible 
to zero.
c. You cannot use the By Distance option in this case.

• If you are satisfied with the read values, tap Finish. You can now start 
measuring new points.
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2. If you choose BS Point:
• Enter the name of the backsight point. It can also be picked from the map 

or the list of points. The resulting backsight azimuth is then calculated 
and displayed just underneath the BS Point field.

• Specify the type of target used at the backsight point (Fixed Target or 
Roving Target).
A “roving target” is when you measure to the backsight with the same rod 
and prism you will be using for your subsequent data collection.
A “fixed target” is when you have a tripod and prism that will remain at the 
backsight and that will be different from the rod and prism you will be 
using for subsequent data collection. See also Managing Smart Targets on 
page 125 for more information on the Survey Pro target database and the 
fixed backsight target.

• Using , select the name of this target. As a result, the HR (height of rod) 
field is updated to provide the height of this target.

• Aim the instrument at the known backsight point.
• Two actions are then possible:

1) Tap Set. The screen provides a summary of what you have just done 
and prompts you to check the setup. Note that the backsight circle has 
been set to 0°00’00”.

NOTE: If the equipment used is unable to set the backsight circle, the button is 
labeled “Read Backsight” instead of “Set Backsight”.

As previously explained for BS Azimuth, you can in the same way check 
the setup either By Angle or By Point (see Check the Setup above).
You can also use the By Distance option. Just make sure the instrument 
is still aimed in the direction of the backsight point and tap Check. The 
measured horizontal and vertical distance errors are reported on the 
screen. They should be as close a possible to zero.
or 2) Tap Measure & Set: This option sets the backsight circle to 0°00’00” 
and also takes a measurement to the point, with the measurement 
results displayed in the next screen.

• Whether you used the first or second option, if you are satisfied with the 
read values, tap Finish. You can now start measuring new points.

3. If you choose New Point:
– Place a target at the unknown (new) backsight point.
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– Aim the instrument at this point.
– Enter the known or an assumed value of azimuth along this direction.
– Specify the type of target used at the backsight point (Fixed Target or 

Roving Target).
– Using , select the name of this target. As a result, the HR field is 

updated to provide the height of this target. Update the height value if 
necessary.

– Tap Measure & Set to measure the new point and set the backsight. 

NOTE: If the equipment used is unable to set the backsight circle, the button is 
labeled “Measure & Read” instead of “Measure & Set”.

– Enter a name and description for the new backsight point.
– Tap  to store the point.
– Review the summary of the station setup, as shown on the screen. If it’s 

not as expected, tap Back and resume the setup.
– If the setup is fine, tap Finish. You can now start measuring new points.

Station Setup on Unknown Point, Resection Method
 The resection method is illustrated below.

At least two known points should be observed to solve the station setup (e.g. 
PT1, PT2). Other known points (PT3, PT4,..) may be added to refine the 
computation.

PT1

PT3
PT2

PT4
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• Go to the Main Menu, then tap Survey > Station Setup.
• Choose Setup Type= Unknown Point/Resection.
• Use the Store Pt and Code or Description fields to enter respectively the 

name and code or description of the point where the instrument is set up. 
(This is a new point, with unknown coordinates.)

• If you will ignore elevations in your job, check the 2D Survey box. You will 
otherwise enter the height of instrument in the HI field.

• You can take one or more shots of each point. Enter the desired number of 
shots in the Shots per Resect Point field. 

• You may want the instrument to perform either Direct and Reverse 
measurements (recommended for station setup) or a Direct Only 
measurement. Use the Sequence field to make this choice.

• Tap Next. This opens the Station Setup screen on which you should define 
the following parameters:
– Resect Point: Enter the name of the first point used (PT1 for example). 

This name can be entered directly, or picked from the map or point list. 
These options can be selected from the  button attached to the Resect 
Point field.
In MAX+ configuration (GNSS + Robotics), you may use the Occupy GNSS 
Point option to collect the point on which your GNSS receiver is standing. 
Once the point has been logged and named, it can be used as a resection 
point.

– Option: Define the type of measurement you will perform on the point 
(Distance and Angle or Angle Only).

– Define the type of target used and its height (HR).

• Tap Observe then Take Shot to start a measurement. You are then taken 
back to the Station Setup screen where the measured point is listed as the 
first point involved in the station setup.

• Repeat the previous two steps for the next point (PT2 for example), and then 
for additional points (PT3, PT4, etc.) for data redundancy.
As you get new points, Survey Pro tries to compute a solution for the station 
location.
When a solution is available, the RMS values of the solution are shown in the 
lower part of the screen.
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You may reject the horizontal or vertical contribution of a point by tapping on 
the corresponding “Yes” which will then be changed into a blank field. Again, 
you will immediately see the impact of this change on the quality of the 
solution.
At this stage (i.e. a solution is now available), you may take measurements to 
as many other points as necessary to refine the station location (these 
points must all be stored in the job). Survey Pro can guide you (or the rodman) 
to each of these points if you don’t know where they are: 
– In the Resect Point field, enter the name of the first of these points (or 

select it from the map or list as you would usually do).

– Tap 
– Use this new screen to find the point. Take several shots and each time, 

follow the guidance instructions until the point is found.

– Then tap , to return to the previous screen, and tap Observe to add a 
measurement to the solution.

– Add other points if necessary using the same procedure.

Also at this stage, if you are using a robotic instrument, you may add a 
measurement to another known point of your choice by first asking Survey 
Pro to turn the instrument to that point:
– Use the Resect Point field to select the name of the desired point.

– Tap  to rotate the instrument in the direction of the point
– Take a measurement to the point
– Add other points if necessary using the same procedure.

• When you are satisfied with the results, tap Next. The screen then shows the 
properties of the station setup. If you scroll down the list of results, you will 
see the components of the final error ellipse for the solved point. 
On this screen, Survey Pro defines one of the control points you have just 
used in the resection method as a backsight point.

• At this stage, you can tap Finish to complete the station setup. The 
instrument circle used for this setup will be the direct circle reading on the 
first resection point used in the setup, unless you are surveying in true 
azimuth mode.
In true azimuth mode, the instrument circle will be adjusted so that your 
circle will now read the true azimuth when pointed at the first resection 
point used in the setup.
Alternatively, you can tap Backsight to proceed to the normal backsight 
setup, with your newly calculated station point as the setup point, and your 
last resection point as the backsight point. It is a good practice to do a 
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backsight check after a resection to ensure the instrument circle is oriented 
as you expected.
When this is done, tap Finish. You can now start measuring new points. 

Station Setup Using Multiple Backsights
 The multiple backsights method is illustrated below.

S, where the station is set up, is a known point. At least one known point should 
be observed to determine the orientation of the instrument and correct it 
accordingly. Other known points (PT3, PT4,..) may be added to refine the 
computation of the correction angle.
• Go to the Main Menu, then tap Survey > Station Setup.
• Choose Setup Type= Multiple Backsights.
• Use the Occupy Point field to enter the name of the point where the 

instrument is set up. (This is a known point, i.e. with known coordinates.) The 
point name can be entered directly, picked from the map or point list. These 
options can be selected from the  button attached to the Occupy Point 
field.

• If you will ignore elevations in your job, check the 2D Survey box. You will 
otherwise enter the height of instrument in the HI field.

• You may want the instrument to perform either Direct and Reverse 
measurements (recommended for station setup) or a Direct Only 
measurement. Use the Sequence field to make this choice.

• You can take one or more shots of each point. Enter the desired number of 
shots in the # of Sets field. 

• Tap Next. This opens the Station Setup screen on which you should define 
the following parameters:
– BS Point: Enter the name of the first backsight point used (PT1 for 

example).

PT1 

PT3 

S

PT2

PT4 
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In MAX+ configuration (GNSS + Robotics), you may use the Occupy GNSS 
Point option to collect the point on which your GNSS receiver is standing. 
Once the point has been logged and named, it can be used as a backsight 
point.

– Option: Define the type of measurement you will perform on the point 
(Distance and Angle or Angle Only).

– Define the type of target used, and possibly its height (HR).
• Tap Observe then Take Shot to start a measurement. You are then taken 

back to the Station Setup screen where the measured point is listed as the 
first point involved in the station setup.
Survey Pro indicates the correction angle needed to the instrument 
orientation so this instrument can accurately measure the azimuth angle to 
this point. This angle is called F1 correction. It is positive for an 
anticlockwise correction, negative for a clockwise correction.

• You may repeat the previous two steps using additional points (PT2, PT3, 
PT4, etc.) for data redundancy.
You may reject the contribution of a point by tapping on the corresponding 
“Yes” which will then be changed into a blank field. You will immediately see 
the impact of this change on the correction value.
When a solution is available, you may take measurements to as many other 
points as necessary to refine the station location (these points must all be 
stored in the job). Survey Pro can guide you (or the rodman) to each of these 
points if you don’t know where they are: 
– In the BS Point field, enter the name of the first of these points (or select 

it from the map or list as you would usually do).

– Tap 
– Use this new screen to find the point. Take several shots and each time, 

follow the guidance instructions until the point is found.

– Then tap , to return to the previous screen, and tap Observe to add a 
measurement to the solution.

– Add other points if necessary using the same procedure.

Also at this stage, if you are using a robotic instrument, you may add a 
measurement to another known point of your choice by first asking Survey 
Pro to turn the instrument to that point:
– Use the BS Point field to select the name of the desired point.

– Tap  to rotate the instrument in the direction of the point
– Take a measurement to the point
– Add other points if necessary using the same procedure.
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• To accept the computed correction value, tap Next>. Survey Pro suggests 
you use the first point measured as the backsight. If you agree, just tap 
Finish to complete the Station Setup.

Variant to the Basic Station Setup Procedures 
There is a variant to the basic step-by-step procedures described above, 
related to your current job settings (in Job > Settings > Surveying tab):
• PPM Correction: By default, the PPM will not show up in the station setup 

routine. But, if you check the box for Prompt for PPM during Station Setup, 
the PPM will become the first step in your station setup routine. 
The PPM correction is applied to all measured slope distances. This may be 
achieved in one of two different ways:
1. You enter the PPM in the instrument which in return will provide Survey 

Pro with slope distances corrected for the PPM.
2. Or you enter the PPM in Survey Pro, in which case the instrument will 

return uncorrected slope distances (make sure the PPM is set to “0” in the 
instrument). Survey Pro will apply the PPM correction to any slope 
distances that will be used in further calculations. 

NOTE: With some instruments (e.g. FOCUS 30 and S6), the PPM correction can only 
be set using the second method.

For any station setup, you can also set the elevation of the station point 
independently using the Remote Elevation routine (see Remote Elevation on 
page 52).
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Remote Elevation
This routine will set the elevation coordinate of the station from a point with 
known elevation. It is accessible from within the first station setup screen by 
tapping the Remote Elevation button (provided the 2D Survey box is 
unchecked).
The known elevation is either that of:
• A point stored in the job. You will select this point from the map or from the 

list of points.
• A point not stored in the job, but its elevation is known, perhaps through past 

results, by calculation, or printed on a data sheet.

Step-by-step procedure:
• Have a target set up on the point.
• Aim the instrument at the point.
• Go to Station Setup and then tap the Remote Elevation button.
• Enter the elevation according to the suitable method.
• Check the HI value.
• Select the target and check the HR value.
• Tap Take Shot. The results of the shot then appears in the lower part of the 

screen.
• Tap  to return to the Station Setup screen and complete the setup 

according to the method you chose.

Fixing Station Setup
You may need to apply corrections to all the measured points sharing the same 
station setup. This can be done using the Fix Station Setup function in the 
Adjust menu.
Two types of transformation can be done:
• Rotation, based on a known azimuth between two points sharing the same 

station setup. You need to specify the value of known azimuth and the two 
point names. When applying the change, all the concerned points will be 
rotated the same way. The original backsight azimuth will be updated as well 
to achieve the desired result (which Adjust > Rotate would not do).

• Translation, based on two points that you specify. The first one is an 
observed point that you would like to translate to another location, and the 
second one is a key-in point created with the coordinates that you would like 
to assign to the first point. When applying the change, all the concerned 
points will be translated the same way. The original occupy point will be 
moved accordingly to achieve the desired results (which Adjust > Translate 
would not do).
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Point Measurement Introduction to Traverse / Sideshot
• Tap Survey > Traverse / Sideshot. This screen allows you to make traverse 

and sideshot measurements. The current setup is summarized at the top of 
the screen.

• Enter the name (Foresight) and description (Desc.) or feature (Feat.) of the 
point you will now be measuring, as well as the type and height (HR) of the 
target used on that point.

• The next step is choosing between sideshot or traverse (Sideshot is the 
default option for the button; tap on the down-arrow if you want to select 
Traverse).
Choosing “Sideshot” means you simply want to take a measurement of the 
point. (See Sideshot on page 53.)
Choosing “Traverse” (see illustration below) means you are expected to move 
the instrument to that point either immediately or after measuring other 
points (sideshot). 

This implies a new station setup is required after moving the instrument. 
(See Traverse on page 54.)
You may want just to perform a measurement, and not store it as a point. In 
this case, use the Measure (or associated Angles Only Measure) button 
rather than the Sideshot button.

Sideshot
• Be sure the instrument is pointed at the target placed over the point.
• Tap Sideshot. Survey Pro returns the results of the measurement in the 

lower portion of the screen ([1]). The point name is automatically 
incremented for the next measurement. Tapping on the Result tab will 
provide more information on the measurement made ([2]).

PT1 PT2
Instrument Target

[1]

PT1 PT2
InstrumentTarget

[2]

[1] [2] 
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Point: Point name
N: Point coordinate Y
E: Point coordinate X
Elev.: Point coordinate Z
Description: Point description
Angle Right: Azimuth angle measured from the occupy point to the foresight 
point (measured in a horizontal plane)
Zenith: Zenith angle measured from the occupy point to the foresight point
(Zenith is measured in the vertical plane, relative to gravity, where 0 is 
pointing straight up, parallel to gravity, and 90 is pointing straight ahead, 
orthogonal to gravity.)
Slope Dist: Slope distance measured from the occupy point to the target
Horz Dist: Horizontal distance calculated from the occupy point to the target
Vert Dist: Vertical distance measured from the occupy point to the target.

• Repeat the above two steps until all your points have been measured. 

Traverse
• Be sure the instrument is pointed at the target placed over the point.
• Tap on the down-arrow by the Sideshot button and select Traverse. The 

screen prompts you to measure a new point, or to pick a point that was 
previously measured from the current station setup (Survey Pro will display 
a list of appropriate points), and then move the instrument to that point. If 
you create a new point to traverse to, you will then be asked to enter the 
description of the point before measuring it.

• After the measurement is done or the point selected, Survey Pro provides a 
summary of what the new station setup will be (see [1] below).

• Move the instrument to the new station point and level it on its tripod.
• Measure the new instrument height and enter the measured value (HI).
• Aim the instrument in the direction of the point you came from (now the 

backsight point).
• Enter the type and height (HR) of the target used on the backsight point (see 

[1]).
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The New Backsight Circle will be preset to zero, unless you are surveying 
with true azimuths.
In the true azimuth case, the circle will be the azimuth from the new location 
occupied by the station back to its previous location, which is now your 
backsight point.

• Two actions are then possible:
1) Tap Set and complete the station setup (see [2]). You have the capability 
to perform several measurements after activating the Perform Backsight 
Repetition Set check box, or by adding new measurements using the 
Backsight Sets button just before tapping on the Finish button to end the 
station setup.
or 2) Tap Measure & Set: This option sets the backsight circle to 0°00’00” 
and also takes a measurement to the point, with the measurement results 
displayed in the next screen. Tap Finish to complete the measurement.

NOTE: The Station Setup routine can be used at any point to occupy any existing 
point in the job at any time. It is up to you to determine if and when this is 
appropriate.

Measure
If you wish to perform just a measurement, and not necessarily store the 
measurement results, use the Measure (or Angles Only Measure) button rather 
than the Sideshot button. You can however save the results in a text file by 
tapping and holding your finger within the results frame on the screen and 
selecting Save Results.
After a measurement has been made, you can however change your mind and 
store the measurement as a point using the Store button (which then replaces 
the Sideshot button).

[1] [2] 
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Repetition Shots
The Repetition shots function allows you to perform sideshots or traverse shots 
using any number (between 1 and 99) of repeated measurements (“Sets”).
• Go to the Survey menu and tap Repetition Shots.

• Tap  in the command bar to access the job settings relating to repetition 
shots (equivalent to navigating to the Job > Settings > Repetition tab).

• Tap the Repetition tab. The Rep Shoot Sequence field allows you to choose 
the desired sequence of repetitions (7 available):
– “FS” stands for “Foresight”: 
– “BS” stands for “Backsight” 
– The ">" symbol is used to denote the next shot coming in the sequence 

using the same face of the instrument (direct or reverse). 
– The "^" symbol is used to denote when in the sequence you will flip the 

instrument to take observations in the opposite face. 

The other parameters on this screen are self-explanatory. Set them to meet 
your application. The Radial Sideshot Seq field allows you to specify the 
sequence of observations to be taken in the Radial Side Shot routine. This 
setting is NOT used for either regular repetition shots or multiple side shots.

• Tap  to return to the Repetition Shots window. 
• Use the Foresight field to enter a name for the point you will measure 

through repetition shots.
• Enter the number of Sets you want the sequence to be repeated.
• Select the type and enter the height (HR) of the target used on the foresight 

point.
• Start the sequence by tapping either HA, ZA, SD or All, whichever is 

appropriate in your case. Depending on the instrument used, run the series 
of measurements manually or let the instrument do this automatically. 
Results are displayed at the end of the sequence (see illustrated).
– Average of: Shows the average angle or distance to the point from all the 

shots taken. The number in parenthesis is the total number of repetitions 
performed.

– Worst Residual: Displays the worst residual calculated from all the sets 
of the selected measurement type.

You may use one or more of the Toss buttons to remove from the solution 
the set of measurements that provided the worst residual. A Toss button can 
only be used if three or more sets have been collected.
When you tap HA, ZA, SD or All, Survey Pro will collect an additional 
observation of that type (or all of them) and add it to the sets already 
collected.
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EXAMPLE: If you had three complete sets, then selected to toss the worst HA, you 
would now have two HA sets, three ZA sets and three SD sets. If you tapped HA, you 
would collect an additional set of horizontal angles only, and on return to this 
screen, you would now have three HA, three ZA, and three SD sets. If you hit HA 
again, on return to this screen you would have four HA, three ZA and three SD sets.

• Additionally from this screen, you can either traverse to the point (tap 
Traverse and then follow the usual traverse procedure) or tap Sideshot to 
store a measurement of the point, based on all the data gathered during the 
repetition shots, to store the point with the measurements taken.

NOTE: The Sideshot or Traverse buttons will not become active unless at least one 
observation for each type of measurement (HA, ZA, SD) has been performed.

If you tapped Sideshot, the observation is used to store a new point, and you 
view the results (see example). If you tapped Traverse, the traverse prompt 
will open and you will be guided through moving and setting the instrument 
on the new occupy station point. The traverse procedure is described above 
(see Traverse on page 54).
Tap Sideshot if you plan to occupy the measured point at a later time. You 
can use the Traverse button later to initiate moving the instrument to any 
point measured from the current station.
Tap  to quit the Repetition Shots function.
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Traversing Reminder on Traversing
When you move your total station forward to any new foresight point, and you 
backsight the previously occupied point, this is called “traversing”.
An important practice is to “close” all the traverses you do. Closing a traverse 
means coming back around the first point in the traverse, observe a known 
point, and then compare your measurement with the known point location.
Once you have closed a traverse, you can check the precision and make sure it 
meets your tolerance specifications. Then you need to adjust the traverse so 
that it closes perfectly. By doing this, the measurement error is distributed 
evenly between the different points of the traverse.
Adjusting a traverse therefore consists of:
• Adjusting the angle misclosure: The error is distributed evenly among the 

different points occupied by the station.
• Adjusting the distance misclosure (also known as Compass Rule or 

Bowditch method): The error is distributed between the different points 
occupied by the station, proportionally to the segment length (traverse legs 
with longer distances get more proportion of error).

Following the adjustment of a traverse, the coordinates of all the side shots 
taken along the way are corrected accordingly, both in rotation (angle) and 
translation (distance).

IMPORTANT: After adjusting a traverse, the points collected in the traverse become key 
in points, which means Survey Pro does not keep track of the vector measurements that 
linked these points together. However, Survey Pro automatically creates an archive of 
the job file as it was before the traverse adjustment so you can come back to it if 
necessary.

Field Methods
Traversing with Survey Pro can be done using one of the following three field 
methods:
• Closed traverse
• Open traverse closed to known points
• Close traverse to a known point.

The three sub-sections below describe the field steps for each of these 
methods and explain in each case how the traverse you have collected can be 
adjusted.
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Closed Traverse
Field Steps:
The simplest method to do a closed traverse is to do a self-contained closed 
loop.
In the traverse example shown on the left, you would proceed that way: 
• Start on point 1, sight point 2 from point 1 with an initial, assumed azimuth 

angle.
• Traverse to point 2, take side shots to points 201 and 202, then traverse to 

point 3, and finally traverse to point 4.
• From point 4, observe back to point 1 and store it as a new point (point 5).
• To finish closing the traverse, occupy point 1, backsight to point 4, and then 

turn the instrument to collect the “closing angle” formed by points 4, 1 and 2.

The traverse angle closure is derived from the geometry of a closed polygon, 
where the sum of the interior angles should always be 180 x (N-2) where N is the 
number of segments in the traverse polygon.
In the case of a four-sided polygon, the difference between the measured 
interior angles and the value 360° is the angle misclosure. The traverse distance 
closure is the coordinate difference between point 1 and point 5.

Adjusting a Closed Traverse:
• From the main menu, select Adjust > Traverse Adjust.
• Tap on the scroll-down list in the middle of the screen and select Closed 

Loop Traverse.
• Tap on the Find Closed Loop Trav... button. The traverse may be found 

either by specifying its first and last points (choose By Traverse Points and 
specify those two points) or by asking Survey Pro to find automatically all the 
existing closed loop traverses, based on the HD (Horizontal Deviation) 
tolerance between the detected first and last points (select By HD Tolerance 
and specify what the HD tolerance should be; 1.0 m by default).

• Tap . The matching closed loop traverse or traverses found in the job are 
listed.

• Select the traverse you want to adjust and then tap .

202

2

1

Measure
Angle

5

3

4

201
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• Indicate which corrections should be calculated: angle and/or distance 
(Compass Rule/Bowditch adjustment and possibly elevations).

• Tap Next>. Survey Pro then warns you of the interdependency of all the 
points.

• Just tap . If angle adjustment is requested, and as prompted, enter the 
closing angle if you have measured it, otherwise keep the prompted value for 
this angle.

• Tap Next>. Survey Pro then calculates the field measurement error. This is 
then presented in two different tabs: Results ([1]) and Map ([2)]. The Results 
tab gives all the details of the calculation. If you open the Map tab, you can 
zoom in on the view after tapping anywhere on the map.

You then have access to the zoom-in setting ([3]) if you wish to see more 
visual details of the results.

Just tap  to close the map and return to the Map tab.
• If you agree with the results of the correction suggested by Survey Pro, tap 

Adjust to apply the correction to the traverse.

[1] [2] [3]
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Open Traverse Closed to Known Points
Field Steps:
Another method to do a closed traverse is to start on a pair of known points and 
finish on another pair of known points. This method is common when you have 
access to ground control points.
For example, you can use GNSS equipment to measure a pair of points on one side 
of a wooded area and another pair of points on the other side of the wooded area, 
and then use optical equipment to measure through the woods between them.
In the traverse example shown on the left, you would proceed that way:
• Set up the station on the second control point (C2) and backsight the first 

control point (C1).
• Traverse to point 1 and then to point 2.
• With the station set up on point 2, traverse to the third control point (C3) and 

store the measurement as a new point (point 3). You can also take side shots 
to points 201 and 202.

• With the station set up on point 3, observe the fourth control point (C4) and 
store the measurement as a new point (point 4).

The traverse angle closure is derived from the difference in bearing between 
measured points 3-4 and control points C3-C4.
The traverse distance closure is the coordinate difference between point 3 and 
point C3. Adjustments for traverse points and side shots are then applied as in 
the case of the closed loop.

Adjusting an Open Traverse Closed to Known Points:
• From the main menu, select Adjust > Traverse Adjust.
• Tap on the scroll-down list in the middle of the screen and select Open 

Traverse.
• Tap on the Find Open Traverses... button.
• Enter the name of your last traverse point (4) and that of the control point 

(C4) that matches this observation. Also select the second to last control 
point (C3).
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• Tap . Survey Pro may find more than one matching traverse. In this case, 
select the traverse that includes all the points starting at C1.

• Tap  again.
• Indicate which corrections should be calculated: angle and/or distance 

(Compass Rule/Bowditch adjustment and possibly elevations).

• Tap Next>. Survey Pro then warns you of the interdependency of all the points.
• Just tap . Survey Pro indicates the resulting closing angle (a read-only value).
• Tap Next> again. Survey Pro then calculates the field measurement error. 

This is then presented in two different tabs: Results and Map (same as in 
Adjusting a Closed Loop Traverse).

• If you agree with the results of the correction suggested by Survey Pro, tap 
Adjust to apply the correction to the traverse.

Closed Traverse to Known Point
Field Steps:
This is a special case of traverse closure where you can only do a compass rule 
adjustment, because you do not have enough measurements to know what the 
angular misclosure is.
In the traverse example shown on the left, you would proceed that way:
• Start with the station set up on the first control point (C1), usually with an 

arbitrary direction (as read on a compass) for the first orientation, since 
there is no azimuth mark visible to sight from point C1.

• Traverse to points 1 and 2, take some side shots (points 201 and 202), then 
traverse to point 3.

• With the station set up on point 3, observe the second control point (C2) and 
store the measurement as a new point (point 4).

The traverse distance misclosure is the difference between the coordinates of 
point 4 and point C2.
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NOTE: It is important that you fix the orientation bias caused by starting from an 
assumed bearing. This is accomplished by the Adjust > Fix Station Setup routine, and 
choosing to fix rotation. This step should be done before attempting to adjust the 
traverse started with an assumed orientation.

Adjusting a Traverse Closed to Known Point:
• From the main menu, select Adjust > Traverse Adjust.
• Tap on the scroll-down list in the middle of the screen and select Closed to 

a Known Point.
• Tap on the Find Traverses button. This opens the Known Location screen. 

The known location may be entered as a point name (this is the case in our 
example) or directly as the coordinates of the known location. To toggle 
between Point and Location, just tap on this field.

• After defining the field as “Point”, enter the name of the point you observed 
and stored as a new point corresponding to the ending control point (point 4 
in the example).

• Tap . 
• Select the traverse that starts at your control point and then tap .
• Indicate which corrections should be calculated: Compass Rule/Bowditch 

Adjustment and possibly elevations:
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• Tap Next>. Survey Pro then warns you of the interdependency of all the points.
• Just tap . You are prompted to enter the name of the control point (in our 

example: C2) corresponding to the point you measured as the closing point 
(point 4) of the traverse.

• Tap . Survey Pro then calculates the field measurement error. This is then 
presented in two different tabs: Results and Map (same as in Adjusting a 
Closed Loop Traverse)

• If you agree with the results of the suggested correction, tap Adjust to apply 
the correction to the traverse.

Canceling a Traverse Adjustment
There is no straightforward way to cancel a traverse adjustment. You can 
however do one of the following, to respectively recover all your points before 
adjustment, or keep a record of what your points were before the adjustment:
• When you accept to adjust a traverse, Survey Pro automatically creates an 

archive of the job file such as it was before the adjustment. So by using the 
File > Backup / Restore function, you have the possibility to restore the job 
file such as it was before the traverse adjustment.

• By anticipation, you can also save the results of the preview report just 
before adjusting the traverse.
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 6. GNSS Surveying

Starting an RTK Base NOTE: You don’t need to set up a base if you are working in a network. Just make sure 
your rover is configured to receive network corrections, and actually receives them 
before you start taking measurements in your job. See Starting an RTK Rover on page 67.

What you have done already:
• You have set up the base GNSS receiver on a tripod over a point of your 

choice and measured the antenna height.
• You have selected GNSS from the instrument icon located on the Home 

screen or Main Menu.
• You have created a receiver profile that matches the use of your receiver as 

a base (or network base) and the receiver has been reported as being “base” 
capable. See GNSS Mode - Connecting Survey Pro to a GNSS Receiver on 
page 31.

• You have made sure the GNSS status is correct at the location where the 
base is to be operated. See Checking the GNSS Status on page 38.

What you should do now:
• Go to the Survey menu and tap Start Survey. You may also find the Start 

Survey function on your Home screen.
• Unless already done, highlight the name of the receiver profile you intend to 

use for operating your base.
For a “network base”, select the network to which the base will deliver its 
corrections by selecting the relevant network profile name. For a “base”, 
there may be additional settings required using the Configure Modem 
button (the radio settings provided by the selected receiver profile may not 
match your case of use).

• Tap Connect.
When creating a job, if you decided not to choose a coordinate system, you 
will be asked to reconsider this choice when starting the base. The Start 
Survey Prompt Projection screen will appear at this time with two possible 
options:
1. Ground Calibration: Choose this option if there is no known projection or 

datum to relate your local grid coordinates to geodetic coordinates 
(through this choice, you confirm your decision to use local control to set 
up a coordinate system). The selection of a geoid is possible after making 
that choice.

2. Mapping Plane: Tap on this button if you now wish to use a coordinate 
system (i.e. known origin and type of projection + known datum or 
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broadcast RTCM datum) that can either be keyed in or picked from Survey 
Pro’s coordinate system database. For more information on the 
projection mode, refer to Introduction to Calibration on page 79.

NOTE: If you always start your GNSS surveys with the same type of projection 
mode, then you can tap Don't ask me again at this prompt, and Survey Pro will 
start the GNSS survey with the settings you used to create the job.

• Survey Pro will poll for the base position. While Survey Pro does this, enter 
the antenna height you measured previously (Measured field) and how you 
measured it (To field).
You may ask the base to log raw data (for post-processing) by just specifying 
a recording interval in the Post Processing Recording Interval field. When 
you start a rover, by default it will automatically use the same recording 
interval as the base you set. Set the recording interval to “Off” if you do not 
want to record raw data. 

• Tap Next. Survey Pro searches the point database for a location that 
matches the current base position (the one that was checked on the 
previous screen). If a matching point is found in the job, or else in the 
reference station database (see Managing Reference Stations on page 84), 
then Survey Pro offers this as the default base point. Tap Change to choose 
a different point or to create a new point for the base setup.

• Tap Next. The base is now started. Survey Pro prompts you to start the rover 
(tap Set Rover) (as if you had tapped Start Survey on the Home screen). 
Underneath the GNSS receiver profiles list, the name of the modem for the 
selected profile is displayed).

NOTE: if you only want to set the base at this time, tap Finish Base Setup. Survey 
Pro will then exit the Start Survey wizard and open the GNSS status page connected 
to the base.
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Starting an RTK Rover This section describes how to configure and start an RTK rover.
What you have done already:
• You have set up the GNSS receiver on a pole and measured the antenna 

height.
• You have selected GNSS from the instrument icon located on the Home 

screen or Main Menu.
• You have created a receiver profile that matches the use of your receiver as 

a rover (or network rover) and the receiver has been reported as being 
“rover” capable. See GNSS Mode - Connecting Survey Pro to a GNSS Receiver 
on page 31.

• You have made sure the GNSS status is correct where you start your survey. 
See Checking the GNSS Status on page 38.

What you should do now:
• Go to the Survey menu and tap Start Survey. You may also find the Start 

Survey function on your Home screen.
• Unless already done, highlight the name of the receiver profile you intend to 

use for operating your rover.
For a “network rover”, select the network from which the rover will receive 
corrections by selecting the relevant network profile name. For a “rover”, 
there may be additional settings required using the Configure Modem 
button (the radio settings provided by the selected receiver profile may not 
match your case of use).
For an "RTX" rover, no additional settings are required.

• Tap Connect. If your receiver operates in RTX, refer to RTX Correction 
Service on page 128 to read about the additional steps that take place at this 
point.
When creating a job, if you decided not to choose a coordinate system, you 
will be asked to reconsider this choice when starting the survey (unless you 
started your own base and you were already prompted to make a choice at 
that time). The Start Survey Prompt Projection screen will appear at this 
time with two possible options:
1. Ground Calibration: Choose this option if there is no known projection or 

datum to relate your local grid coordinates to geodetic coordinates 
(through this choice, you confirm that you will be using a local coordinate 
system defined by existing control points). The selection of a geoid is 
possible after making that choice.

2. Mapping Plane: Tap on this button if you wish to use a coordinate system 
(i.e. known origin and type of projection + known datum or broadcast 
RTCM datum) that can either be keyed in or picked from Survey Pro’s 
coordinate system database. For more information on the projection 
mode, refer to Introduction to Calibration on page 79.
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NOTE: If you always start your GNSS surveys with the same type of projection 
mode, then you can tap Don't ask me again at this prompt, and Survey Pro will 
start the GNSS survey with the settings you used to create the job.

• While the rover receives data (corrections and position) from the base, enter 
the rover antenna height you measured previously (Measured field) and how 
you measured it (To field).
You may ask the rover to log raw data (for post-processing) by just specifying 
a recording interval in the Post Processing Recording Interval field. If you 
earlier set up a base doing the same, then make sure you are using the same 
recording interval for both receivers. Select “Off” if data logging is not required.

• Tap Next.
• Confirm or change the point where the base is located.

For most receivers, the height of the base antenna is broadcast over the 
data link, so you do not need to change the base antenna height displayed on 
this page.

NOTE: The broadcast height will be reduced to the antenna phase center, and will 
show as an “Unknown” antenna brand.

If your rover receiver does not get the base antenna height from the data link 
(Measured= ”0.000”, Base Brand= “Unknown” and Antenna Type= “Unknown 
Broadcast”), you need to specify the antenna brand and type used at the 
base, enter the measured height and specify the mark used to measure the 
height (tap on the Change button to access the base’s Antenna Height 
definition screen).

NOTE: Next time you run your rover, Survey Pro will automatically query the Base 
Info list (see Managing Reference Stations on page 84) for the suitable base to use 
with the rover, thus skipping the base location selection step described here.
If both the base location and antenna type match, Survey Pro will automatically use 
the antenna parameters stored in the Base Info list for that base, and not the 
antenna parameters broadcast by the base.
The message Rover is ready to set with reference station “x”. will indicate that the 
base was picked from the reference station data base, whereas the message Rover is 
ready to start a survey with base point ‘x’. will indicate it was found in the survey file.
Any time a VRS (Virtual Reference Station) survey is started, excluding a PRS 
(Physical Reference Station) in a VRS survey, automatic base selection will be done 
as well. The message Rover is ready to start a survey with virtual base ‘x’ will be 
displayed in this case. 
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• If the Finish button is displayed, this means the coordinate system is fully 
solved, and you are ready to collect data.
If the Next button is displayed instead, this means you are working in Default 
Ground mode, where a calibration is always required, or you are working in 
mapping plane mode but you started your base on a new point with a new 
autonomous position. Tap this button. You will see a new screen asking for 
occupation of control points (see screen example).
For the sake of clarity, calibration is discussed in a separate section (see 
Solving Calibration on page 79).

NOTE: Solving the calibration is optional when your coordinate system is a known 
map projection and datum, and your base was setup on a known point.

At this stage, you may tap Start Now to begin surveying with a temporary 
calibration solution, which will solve your translation, but the scale and 
orientation parameters will remain unknown. You can collect data points; 
their local coordinates will be calculated with this temporary calibration.
At any time during the survey, you can collect the required number of GNSS 
control points and solve the proper calibration for your site. After you solve 
the calibration, any data collected points will automatically be recalculated 
using the latest solution of coordinate system.
Some routines, such as point stakeout or offset points, cannot be run until 
the calibration is properly solved.

• Before starting data collection, tap  in the command bar. This directly 
opens the Meas. Mode tab (part of the Job Settings screen) where you can 
set the acceptance criteria for different types of point collection:
– On the Data tab, define the criteria for all the points you will collect using 

Point from the Data Collection screen or from the active survey map.
– On the Topo tab, define the criteria for all the points you will collect using 

Topo SS from any measurement screen or from the active survey map. 
Topo criteria are also used for feature collection.

– On the Check tab, define the criteria for all the points you will collect after 
tapping successively Control (on the Data Collection screen), then 
Check.

– On the Control tab, define the criteria for all the points you will collect 
after tapping successively Control (on the Data Collection screen), then 
Control.

– On the Stakeout tab, define the criteria for all the points you will collect 
through any stakeout routine. 
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– On the RTX tab, define the criteria for all the points you will collect if you 
have selected “RTX” as the survey function for your receiver (if the 
receiver allows it). See also Setup Type field in Modifying a Receiver 
Profile on page 35 or Managing Your Receiver Profiles on page 33.
If you collect a topo point in RTX, the Occupy for and Automatically 
accept when criteria is met fields on the RTX tab are simply ignored.
The value you choose in the HRMS field is used to test RTX convergence 
for the computed position. If no HRMS value is specified (the check 
button is cleared), a default value of 5 centimeters will be used to test the 
convergence.

Independently for each type, you can set the following criteria:
– Solution quality: “Fixed RTK only” or “Code, Float or Fix”
– Max. tolerated HRMS and VRMS values
– Max. tolerated PDOP value
– Minimum number of satellites required (Min SV).
– eLevel Bubble: Some models of GNSS receiver models are fitted with a 

built-in electronic tiltmeter providing level information directly on the 
screen. Check this option if you want to use it. This option will not appear 
if the connected GNSS receiver does not incorporate a tiltmeter.

– Minimum position averaging time, in seconds (Occupy for)
– Automatically accept data collection or not when criteria are met.

NOTE: The last two criteria make sense when the receiver is set to static to give 
the best averaged position. Since in Topo SS point collection Survey Pro is 
allowed to store a point using the single latest epoch of data, these two criteria 
are irrelevant in that case (compare the two screen examples on the left).

If you enabled raw data logging for post processing, the Post Process tab is 
also accessible through which you will set the RTK autonomous points field 
as follows:
– Allow in PPK Survey: Choose this option to allow Survey Pro to store an 

autonomous solution for a data point. This will happen during an RTK 
survey in case of intermittent or prolonged data link failure. By doing this, 
you will be able, after the survey and through post-processing, to 
calculate a precise solution for the point using the data from the GNSS 
raw data file (PPK logging file).

– Do Not Store: No autonomous point will be stored.
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On the Post Process tab, you can also set an alarm to warn you if the number 
of satellites, or the remaining free memory size drops below a preset 
threshold, or if the HDOP exceeds a preset limit.

• Tap  to save your settings. Survey Pro displays the Data Collection screen.

Collecting Data Standard data collection routines are presented below. Keep in mind that you 
may have to solve the calibration before your measured GNSS coordinates are 
properly transformed into your local grid (see Solving Calibration on page 79).
Remember also that you can access the data collection functions from the 
active map after you have tapped and held on the map and selected Survey 
Mode from the popup menu.
From the Data Collection screen, you can perform several types of point 
collection:
• Point: Tap this button to collect the averaged position of a point after a 

timed, static occupation on that point. The acceptance criteria defined on 
the Data tab will apply. (The corresponding markers will be inserted into the 
GNSS raw data file if raw data logging for post-processing is activated.) 

• Topo SS: Tap this button to collect the “instant” position solution of a point. 
The acceptance criteria defined on the Topo tab will apply.

In its upper part, this screen provides detailed, real-time GNSS status 
information:
• Type of computed position (Fixed, Float, RTX,..) preceded by a green icon if 

it complies with the current accuracy requirements (else red) 
• Age of corrections (in seconds)
• Number of satellites used
• Coordinates of the last computed position, expressed in the chosen 

coordinate system
• PDOP
• VRMS (estimated vertical accuracy) and HRMS (estimated horizontal 

accuracy), represented respectively by small vertical and horizontal rulers.

Collecting Points
Place the pole in vertical position over the point to be surveyed and tap Point. to 
start collecting data on this point.
The workflow of this routine will depend on the choice you made for the 
following acceptance criteria:
• Occupy for checked and a minimum averaging time (in seconds) requested: 

After tapping Point, you will see screen type [1] on which the lower-left 
button label will show Survey Pro counting down from the requested 
averaging time (Wait xx). After that time, Accept is restored as the button 
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label so you can decide on what to do: Accept the point collection now or 
wait more time for an even better averaged position.

NOTE: You can tap the Wait xx button to accept the point before the minimum 
duration has expired. You will in return be informed that the minimum duration is 
not yet met, at which point you can discard the warning by tapping Accept anyway.

• Occupy for cleared: Screen type [2] will be displayed for an unlimited period 
of time, until you tap Accept. Point collection is then complete, unless some 
other acceptance criteria are not met in which case you will see screen type 
[3] after you tap Accept. You can also choose to accept the point before the 
wait time expires. Still with this option cleared, you can spend some time 
checking GNSS reception: This is done by pressing the GNSS Status button 
on screen type [2]. Closing the GNSS status screen will take you back 
directly to screen type [2].

• Automatically accept when criteria is met checked: The use of this 
parameter makes sense when it is combined with Occupy  for checked. 
Survey Pro will automatically store the point at the end of the averaging time, 
unless some other acceptance criteria are not met. In that case, at the end 
of the count down, the Accept button will be restored on the screen and 
when you tap on it, you will see screen type [3].

When screen type [3] is displayed, you can either ignore the warning message 
(tap Accept Anyway), or ask for more data collection on the point (tap Keep 

[1] 

[3] 

[2] 
72



Measuring) until you are satisfied with the collected data (you will then tap 
Accept to end the point collection). 
NOTES: On-screen eLevel information is available only for those receivers fitted 
with an embedded electronic tiltmeter, and provided you enabled its use (see 
page 70). The View Map/View Data button allows you to choose the view that is 
the most convenient to you when logging points.

Collecting Topo SS Points
This is the simplest way of collecting a point. Just tap on the Topo SS button 
when you are physically on the point and you have previously named and 
described the point (see Name and Description fields). Survey Pro will save the 
point position right away (no position averaging), assigning the last computed 
position to the point. A new position being computed every second, the best 
possible accuracy for the point is achieved if you wait about 1 second, once 
physically on the point, before tapping on the Topo SS button. The Point field is 
then automatically incremented, ready for storing a new point.
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Collecting Offset Points When GNSS reception is poor on a point of interest, you may resort to the Offset 
Point method to collect it.
To select this function, go to the Survey menu and tap on Collect Offset. This 
function is also available from the Data Collection screen. Offset points may be 
collected in one of three ways:

1. By azimuth and distance (Az./Dist.): You choose a nearby reference point ( ) 
where you know GNSS reception is good and from this point, you measure 
the azimuth and distance to the offset point ( ) using any means other than 
GNSS. You stand on the reference point and collect it, then you enter the 
measured azimuth and distance ( ) to the offset point. Then you store the 
offset point under a new point name (the point is therefore defined by the 
coordinates of the reference point and the measured azimuth and distance).

2. By 2-point azimuth and distance (2-Point Az.): You choose two nearby points 
(reference point: , azimuth point: ) where you know GNSS reception is 
good. You measure the distance from the offset point ( ) to the reference 
point using any means other than GNSS. This distance is measured in one of 
four possible directions compared to the reference point, thus determining 
the location of the offset point compared to the other two points:

One after the other and in any order, you stand on each of these points and 
collect them, then you enter the measured distance and tell Survey Pro 
where the offset point is located compared to the direction from the azimuth 
to the reference point (“Forward”, “Left”, “Right” or “Reverse”). Then you store 
the offset point under a new point name.

3. By distance/distance intersection (Dist. /Dist.): You choose two nearby points 
(reference point 1:  and reference point 2: ) where you know GNSS 
reception is good and from each of these points you measure the distance 
to the offset point ( ). You stand on each of these points and collect them. 
Then you enter the distance from each of these points to the offset point. 
Survey Pro will in return view the possible solutions for the offset point. 
Choose the one that suits with what you see in the field and then store the 
offset point under a new point name.

Az.

1.

Dist.

N

2.

3.

Dist.

Dist. 2

Dist. 1

Right

Forward

Reverse

Left

Direction Offset Point Location

Forward Aligned with, and beyond Az-to-Ref vector

Left
To the left of the Az-to-Ref vector, on a line perpendicular to this vector passing 
through the reference point.

Right
To the right of the Az-to-Ref vector, on a line perpendicular to this vector passing 
through the reference point.

Reverse Somewhere on the Az-Ref segment.
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NOTE: In all three methods presented below, the reference and azimuth points 
are assumed to be new points that you have to collect. But be aware these 
points may also be existing points selected from either the list of points or from 
the map view.

Collecting an Offset Point by Azimuth & Distance
• Choose Offset Type= Az./Dist.
• Stand on the reference point then tap on the  Ref. button to collect this 

point. This delivers an instant or averaged position solution for the point, 
depending on the choice made from the down arrow attached to this button. 

• Using appropriate tools, measure the distance and azimuth from this point 
to the offset point, then tap  Az./Dist. and type in the measured values. 
You may need to type in the heights of the instruments used if appropriate.

• Tap  to validate these measurements, then tap  Store to name and log 
the offset point.

Collecting an Offset Point by 2-Point Azimuth & Distance
• Choose Offset Type= 2-Point Az.
• Stand on the reference point then tap on the  Ref. button to collect this 

point. This provides an instant or averaged position solution for the point, 
depending on the choice made from the down arrow attached to this button. 

• Go to and occupy the azimuth point then tap on the  Az. button to collect 
this point. This provides an instant or averaged position solution for the 
point, depending on the choice made from the down arrow attached to this 
button. 

• Using an appropriate tool, measure the distance from the offset point to the 
reference point. Then tap  Dist. and type in the measured value.

• Tap  to validate this measurement.
• Take a look at the map on the screen to deduce where the offset point would 

be on the screen compared to the two collected points, based on what you’ve 
done in the field. Choose between “Forward”, “Left”, “Right” or “Reverse” to 
qualify this location (see explanations further above).
NOTE: The two collected points may be swapped using the scroll-down menu 
attached to either the Ref. or Az. button.

•  Tap  Store to name and log the offset point.
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Collecting an Offset Point by Distance/distance Intersection
• Choose Offset Type= Dist./Dist.
• Stand on the first reference point then tap on the  Ref. 1 button to collect 

this point. This provides an instant or averaged position solution for the 
point, depending on the choice made from the down arrow attached to this 
button. 

• Using an appropriate tool, measure the distance from the collected point to 
the offset point. Then tap  Dist. 1 and type in the measured value. Tap  
to validate this measurement

• Go to and occupy the second reference point then tap on the  Ref. 2 button 
to collect this point. This provides an instant or averaged position solution 
for the point, depending on the choice made from the down arrow attached 
to this button. 

• Again, measure the distance from the collected point to the offset point. 
Then tap  Dist. 2 and type in the measured value. Tap  to validate this 
measurement

• Take a look at the map on the screen and see which solutions Survey Pro 
suggests for the offset point. Choose the one corresponding to what you see 
in the field (Solution 1 or Solution 2).
If no solution is available, that means the two circles do not intersect. Please 
double-check the distances measured and/or the distance values you typed 
in.
NOTE: The two collected points may be swapped using the scroll-down menu 
attached to either the Ref. 1 or Ref. 2 button.

•  Tap  Store to name and log the offset point.
76



Collecting Features Go to the Survey menu and tap on Collect Feature. Features can be collected 
using one of the methods below. In all methods, each new point name is 
incremented automatically to the next available name.
• Time Interval: After accepting the first point, additional points will 

automatically be stored after the specified time interval (in seconds) has 
elapsed. 

• Dist Interval - 2D or 3D: After accepting the first point, additional points will 
automatically be stored after traveling the specified 2D or 3D distance.

• Dist. Interval - Vertical: After accepting the first point, additional points will 
automatically be stored after traveling the specified vertical distance.

• Hold Still For: After accepting the first point, additional points are 
automatically stored when the pole is held in the same spot for the specified 
interval of time (in seconds).

• Level and hold still for: Same as the previous option but you are required to 
set the range pole vertical, by watching the e-level reading, before Survey 
Pro starts down-counting the specified interval of time (in seconds) and log 
the point automatically when time is up.

• Manual: Prompt Once: Will store points in the same way as Topo SS from the 
Data collection screen, incrementing the point name automatically after 
each stored point.

• Manual: Prompt Every Point: Same as Manual: Prompt Once except that you 
are prompted for a new description, layer and attribute with each point 
stored.

When shown, Interval is the field where you should enter the time or distance 
interval used for continuous data collection.
Use the Update Rate field to set the speed at which the rover receiver should 
deliver position solutions. When Five Hz is selected, the receiver will compute 
positions five times a second minimizing the measurement latency.
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Collecting Data Out
of a Survey

If you tap Data Collection on the Survey menu to work with the selected GNSS 
receiver but without having first started a survey, Survey Pro will invite 
you to choose between two options:

• Start the survey first, then collect data (this is the recommended way of 
using Survey Pro).

• Start collecting data right away (and possibly running any stakeout routines) 
using your receiver in Autonomous Rover mode, that is, with the receiver only 
capable of delivering autonomous position solutions. You will need to 
confirm this choice.
Working in this mode means you will collect LLH coordinates in the open job 
regardless of the chosen acceptance criteria in the Data Collection function.

NOTE: Most receiver models will provide autonomous position solutions in that 
mode. However some may keep the ability to deliver more accurate solutions (i.e. 
DGPS, Float or Fixed).
If you are using such a receiver, to remind you at all times that you are working with 
no survey started, position solutions will be reported with a tilde character (~) 
placed before the position status if better than Autonomous (e.g. “~Float” instead of 
“Float”, “~Fixed” instead of “Fixed”, “~RTX” instead of “RTX”).
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Solving Calibration Introduction to Calibration
A GNSS calibration is a 2D similarity transformation. The GNSS LLH coordinates 
are transformed using a map projection into XY mapping plane coordinates. The 
XY mapping plane coordinates are then translated, scaled and rotated into your 
local grid using the calibration.
Your choice of projection mode will determine the mapping plane used for this 
procedure:
1. If you started your job with no coordinate system, then there is no projection 

and no datum available to relate the LLH coordinates to the local grid 
coordinates. In this case, Survey Pro will initialize a default map projection 
when you collect your first GNSS control point. This default projection will be 
created to give ground distances at the height of the first control point.
Because the orientation of your local grid relative to geodetic North is 
unknown, you must collect at least two GNSS control points to solve the 
scale, rotation, and translation between the default map projection and your 
local grid coordinates.

2. If you started your job with a map projection and datum, then the measured 
LLH coordinates can be transformed into local coordinates using this 
selected map projection. In this case, because the scale and orientation is 
defined by the map projection, you need only to solve for the translation 
parameter.
If you set your base on a known point, then no calibration will be required. If 
you set your base on a new autonomous point, then you must collect at least 
one GNSS control point to solve the translation parameter.
A calibration with multiple points can still be performed to give extra 
redundancy to the calibration solution.

A calibration is solved by collecting GNSS control points. A GNSS control point is 
a point with an accurate local grid coordinate that you occupy with the GNSS 
rover. The LLH from the GNSS measurement is combined with the accurate grid 
point to form a calibration point pair. The calibration is then solved from these 
control points to give you the best fit between your GNSS measurements and 
the local ENE grid coordinate system.
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Calibration Procedure, Illustrated
The calibration procedure can be split into three distinct steps. These are 
described below as flowcharts:
• Step 1: When you start a survey, Survey Pro will report the need for 

calibration on the Calibration Status page, which will guide you through the 
process of collecting the minimum amount of control points required for a 
unique solution of the calibration.

Base on a New Point, GNSS Resection Case 

Survey Pro Will 
Automatically Advance 
to Step 2 

Base on a Known Point, GNSS Backsight Case 

Yes No 
Collected 
Enough 

Control Points for 
Unique Solution? 
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• Step 2: The Calibration check page will guide you through the process of 
collecting an additional GNSS control point to check the solution, and to 
provide redundancy for the best fit least squares solution.

Base on a New Point, GNSS Resection Case 

Survey Pro Will 
Automatically Advance 
to Step 3 

Base on a Known Point, GNSS Backsight Case 

Yes No Check Point 
Successfully 
Collected? 
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• Step 3: The calibration results page will solve the calibration and display the 
results.

You can change the contribution of your control points to the calibration 
solution by tapping on the columns next to each point name in the list:
– Tap in the H column to deselect or select a point to be used in the 

horizontal calibration.
– Tap in the V column to deselect or select a point to be used in the vertical 

calibration.

Tap Finish to accept 
the good calibration 

Tap Finish to accept the solution anyway 

Tap Add Point to collect more 
control points, as in Step 2. 

Yes 

Yes No No 

From Step 2 

To Step 2 

Blunders 
Detected Control points 

are spaced evenly 
and have good 

geometry? 

Blunder 
Detection Runs 

 

No Blunders 
Detected 
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Any time you change the contribution of a control point, the Finish button 
will change to a Re-Solve button. Tap this button to re-solve the calibration 
using the new contribution of that control point.

After you have solved the calibration as part of the Start Survey wizard, you can 
use the Survey > Control > Control routine, or the Survey > Projection > Solve 
Calibration > Add Point routine to add additional GNSS control points, re-solve 
the calibration, and have all the collected points updated with the latest 
calculation.

Special Case of One-Point Calibration
When you are using the Default Ground Calibration projection mode, and you 
have started a new job with no points, or only one point in it, you have the option 
of doing a one-point calibration to create the coordinate system for your job. If 
these conditions are met, the screen will look as illustrated.
You can tap One Point to set up the calibration for a ground level survey at the 
reference height displayed on this screen. Since there is only one point in the 
job to start, the orientation is not fixed by the local grid coordinates, so only the 
translation needs to be solved, which is possible from a single point.

How Survey Pro Deals With Base Location
With no known coordinate system used:
• If you set up the base on a known point, a geodetic point will be created for 

the base location, using the autonomous LLH coordinates from the GNSS 
receiver as the geodetic position for the base.

EXAMPLE: Base location “B1” will have for geodetic counterpart a point named 
“B1_GNSS” with description “B1”.

This point will automatically become a GNSS control point, with the known 
grid location of the base paired with its new geodetic coordinates. 

• If you set up the base on an unknown point, Survey Pro will create a default 
point named “BASE_1” using the autonomous LLH coordinates from the GNSS 
receiver as the geodetic position for the base. This point is not eligible as a 
GNSS control point, because the grid coordinates are not known until they 
can be calculated with a calibration solution. Until the calibration is 
available, the grid coordinates of this point will be “-- -- --”.
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NOTE: You can set only one new autonomous base position in each job.

With a known coordinate system used:
• If you set up the base on a known point, the selection of a known coordinate 

system will allow Survey Pro to compute and attach the equivalent geodetic 
(LLH) coordinates to that point. 

• If you set up the base on an unknown point: Same as with no coordinate 
system used.

Detected Change of Base If the rover receives the coordinates of a new base station (through the 
broadcast corrections message), a warning message will then be displayed. 
This may occur when the receiver switches to a new network cell, or when using 
a radio link and another operator is also broadcasting on the same radio 
channel.
In this case, tap OK to acknowledge the warning message. This will take you to 
the Start GNSS Survey screen. From that screen, you can verify and validate the 
new base.

Managing Reference
Stations

Survey Pro keeps up to date a list of reference stations that the software uses 
to enhance the search for base points when starting a survey. To view this list:
• Go to the Main Menu.
• Tap Survey, then Base Info.
The Current Base tab shows the properties of the base point currently used in 
the survey. 
The Ref Stn List tab lists all the base points Survey Pro has been using so far. 
The list includes:
• Base point names followed by the term “(database)”: These are read from the 

reference station database. By default, any NTRIP station set up in a survey –
whether a single base, or a PRS in a VRS survey– is automatically saved to 
that database (in addition to being part of the survey). This is done because 
it is assumed that these stations are likely to be re-used in other survey jobs 
to provide the required base points. 
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• Base point names followed by the term “(survey)”: These are read from the 
current survey and so belong to the survey file. These are considered to be 
temporary base points (reference stations using radios) not likely to be re-
used. That’s why they are not by default saved to the reference station 
database. You may however do so if you wish (see below).

From the Ref Stn List tab, you can: 

• Tap  to view all the properties of any reference station: base point name, 
geodetic location, antenna used, and if applicable, additional information 
about the NTRIP mount point used.

• For a “re-usable” reference station (<base point name> (database)), you can 
use the context menu (tap and hold the base point name) to either rename or 
delete the reference station, or edit the properties of its antenna.

• For a “temporary” reference point (<base point name> (survey)), you can use 
the context menu to save the reference point to the reference station 
database.

Ending a Survey Go to the Home screen and tap End Survey. Confirm the end of survey by 
tapping End.
A survey in progress implies that either a base or a rover or both are running. 
You will need to end the currently running survey if you wish to reset the base or 
rover.
Opening an existing job or creating a new one while a survey is in progress will 
automatically end the current survey. 
When an RTK rover or/and an RTK base is used in a survey, then ending this 
survey will cause the rover to stop listening for corrections, and/or the base to 
stop sending out corrections. (ProMark will however continue to operate as 
rovers.)
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7. Leveling

Introduction What Leveling Is
Leveling is a surveying method that allows the most accurate measurement of 
vertical distances between points. Using a starting point with known elevation, 
the leveling survey method allows you to transfer the elevation to new points by 
measuring vertical distance differences between the known elevation and the 
position of the level instrument.
Leveling data collection is organized into level loops. A level loop is a sequence 
of measurements that starts and ends on a point of known elevation. Many level 
loops start and end on the same point, hence the name “loop”. However, you can 
start and end a level loop on different points, provided the elevation is known for 
both points.

NOTE: Collecting and storing points in a level loop is different than optical or GNSS 
surveying in that for leveling, you often need to take many measurements before you 
reach the point of interest in the survey where you want to store a new elevation.

The procedure for leveling with Survey Pro is almost the same no matter which 
leveling method you are using. The main difference for each method is the type 
of information that is collected with each shot taken.
You should have now selected a leveling method and possibly connected an 
instrument to Survey Pro (if you are using an electronic level or an electronic 
total station for trig leveling). See Leveling Mode - Getting Ready for Leveling on 
page 40 for more information. 
It’s a good idea, in the current job, to create the point from which your first level 
loop will start. This point, which must have an accurate elevation, can also be 
created when creating the level loop.

Other Definitions
• A level loop is a series of level measurements that start with a backsight 

measurement on a known point with a valid elevation. This point is referred 
to as the opening Control Benchmark (or opening CBM). The elevation of the 
opening CBM will NOT be modified by the elevation measurements you will 
collect in the loop.
A level loop is closed by taking a measurement to a point with a valid 
elevation. This point is referred to as the closing Control Benchmark (or 
closing CBM). Often, the closing CBM is the same point as the one where you 
started the level loop, but it can also be any known point with an accurate 
elevation.
86



A level loop can have two states: open or closed. Once a new loop is created, 
it is automatically opened. It will remain open until you decide to close the 
loop. A level loop is closed after shots are taken to the closing CBM.
Level loops are stored within the current Survey file, which can contain any 
number of level loops.
Any level loop can be selected from the current job as the active loop for data 
collection. Once a loop is closed, it cannot be re-opened for data collection. 
It can only be viewed or adjusted. Only closed loops can be adjusted.

• A level turn represents the set of backsight-foresight observations collected 
from a given location where your instrument is set up. Each level turn 
calculates the elevation of the point in the loop for which the foresight 
observation is made. A level loop typically consists of many level turns 
between each level benchmark point stored.

• A benchmark is a point in your level loop for which you will store the elevation 
as a point record in Survey Pro. A benchmark is usually a permanent mark, 
such as a brass survey disk or a stable iron rod in the ground, that can be 
reoccupied at a later date.

• A turning point is an intermediate point used to connect two benchmarks. 
Because a level turn is usually short (typically less than 50 meters), many 
turning points are often needed to make the connection between two 
consecutive benchmarks.
As opposed to benchmarks, turning points are not permanent marks on the 
ground and are not stored in the job. They only exist while the rod occupies 
them during the foresight/backsight measurements.

• A sideshot point is a point of interest for which you will store the elevation as 
a point record in Survey Pro. Unlike benchmarks, you do not turn through 
sideshot points in the level loop, they are spur observations to the loop.

• A stakeout point is like a sideshot point in that you do not turn through these 
points. They are spurs to your loop. A stakeout point is used to display the 
cut/fill information from the level observation and some design elevation.
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Creating or Selecting a
Level Loop

• From the main menu, tap Survey > Select/Create Loop.

NOTE: Survey Pro will list all the level loops that haven’t been closed yet. You may 
select one of them and tap Activate Selected Loop to choose to work in this level 
loop.

• To create a new level loop, tap on the New Loop button. This opens the New 
Level Loop screen.

• Enter a name for the new level loop (e.g. MyLoop).

• Tap on  to define the opening CBM. The point may be selected from either 
the map or the list of points. You may also create the opening CBM at this 
stage.

NOTE: The opening CBM must be a point in the job with a user-entered, keyed-in 
elevation. You cannot select points derived from measurements for your opening 
CBM.

• Tap Next.
• Use the Desc field to enter a description for the level loop (e.g. “Boundaries”). 

Below this field, the current definition of the level loop you want to create is 
displayed. You may tap Back if you wish to modify this definition.

• When the definition of the level loop is complete, tap the Create Loop button. 
A message is then displayed prompting you to proceed with level 
measurements in the loop.

• Tap OK to close the message. This automatically opens the screen from 
which you can start collecting elevations in the level loop. (This screen can 
also be accessed from the main menu by tapping Survey then Level.)
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Collecting Elevations in an
Open Level Loop

Description of a Simple Level Loop
A simple level loop is illustrated below.

Collecting elevations in a simple level loop consists of the following:
1. In every level loop, you will start with a backsight observation to the opening 

CBM.
2. You will observe some number of turning points next. Turning points are not 

stored in the survey file. They are used as intermediate points to transfer the 
elevation between benchmarks.

3. After some number of turning points, you will reach a point you wish to store 
an elevation for. You will observe this point as a benchmark. You can observe 
a brand new point as a benchmark, in which case a new point with only an 
elevation coordinate will be created. You can observe an existing point as a 
benchmark, in which case you will have the option of updating only the 
elevation of the existing point, and its horizontal coordinate will remain 
unchanged.

4. After some number of turning points and benchmarks stored, you will reach 
the end of your level loop. You will close the loop by collecting a foresight 
observation to the closing CBM. This can be either your starting point, or it 
can be another point of known elevation.
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In practice, the sequence of observations will be as follows:
1. The instrument is set up somewhere close to the maximum allowable sight 

distance (typically 30 meters) away from the opening CBM. A backsight 
observation is taken to the opening CBM.

2. A foresight observation is made to the first turning point. This turning point 
should be chosen in such a way that the instrument is located midway 
between the opening CBM and that turning point.
Steps 1 and 2 are called the first turn, and are indicated as BS and FS in the 
above diagram.

NOTE: A usually observed tolerance is that the foresight and backsight distances for 
each turn should not be different from each other by more than ± 5 meters, or some 
similar value. Refer to Level Settings on page 41 to set this tolerance.

3. The instrument is set up midway between the first turning point (TP1) and the 
second turning point (TP2). A backsight observation is made to TP1 and a 
foresight observation is made to TP2. These observations constitute the 
second turn.

4. The instrument is set up midway between the second turning point (TP2) and 
the first point of interest (BM1). A backsight observation is made to TP2 and 
a foresight observation is made to BM1. These observations constitute the 
third level turn.

5. Make the same types of observations for the next level turns (TP3-BM1, TP4-
TP3, BM2-TP4, TP5-BM2, TP6-TP5, BM3-TP6, TP7-BM3).

6. In the last level turn, a backsight observation is made to TP7 and a foresight 
observation is made to the closing CBM, which here is the same point as the 
opening CBM (it could be a different one as long as it has accurate elevation). 

There may be variants to this simple level loop. You can for example shoot 
sideshot points or stakeout points as you go along the level loop. This is 
explained in Collecting Elevations for Sideshot and Stakeout Points on page 93.
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Collecting Elevations in a Simple Level Loop
After creating/selecting a loop, Survey Pro prompts you to start collecting 
elevations in the loop. A new screen is displayed providing the list of possible 
actions. The name of the open level loop is indicated in the upper bar.

NOTE: The  button provides access to the level settings (see Level Settings on 
page 41).

Follow the procedure below to complete a typical level loop:
1. Set up your instrument midway between the opening CBM and the first 

turning point and have your rods ready for backsight and foresight 
observations.

2. Unless already done, select Survey from the main menu, then Level.
3. Tap Turn to Turning Point. Based on the shooting sequence you have 

chosen, Survey Pro will prompt you successively to take all the necessary 
direct and reverse shots to the backsight point (the opening CBM) and the 
foresight point (the first turning point in the level loop).
If in manual leveling, you will be requested to enter the following parameters 
measured with your standalone instrument:

4. After completing the shooting sequence, Survey Pro will show the results. 
Tap Store Observation if you are satisfied with the results. If these are of 
poor quality you can remove some of them (use the Toss button) or add new 
backsight (BS) and/or foresight (FS) observations.

5. After you have tapped Store Observation, thus accepting the results, Survey 
Pro will prompt you to start a second level turn.

NOTE: As you move along the loop, at the end of each level turn, Survey Pro provides 
an up-to-date summary of the measurements made so far (total number of level 
turns made, etc.)
If you tap on the Notes vertical tab, you will see a summary of all the measurements 
made so far.
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6. Move the instrument for the next level turn and then start a new shooting 
sequence.
If the foresight point is a turning point, tap Turn to Turning Point again. If the 
foresight point is a point of interest (i.e. a benchmark), tap Turn to 
Benchmark. In both cases, proceed as explained above.
Again, Survey Pro will provide results at the end of the second level turn that 
you will need to accept by tapping Store Observation. Additionally for a 
benchmark, you will need to enter a name and description for that point.
This may be an existing point in the job (select it from the list or the map), in 
which case Survey Pro will prompt you to update its elevation, or a new point, 
in which case Survey Pro will create this point with just its elevation. Tap  
to continue.

7. For the last level turn, tap Turn to Benchmark when you are ready for the 
shooting sequence. Proceed in the same way as for any benchmark.
The difference is when you name the point once the observation is 
accepted, you will have to select the closing CBM from the list of existing 
points. In our example, this point is also the opening CBM, a point named 
“CBM”. Survey Pro will then alert you that this point cannot be modified but 
will give you the option to close the level loop (see screen example).

8. Tap Close Loop on Existing Point. Survey Pro will then provide a report on 
the level loop you are about to close.

9. Tap Close Level Loop. A message informs you that the loop has been closed 
successfully.

10. Tap OK. Survey Pro goes back to the loop summary screen from which you 
will notice that no more action can be taken for the loop.

11. Tap  to return to the home screen.
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Collecting Elevations for Sideshot and Stakeout Points
For some level turn, you have made your backsight measurement to the 
previous turning point or benchmark. At this stage, the elevation of the 
instrument is known.
Before completing the turn with a foresight measurement to the next 
benchmark or turning point, you can shoot any number of sideshot or stakeout 
points. These points are spurs to the loop, as they are never used in any 
backsight measurements. They are stored in the job file.
Typically with stakeout points, you will want to compare the measured 
elevations to design points so you can compute cut/fill values.
Follow the instructions below to collect elevations of sideshot or stakeout 
points in an open loop:
• For the next level turn, instead of tapping Turn to Turning Point or Turn to 

Benchmark, tap Sideshot or Stakeout.
• Have your instrument and rods set up accordingly.
• Start the shooting sequence: First make a backsight measurement to the 

last measured benchmark or turning point, then shoot the sideshot or 
stakeout point. For a stakeout point, you will need to specify which point you 
want to measure. This may be an already existing point or a point you create 
on the spot.

• If your measurements are all good, tap Store Observation.

• Name the point and tap .
For a sideshot point, you just need to name the point (Point field).
For a stakeout point, Survey Pro will ask you to name the as-staked point 
(Point field) and will suggest to add a default description for this point in the 
form “pt<stakeout_point_name>” (Description field).

NOTE: If you wish to collect a series of sideshot or stakeout points from the same 
instrument setup, Survey Pro will ask you to perform foresight measurements 
directly to the second and next points (no backsight measurements need to be 
repeated in this case as Survey Pro has already collected these measurements for 
the first of these points).

• When you are finished with the collection of your sideshot or stakeout 
points, tap Turn to Turning Point or Turn to Benchmark to complete the level 
turn. Once again, you will just have to perform foresight measurements to 
this point, the backsight measurements having been already made.

• Start a new level turn.

Sx1

Sxn

Sideshot or
Stakeout Points
Sx1.. Sxn

TP3

TP4

FSFS
BS

BS
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Adjusting a Closed Loop Adjustment may be used to remove the error computed from any existing closed 
loop. This is a simple arithmetic adjustment where the computed error can be 
either distributed equally among each instrument setup in the loop, or a 
weighted adjustment can be applied where the error is distributed based on the 
length of the backsight and foresight distance of each turn.
1. From the main menu, tap Survey > Adjustment
2. Choose how you want Survey Pro to distribute errors. Weigh by # of Setups 

divides the computed error equally among each instrument setup selected 
in the loop. Weigh by length of Setups distributes the error where each 
instrument setup is adjusted by an error proportional to the length between 
them, so that instrument setups that are farther apart will carry a larger 
portion of the error adjustment than those closer together.

3. Choose the portion of the loop you want to adjust. Adjust Loop from Begin 
to End will include every instrument setup of the selected level loop in the 
error adjustment. Adjust Loop From a Specific Point to End will only adjust 
the turning points and benchmarks starting from an alternative benchmark 
(that you need to specify in the Begin CBM Pt field) to the end of the loop.

4. Use the Closed Loop Name drop-down list to select the name of the loop you 
want to adjust. Only closed loops are listed here.

5. Tap Next to access the Adjustment Preview screen.
6. Tap Adjust to start the adjustment. At the end of this process, a message will 

inform you that the job file has been backed up and this backup file includes 
the archive of the adjustment.

7. Tap OK to close the message and read the results of the adjustment.

8. Tap  to close the results screen.
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Running the 2 Peg Test The 2 Peg test is used to check the collimation error of an automatic level 
instrument. This test can be used for electronic automatic levels and manual 
automatic levels. The test will compute the error, which can then be used to 
adjust the horizontal cross-hair of the instrument.
1. Position two rods 50 to 90 meters apart (165 to 300 feet).
2. Pace off the distance between the rods and set up the level midway between 

them. (The placement of the rod over Point B can be adjusted after shooting 
Point A.)

3. Carefully level the instrument. You should be able to rotate the instrument 
180° around its vertical axis without the bubble moving away from the 
center.

4. From the main menu, tap Survey > 2 Peg Test.
5. Tap Take Shot. You are now prompted to take each set of shots to the rod 

over Point A. Once each shot is completed for the number of sets entered in 
the Level Settings screen, you will return to the Peg Test screen.

6. Turn the instrument to the rod over Point B.
7. You can optionally tap Check H Dist to verify the instrument is centered 

between the two rods.
The distance to Point B will be measured and compared to the horizontal 
distances previously measured to Point A and a come/go distance will be 
provided so the rod at Point B can be moved to equal the horizontal distance 
to Point A prior to taking the shots that will be used to compute the error.

8. Tap Take Shot. You are now prompted to take the required shots to the rod 
over Point B. Once completed, the Peg Test screen will open with a new 
graphic showing the next instrument setup.

9. Move the instrument as close as possible to the rod over Point A where a shot 
can still be taken to it. This is typically about 3 meters (10 feet) from the rod.

10. Tap Take Shot. You can now take the required shots to Point A from the new 
instrument setup.

11. Once complete, turn to Point B and take the required shots to that point.
12. After the final shot is taken, the Peg Test Results screen will open showing 

the details of the shots taken and the computed error.

13. Tap  to close the results screen.
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8. Stakeout Routines

This section introduces the basic stakeout routines with optical and GNSS 
instruments. When you become familiar with these routines, you will be able to 
extend your knowledge on more specific stakeout routines, such as stake to 
line, slope staking, etc.

What you should have done already: 
• You should have now completed the station setup with your optical 

instrument.
• You should have now solved the calibration with your GNSS receiver.
• If the points to stake are not in your job, you can use the File > Import 

function to import your points to the job (see Importing Data on page 18). 

The built-in electronic compass (if there is one in your data collector) may be a 
valuable tool during the guidance phase as its activation will translate into 
accurate N/S indications on the stakeout screen (see Electronic Compass on 
page 126 for more information).

Selecting Points to Be
Staked, “Next Point”

Scenario

Whether you are working in GNSS or optical, Survey Pro offers two different 
ways of selecting points for stakeout work:
• By Points method (see screen [1] below): This is the simplest method. You 

just select the point, from the open job, from either the list of points or the 
map view, and then you stake it out. Icons assigned to points remain the 
same ( ) at every step of the stakeout procedure.

• By Managed Points method (see screen [2] below): This method gives 
better control over the whole stakeout process. You need to create a list of 
design points. Icons assigned to these points are distinct from other points 
and later will change after the points have been staked. See “By Managed 
Points” Method on page 97 for more information on this method.

To choose one of the two methods, go to Stakeout > Stake Points and use the 
button located in the upper-left corner (see diagram below).

[1] [2]
96



“Next Point” Scenario. After you have staked out a point, Survey Pro may help 
you select the next point to be staked. This may be:
• Next Point by Increment: The point whose name matches the increment you 

specify (see screen [1] above). Available in By Points method only.
e.g. “ST101” first staked and Increment= 2, then next point will be “ST103”.

• Next Point by Closest Point: The point the closest to the one you have just 
staked (see screen [2] above). If the By Managed Points method is used, 
Survey Pro will search for and prompt the closest design point, ignoring all 
the other types of points. With the By Points method, Survey Pro will search 
for the closest point, regardless of its type (unstaked, staked or 
undifferentiated).

• Next Point in Order: The next point in the list of managed points. Available in 
By Managed Points method only.

“By Managed Points” Method
• Tap Stakeout > Manage Design Points (or tap Stakeout > Stake Points and 

then tap on the Manage Design button).
• All points are necessarily picked from the open job. For more details, see 

screen and instructions below.

– [1]: Used to select points from the map.
– [2]: Used to select points by specifying a point name (e.g. “ST100”) or a 

range of point names (e.g. “ST200-ST300”. Then tap Add or the Enter key 
to add the point or range of points to the list [6].

– [3]: Used to select points using another selection criterion (non-control 
points, distance, description, code or layer).

– [4]: Indicates the current number of staked and unstaked points.
– [5]: Used to choose which type of points to view in the list (all, unstaked 

points only, or staked points only)
– [6]: Current list of managed points, according to viewing option [5].
– [7]: Set of seven buttons allowing you to make these changes to the list 

of managed points:

[1]

[3][2]

[5]
[4]

[6]
[7]
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: Moves the selected point by one position to the top of the list.

: Moves the selected point by one position to the bottom of the list.

: Changes the selected point from staked to unstaked point, or vice 
versa.

: Changes all points in the list from staked to unstaked points, or vice 
versa.

: Deletes the selected point from the list (but the point still exists in 
the job).

: Deletes all points from the list (but the points still exist in the job).

: Reverses the order of the points in the list (e.g. “P1, P2, P3” to “P3, P2, 
P1”).

NOTE: You cannot add the same point twice to the list.
• When the list is complete, tap  to save all the changes made to the list. 

(Tapping  would cancel all those changes.) You can then start staking out 
the first point.

NOTE: The icon of an unstaked point will change from  to  only if you store the 
measured position as a new point in the job (which will be assigned a ( ) icon).

Staking Points With a
Mechanical Optical

Instrument

• Go to the Stakeout menu and tap Stake Points.
• Select the point to be staked using one of the two possible methods, as well 

as the criterion allowing Survey Pro to prompt the next point to be staked 
(see Selecting Points to Be Staked, “Next Point” Scenario on page 96).

• Choose the type of target used and set the height of the rod (HR field). The 
information underneath describes the current station setup.
(You may use the Backsight button to check the station setup or start a new 
setup.)

• Tap Solve. The Stake Points screen now indicates the angle and distances 
the instrument should measure with the target placed exactly over the 
design point.
It may be convenient at this point to change the circle setting so that it reads 
zero when the total station is facing toward the design point. This can be 
done by tapping the Circle Zero button. The first time you tap this button 
during a stakeout session, a message will warn that the original backsight 
reference will be lost.
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The following appears when zeroing the circle:
– A new backsight circle value is computed, sent to the instrument and 

stored in the raw data.
– The Angle Right value is changed to zero to reflect the change (see 

example). The instrument now needs to be turned horizontally to zero 
to face the design point.

– To prevent errors, the backsight setup is invalidated when exiting the 
Stakeout function. You will need to reset your backsight circle to the 
proper reference after exiting stakeout before collecting any new data.

• Whatever your choice about the circle setting, orient the instrument as 
requested so the instrument is facing the target.

• Tap Stake then Shot to take a measurement. The screen returns the results 
of the measurement, providing information to adjust the position of the 
target (see screen example):
– FORWARD / BACK: Indicates if the rod must move forward (toward the 

instrument) or backward (away from the instrument).
– Go RIGHT / Go LEFT: Indicates if the rod must move to the right or left 

from the instrument’s point of view.

NOTE: You can also get the reverse indication (i.e. displaying directions from 
the rod’s viewpoint) by clearing the View From Instrument to Rod (non-remote) 
option in Job > Settings > Stakeout tab.

– CUT / FILL: Displays the required amount of cut or fill to bring the stake 
point to the design point’s elevation.

– Rod Elev: Displays the elevation at the rod’s location computed from the 
last shot.

• When you are satisfied with the location of the target, stake the point and 
then do one of the following: 
1. Before moving on to the next point, you may want to store the location of 

the as-staked point: While still standing on the target, tap Store, name 
and describe the point (the default description prompted by Survey Pro is 
in the form “ST<name_of_point_you have_just staked>), then tap  to 
collect the point. This point will be marked with a  icon.

2. Or If you wish to stake the next point without storing the results of this 
staked point, tap Stake Next.
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Staking Points With a
Robotic Optical Instrument

• Go to the Stakeout menu and tap Stake Points.
• Select the point to be staked using one of the two possible methods, as well 

as the criterion allowing Survey Pro to prompt the next point to be staked 
(see Selecting Points to Be Staked, “Next Point” Scenario on page 96).

• Choose the type of target used and set the height of the rod (HR field). The 
information underneath describes the current station setup.
(You may use the Backsight button to check the station setup or start a new 
setup.)

• Tap Stake. This opens the Remote Staking screen.
If the status on that screen indicates that robotic tracking is not locked on, 
you can tap the Remote button to open up the Remote Control screen, where 
you can initiate a search for the target. Then tap  to close this screen.
The Remote Staking screen (illustrated) will guide you to the design point. 
Survey Pro offers two different navigation modes to help you walk to the 
design point:

Tap on the button in the upper-right corner to change the navigation mode:

– : When this button is displayed, the top of the screen shows the 
direction to the total station ([1]).

– : When this button is displayed, you see a copy of the map view on this 
screen ([2]), including background maps, if any made visible. You may 
tap within this area to switch to the complete map view.

In both navigation modes, the screen provides information on how far you 
are from the design point:
– FORWARD / BACK: Indicates if the rod must move forward (toward the 

instrument) or backward (away from the instrument).
– Go RIGHT / Go LEFT: Indicates if the rod must move to the right or left 

from the rod’s point of view. This requires that you have cleared the View 
From Instrument to Rod (remote) option in Job > Settings > Stakeout tab, 

[1] [2]
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otherwise you will get the reverse indication, i.e. directions from the 
instrument’s viewpoint.

– CUT / FILL: Displays the required amount of cut or fill to bring the stake 
point to the design point’s elevation.

– Rod Elev: Displays the elevation at the rod’s location computed from the 
last shot.

• Walk toward the design point following the instructions on the screen: 

When you get closer to the design point, the graphic will change to assist you 
in more precisely locating the design point. The point to stake becomes the 
fixed center of the display and the rod becomes the object that is moving. 
This aids in precisely positioning the rod over the point. A red arrow 
indicates the direction in which to go.

1. Distance to go is between 3.0 and 0.3 m (10 and 1 ft): Four dark-green 
spots appear around the graphic.

2. Distance to go is less than 0.3 m (1 ft): The spots around the graphic turn 
light green. 

Symbol Meaning

Design point location.

Your current location.

Instrument location.

Scale used on the graphic. Represents the circle radius.

FORWARD/BACK: xxx
Go LEFT/Go RIGHT: xxx
FILL/CUT: xxx

Horizontal and vertical components of the distance still to go.
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• When you are satisfied with the location of the target, tap Done to access 
the Stake Points screen. The screen indicates how close you are to the 
design point.

• Stake the point and then do one of the following: 
1. Before moving on to the next point, you may want to store the location of 

the as-staked point: While still standing on the target, tap Store, name 
and describe the point (the default description prompted by Survey Pro is 
in the form “ST<name_of_point_you have_just staked>), then tap  to 
collect the point. This point will be marked with a  icon.

2. Or If you wish to stake the next point without storing the results of this 
staked point, tap Stake Next.

Whatever your choice, you will then be taken back to the Stake Points screen 
with the next point to stake automatically selected, (based on the Increment 
value you entered previously). 

NOTE: At this stage, you may:
- Change the elevation of the design point after tapping Change.
- Tap the Turn button to automatically turn the instrument toward the design point.
- Tap the Shot button to re-measure the point.
- Collect a Topo SS point using the Topo SS button.
WARNING: Be sure you are using the Store button to store stakeout data. The Topo 
SS button only stores sideshot data.
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Staking Points With GNSS • Go to the Stakeout menu and tap Stake Points
• Select the point to be staked using one of the two possible methods, as well 

as the criterion allowing Survey Pro to prompt the next point to be staked 
(see Selecting Points to Be Staked, “Next Point” Scenario on page 96) 

• Set the rover antenna height.
• Tap Stake. This opens the screen that will guide you to the point. Survey Pro 

offers three different navigation modes to help you walk to the design point 
(the screenshot examples shown below are those of an SP80 for which an e-
level is displayed. Note that not all GNSS receivers have this tool. When no e-
level is available, the corresponding area on the screen is left empty).

NOTE: In the example above, the direction to follow is provided as Go South / Go 
West instructions. Survey Pro can instead provide Azimuth / Distance to the point if 
it’s more convenient for you. Go to Job > Settings > Stakeout tab to change the 
setting of the Display Directions As field. Point tolerance (different from 
acceptance criteria) can also be set on this tab. 

Tap on the buttons shown in the upper-right corner (  /  /  ) to 
change the navigation mode:

– : When this button is displayed, the top of the screen shows the 
direction in which you are walking ([1]). A large red arrow will appear as you 
walk. The North (N) and South (S) directions will be shown as well. You can 
also define a reference point or azimuth using the Ref... button. The 
resulting direction will appear as a blue line starting from your current 
position.

– : When this button is displayed, the top of the screen shows the 
selected reference point or azimuth you select through the Ref... button 
([2]).

– : When this button is displayed, you see a copy of the map view on this 
screen ([3]), including background maps, if any made visible. You may 
tap within this area to switch to the complete map view.

[1] [2] [3]
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• Walk toward the design point following the instructions on the screen (see 
table below).
Remember the rover receiver is always in dynamic mode (>ROVING button 
displayed) as you navigate to the design point: 

NOTE: You can use the Topo SS button any time along the way to store any point of 
interest. Survey Pro will ask you to name and describe that point before storing it.

When you get closer to the design point, the graphic will change to assist you 
in more precisely locating the design point. The point to stake becomes the 
fixed center of the display and the rod becomes the object that is moving. 
This aids in precisely positioning the rod over the point. A red arrow 
indicates the direction in which to go.

1. Distance to go is between 3.0 and 0.3 m (10 and 1 ft): Dark-green spots 
appear around the graphic.

2. Distance to go is less than 0.3 m (1 ft): The spots around the graphic turn 
light green. 

3. Your current position is within the acceptance criteria defined on the 
Stakeout tab: The rover and the design point are practically 
superimposed at the center of the graphic. 

Symbol Meaning

Design point location.

Your current location.

Reference point or azimuth.

Scale used on the graphic. Represents the circle radius.

Go N/S: xxx
Go E/W: xxx
FILL/CUT: xxx

Horizontal and vertical components of the distance still to go.
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• When you have located the design point and you wish to collect a static RTK 
occupation at this point in order to get a more precise position averaged 
from multiple epochs, you should toggle to occupying mode by tapping the 
>ROVING button (which is then changed into an >OCCUPYING button). This 
will turn the receiver into static mode for the occupation.

• When you are satisfied with the occupation results, you can tap Accept to 
finish the stakeout measurement. Depending on the acceptance criteria you 
set on the Stakeout tab, the button label may show Wait xx before it becomes 
an Accept button. The screen then shows the results of the position 
computation for the staked point.

NOTE 1: At this stage, you may tap Shot to re-measure the point. You may also 
change the elevation of the design point by tapping Change.
NOTE 2: If you are simultaneously collecting raw data for post-processing, the as- 
staked point is automatically stored when you tap Accept on the previous screen, 
provided you did a static occupation on the point.
WARNING: Be sure you are using the Store button to store stakeout data. The Topo 
SS button only stores sideshot data.

• Stake the point and then do one of the following: 
1. Before moving on to the next point, you may want to store the location of 

the as-staked point: While still standing on the target, tap Store, name 
and describe the point (the default description prompted by Survey Pro is 
in the form “ST<name_of_point_you have_just staked>), then tap  to 
collect the point. This point will be marked with a  icon.

2. Or If you wish to stake the next point without storing the results of this 
staked point, tap Stake Next.

Whatever your choice, you will then be taken back to the Stake Points screen 
with the next point to stake automatically selected, (based on the Increment 
value you entered previously). 
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Other Stakeout Routines You can use Survey Pro for other stakeout routines:
• Stake to Line: Allows you to locate any position in relation to a predefined 

line. The line can be defined by two points, a point and direction, a polyline 
or the centerline of an alignment. Distance, direction and cut/fill information 
is provided so the rod/the rover can locate the line by traveling the shortest 
possible distance (a perpendicular offset to the line).
Compared to point stakeout, the guidance screen (illustrated) will be 
automatically restored after you have stored a point, ready for storing the 
next point. This routine is often used to keep the rod on-line while clearing 
line along a property boundary.

• Offset Staking: Is used to stake the center of a road, the road edge, the curb/
ditch edge, or any offset at fixed intervals. An existing polyline, alignment, or 
a specified point range can define the centerline of the road.

• Slope Staking: Is used to locate the catch points for a roadway in any terrain. 
The first screen is used to define or select the line that describes the centerline 
of the road to be slope staked. An existing polyline or alignment can be 
selected, or a series of existing points can be entered to define the centerline.

• Point Slope Staking: Is a simplified version of the Slope Staking routine.
• Stake Skew Line: is used to stake a usually short straight line (a skew line) 

intersecting the current polyline at a given point and with a given skew angle 
(for example this function is useful for staking a culvert going under a road).

• Line and Offset, Curve and Offset and Spiral and Offset: Are used to stake 
stations at fixed intervals on respectively a line, curve or spiral, or at an 
offset to it.

• Show Station: Allows you to see where the rodman/rover standing anywhere 
near a polyline, a range of points that define a line, or an alignment is located 
in relation to the line.

• Store Offset Points: Is used to store points in the current job at a specified 
offset from an existing polyline or alignment at a specified interval.

• Stake DTM: Allows you to stake an area and get cut/fill information between 
the point being staked and a reference DTM surface at the same horizontal 
coordinates (see chapter 9 in this manual for more detail).

• Define a Location: Is used to manually enter the distance and direction to a 
new point from any existing reference point and then stake out the new point.

• Where is Next Pt?: Provides instructions to locate the next point in the job 
taking into account the current location of the operator (or rodman) and a 
reference point. 

• Navigation: Allows you to navigate to existing points using autonomous 
positions from a GPS receiver that outputs a NMEA signal. The routine also 
allows you to store coarse-precision GPS points.
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9. DTM

Survey Pro allows you to stake DTMs (Digital Terrain Models) imported into 
Survey Pro. Survey Pro can also be used to create DTMs.
Survey Pro displays a large map view of the DTM so you can easily work from that 
view. In addition, you may choose which text data you want to view and choose 
to hide all the DTM triangles for better use of your background maps.   
Before you start staking a DTM, you may set a vertical offset to the DTM surface 
so you can stake sub-grades and super-grades.
Survey Pro also allows you to calculate volumes and export the DTMs you 
created with the software.
NOTE: All screen shots in this chapter originate from a Ranger 7 data collector 
and are based on the use of a GNSS instrument. The same can be obtained from 
an optical instrument.

Importing a DTM File The supported input formats for DTM data are the following:
• LandXML (*.XML): A Land XML file may contain more than one DTM surface. 

When you choose this file format, you will see an additional screen 
prompting you to select the surfaces from the Land XML file. You can import 
any or all of the surfaces in the Land XML file, and each one will be loaded as 
a separate DTM in your Survey Pro job.

• DXF (*.DXF): Because a DXF file does not specify distance units, when you 
choose this file format you will be prompted to specify the units used in the 
file. The default choice will always be the current units of your job.

• DTM (*.DTM): TDS/Spectra Foresight DTM format file. Because a DTM file 
does not specify distance units, when you choose this file format, you will be 
prompted to specify the units used in the file. The default choice will always 
be the current units of your job.

• Trimble TTM (*.TTM): Trimble native format for DTM data.

To import a DTM file into the open job:
• From the main menu, select DTM then Manage DTMs.
• Tap on the Import button then select the type of file format you wish to 

import.
• Browse to the folder where the DTM file is stored, select the desired file, then 

tap .

NOTE: Imported DTMs cannot be edited in Survey Pro.
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Creating a DTM With Survey Pro, you can create a DTM from the points present in the open job. 
The DTM source can either be a layer or it can be individually selected points. In 
the latter case, there are multiple ways to select those points.
There are two optional ways to modify a DTM surface that you have created:
• Select a closed polyline as a boundary to the DTM. The boundary will include 

all the selected points in the interior and exclude all points outside the 
boundary when creating the DTM.

• Select one or more polylines used as breaklines to force TIN nodes at the 
breaklines (TIN: Triangulated Irregular Network).
The illustration below shows how a breakline affects the TIN. [1]: without 
breakline, [2]: with breakline (no triangles cross the breakline). 

To create a DTM in the open job:
• From the main menu, select DTM then Manage DTMs.
• Tap on the Create button then select the source of your DTM (Layer or Points):

– If the selected source is Layer, use the Layer scroll-down list to select the 
name of that layer. A boundary can be used to exclude some of the points 
on the layer if desired.

– If the selected source is Points, use the Manage Points button to select 
all the points that should be part of the DTM.

• Enable the Use Boundary check box if you wish to define a boundary for the 
DTM, otherwise keep it disabled.
If enabled, using the Tap Polyline button allows you to select a closed 
polyline created beforehand. Using the To/From... button allows you to 
create this closed polyline.

• If necessary, use the Breaklines button to add one or more polylines used as 
breaklines.

• Tap , name the DTM and then tap  again. You may use the View DTM 
2D or View DTM 3D button to view the resulting DTM (see example on the left).
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Viewing a DTM
To view a DTM found in the open job:
• From the main menu, select DTM then Manage DTMs.
• Select the DTM you wish to view then tap View DTM 2D or View DTM 3D to 

respectively visualize the DTM in two (2D) or three dimensions (3D). For a 2D 
view, tap on the DTM view once again to open the DTM preview and access 
the palette of buttons (on the left).
Depending on whether you choose 2D or 3D, the palette is different as 
illustrated and explained below.
1. Sets the zoom level so that the entire job can be seen. 
2. Sets the zoom level so that the active DTM can best be seen on the 

screen.
3. Zooms the map view in by one step after each click.
4. Zooms the map view out by one step after each click.
5. Allows you to drag a box across the screen. When your finger or stylus 

leaves the screen, the map will zoom to the box that was drawn.
6. Zooms to a point you specify. The whole map is then moved in such a way 

that the chosen point occupies the center of the screen.
7. Opens a window allowing you to change the map display options. These 

include showing/hiding point/line names, codes, elevations, etc. and 
giving access to grid lines, DTM list, layers list and basemaps list.

8. Allows you to change the 3D viewing angle. The changing icon below 
appears at the same time so you can adjust this angle by referring to the 
orientation of the three axes (Northing, Easting, Elevation):

9. Allows you to drag the view in any direction without changing the 3D 
viewing angle.

10. Resets the view to a direct, overhead plan view.
11. Resets the view to side-on profile view. This viewing angle is perfect for 

identifying elevation spikes in the surface. The previous icon then looks 
like this: 

12. Increases the vertical exaggeration of the 3D view. The resulting 
magnifying ratio is indicated before the map scale value.

13. Decreases the vertical exaggeration of the 3D view. The resulting 
magnifying ratio is indicated before the map scale value.

NOTE: In 3D view, when seen from below, triangles are shaded.

2.

3.

4.

5.

8.

9.

11.

12.

13.

6.

7.

1.

10.

2D

3D
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Staking a DTM To stake a DTM:
• From the main menu, select DTM then Stake DTM.
• Select the desired DTM from the Surface drop-down list.
• Make the following additional settings:

– With Centerline: If you wish to see station and offset data, enable this 
option and then tap Choose Centerline to specify this polyline. It is 
assumed this polyline has been created beforehand in the job. When you 
use a centerline, the following distances are computed: Station and 
Offset Left/Right.

– Add Vertical Offset: If you wish to modify the elevation of the surface by 
a constant amount, enable this option and then enter a value in the text 
box underneath. 

• Tap Next>.
While measuring on the DTM surface, you can use the palette of buttons on 
the left to change the view of the DTM:
1. Sets the zoom level so that the entire job can be seen. 
2. Sets the zoom level so that the active DTM can best be seen on the 

screen.
3. Activates the Follow me mode, which re-centers the map around the pole 

(or rod) location when the pole (or rod) gets too close to the edge of the 
map screen. The map is not constantly re-centered but only when 
required to keep the pole (or rod) on the screen.

4. Zooms the map view in by one step after each click.
5. Zooms the map view out by one step after each click.
6. Allows you to drag a box across the screen. When your finger or stylus 

leaves the screen, the map will zoom to the box that was drawn.
7. Zooms to a point you specify. The whole map is then moved in such a way 

that the chosen point occupies the center of the screen.
8. Shows or hides the DTM triangles.
9. Opens a window allowing you to change the map display options. These 

include showing/hiding point/line names, codes, elevations, etc. and 
giving access to grid lines, DTM list, layers list and basemaps list.

10. Opens a window allowing you to choose and order the data you wish to 
display on the map view (current values of Cut/Fill, DTM EL, Northing, 
Easting, Elevation, Station, Offset Left/Right). With an optical 
instrument, these parameters are also computed: Horizontal Angle, 
Zenith Angle, Slope Distance, Horizontal Distance and Vertical Distance. 
Use the up and down vertical arrows to move up or down the selected 
data within the list.

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.
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• On each position you occupy on the DTM surface, you can see that the 
corresponding triangle (TIN) has a bold contour (see [1] below). The Station 
and Offset Right/Left distances will also be computed if you are using a 
centerline (see [2] below).

• When required, you may log the position of any point by tapping Accept (or 
Store with an optical instrument).

Calculating DTM Volumes Survey Pro allows you to compute the quantities of cut and fill and the resulting 
total volume between a DTM surface and a reference elevation, or datum, or 
between two DTM surfaces that you specify.
To make these computations:
• From the main menu, select DTM then Calc DTM Volumes.
• Use the first Surface field to select the DTM you want to compare to a 

reference.
• Select the reference, either a datum (i.e. a flat plane) defined as the 

elevation of a point you select, or a second DTM (tap Compare to DTM and 
select the second DTM from the second Surface field).

• Tap Solve. The results are provided automatically on the Result. tab.

Exporting a DTM The unique export format is LandXML (*.XML).
Assuming a DTM was created in the open job, do the following to export the DTM:
• From the main menu, select DTM then Manage DTMs.
• Select the surface from the list that you want to export.
• Tap on the Export DTM button.

• Browse to the folder where the exported file should be stored then tap .

[1] [2]
111



10. Survey Pro’s On-Board Version

Survey Pro is used on board a Nikon Nivo or Spectra Precision FOCUS total 
station. After you have powered on the instrument, wait until the screen 
displays the desktop. Then do the following:

• Double-tap the Survey Pro icon: . Survey Pro starts initializing the 
instrument. The Level Bubble screen is then shown (see screen example).

• Level the instrument and enable or disable the compensator, as required.
• Tap  when done. This opens the Quick Shot screen.

You may take measurements with Survey Pro without opening a job. You may 
also create or open a job where you can collect all your measurements and/or 
use as reference other measurements you collected earlier in that job.

NOTE: The onboard version of Survey Pro will always start with no job open regardless 
of whether you ended your last Survey Pro session with a job open or not.

Working With No Job Open The Quick Shot screen you get at startup can be split into different parts:
• Command bar ([1] to [9])
• Function buttons ([10] to [13])
• Result pane ([14])
• Target management and EDM measurement mode ([15])
• Other control buttons ([16] to [18]).

Robotic Instrument:

[1] [2] [3] [4] [5] [6] [7] [8] [9]

[10]

[16] [17] [18]

[11]

[12]

[13]

[14]

[15]
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Mechanical Instrument:

Command bar:
• [1]: Provides access to Online Help.
• [2]: (Robotic instrument only) Denotes keyboard used in numeric mode.
• [3]: Provides status of visible laser pointer:

– : Off. Tapping this icon will toggle it On.

NOTE: Standard safety precautions should be taken to ensure that persons do 
not look directly into the beam.

– : On. Tapping this icon will toggle it Off.

For safety reasons, this button is always accessible so that at all times you 
can easily disable the laser pointer whatever the screen you are on.

• [4]: Battery status. This icon provides access to the power off setting 
through which you can set an idle time at the end of which the instrument 
will be turned off automatically. 

• [5]: Provides access to the instrument settings (specific to each 
instrument).

• [6]: This icon allows you to switch to another data collection mode (using a 
data collector through a serial cable, Bluetooth or in Robotic mode).

• [7]: Quick Pick function: Provides quick access to common Survey Pro 
functions. About and Level Bubble are the only two selections available 
unless a job is open. After a job is opened, the list will populate with available 
functions.

[1] [3] [4] [5] [6] [7] [8] [9]

[10]

[13][14]

[15]

[16] [17]
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• [8]: Provides access to Survey Pro settings:
– Units tab: Used to set distance and angle units, directions, azimuth type 

and the order in which to display/deliver coordinates.
– Format tab: Used to set the number of decimal places displayed by the 

instrument for each type of measurement.
– Quick Shot tab: Used to choose which results to display (HA, ZA, SD or HA, 

HD, VD) and which function to assign to the Measurement key (Measure 
Only or Measure and Store). Measure and Store requires an open job. See 
Working With a Job Open on page 116.) 

• [9]: Used to exit.

Function buttons:
(More functions are available from these buttons with a job open. See Working 
With a Job Open on page 116.)
The left-arrow button located before each function button opens a related 
menu. Tapping directly on the function button is equivalent to selecting the first 
option on the menu.
• [10]: Sets the circle to 0 or to any value you specify.
• [11]: (Robotic instrument only) Turns to angles you specify, or to flip the 

instrument. 
• [12]: (Robotic instrument only) Starts the search target or LockNGo function 

or stops the one you last activated.
• [13]: Opens or creates a job where measurements will be stored.

Result pane:
(Item [14]) on the screen example.)
Depending on how you set the Display field on the Quick Shot tab (see [8] 
above), this pane will either provide the measured values of:
• Horizontal angle (HA), zenith angle (ZA) and slope distance (SD)
• Or horizontal angle (HA), horizontal distance (HD) and vertical distance (VD).

Tapping on the display over these labels will also toggle between the display 
modes.
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Target management:
(Item [15]) on the screen example.)
• HR field: Enter the height of rod for the selected target

•  /  button: Specify the type of target used. Also provides access to the 
management of smart targets.

• Choose the EDM measurement mode. This is an instrument-dependent 
setting but these are the usual available options:
– Standard: (Focus 30) Precise measurement mode, activated only when 

you trigger a measurement
– Tracking: (Focus 30) EDM continuously measuring distances
– Normal: (Nivo) Normal measurement mode
– Precise: (Nivo) Precise measurement mode

Other control buttons:
• [16]: A button equivalent to and bigger than button [3].
• [17]: Turns on or off the instrument’s track light. The track light is for helping 

the rodman stay online when staking. It will flash more quickly when the 
instrument is locked to the target.
The track light is instrument dependent. For example, the Focus 30 has two 
different colors (green and red) located on either side of the instrument. 
Nivo has two red colors, one that flashes and the other that doesn’t.

• [18]: Instrument dependent. Shows LockNGo status (IDLE, MEASURING or 
Locked). Also shows if the current measuring mode uses a prism or 
reflectorless target.
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Working With a Job Open If you open or create a job using button [13], the Quick Shot screen will then 
show different options.
Robotic Instrument:

Mechanical Instrument:

The differences are listed below:
• [10]: With a job open, the Quick Stake screen can be accessed through this 

button. The Stakeout, Station Setup and Check Setup functions can be 
accessed by clicking on the arrow to the left of this button.

• [11] and [12]: Same as with no job open. 
• [13]: With a job open, a sideshot can be taken and stored by pressing this 

button. The Sideshot and Traverse functions can be accessed by clicking on 
the arrow to the left of this button.

• [19]: The current station setup status is reported in this area.
• [20]: Use this area to name and describe each point you will be measuring 

and storing in the job. Make sure MSR Key= Measure and Store on the Quick 

[10] 

[11] 

[12] [19] 

[20] 

[13] 

[10] 

[13] 

[19] 

[20] 
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Shot tab if you plan to store measurement data (see [8] described earlier in 
this section).

With a job open, you can perform a lot of the most commonly used functions 
from the Quick Shot screen. To access the full set of Survey Pro functions, you 
can close the Quick Shot screen and access the Survey Pro main menu. Survey 
Pro can be used either in optical or leveling mode.

NOTE: To access the Quick Shot screen at any time, simply press the “star”/F1 hard key 
on the instrument.
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Appendix

Point Properties If you take a look at the points present in your job (go to the main menu, then 
select Job > Points), you will see that each point is defined with the following 
parameters:
• Point (Point name)
• Description. More details in next section.
• Code(s). More details on page 120.
• Coordinates (Northing, Easting, Elevation or Latitude, Longitude, Height, 

depending on the coordinate system defined for the job).
• Layer. More details on page 122.
• Control (“Yes” if the point was defined as a control point, “No” if not). This 

parameter is read-only.

At any time, from within this function, you can edit any of the listed points to 
modify one or more of these parameters.
Conversely, when collecting points in the field, the interface will never show the 
Description and Code(s) parameters at the same time, but only one of them, i.e. 
the one that beforehand, you will have chosen to display. To make that choice, 
go to the Home screen and select Settings> Coding and then set the Code or 
Desc field accordingly.
On the other hand, you may ask to be prompted for these parameters (+ the 
Layer parameter) JUST BEFORE Survey Pro actually stores the point. To 
configure Survey Pro to operate that way, go to Job > Settings and then open 
the Surveying tab. Check the options corresponding to the parameters you 
would like to key in just before the point is stored. On the Surveying tab, these 
options are:
• Prompt for Description
• Prompt for Code and Attributes
• Prompt for Layer.
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Descriptions
A description may be defined for each point you store in a job (e.g. tree, 
pavement). You can create a description list to automate the task of entering 
descriptions for points when they are stored. This is particularly useful when 
the same description is used frequently.
A description list is stored in Survey Pro as a description file (a TXT file you store 
in /Survey Pro Jobs/ for example), which may be in two different formats. 
Choosing one rather than the other determines how descriptions are entered:
• Description list without abbreviations [1]: Only contains the list of 

descriptions you want to use.
• Description list with abbreviations [2]: Similar to the previous one except 

an abbreviation precedes each description (with a space or tab in between). 

Go to Job> Settings> Coding to choose how you want to work with descriptions. 
Further down on this tab, you will find the following parameters that you can set 
at your convenience:
• Use Description Shortcuts File: Activate this parameter to use a description 

file that contains description shortcut abbreviations and click the 
associated Browse button to navigate to and select the file.
Description Shortcuts files contain one shortcut/description pair per line 
where the shortcut and description are separated by a space or a tab. (The 
shortcut cannot contain spaces.) 

• Use Description List File: Activate this parameter to use a description file 
containing a list of descriptions without abbreviations – one description per 
line and click the associated Browse button to navigate to and select the file.

• Load Description List from Job File: Activating this parameter results in 
descriptions used in the current job, as well as any new descriptions 
entered, to be included in the description list.

• Add New Descriptions to Description List: Activating this parameter results 
in only new descriptions entered since marking this box to be included in the 
description list. (If the preceding parameter is activated, new descriptions 
are added whether or not this parameter is marked.)

• Show Suggestion List Automatically: Activating this parameter results in a 
drop-down list of descriptions displayed as soon as text is entered into a 
Description: field. If this parameter is disabled, the list can be displayed by 
selecting Suggestion List using the  power button associated with a 
Description field.

[2][1]
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Codes
Codes can be used to quickly describe objects (points, lines), and in more detail 
than a standard text description, particularly when data is collected for several 
points that fit into the same object (e.g. a line).
Lists of codes are usually pre-defined and saved in xml format (file with fxl 
extension) for direct use in Survey Pro.
Go to Job> Settings> Coding to choose how you want to work with codes. 
Further down on this tab, you will find the following parameters that you can set 
at your convenience:
• Use Code Definition File: Activate this parameter to use a feature code file 

(*.FXL) with the current job. FXL files can be created and customized with 
Spectra’s Feature Definition Manager software. When this parameter is 
activated, tap the Browse button to select an FXL file.

• Show Suggestion List automatically: Activating this parameter results in a 
drop-down list of codes displayed as soon as text is entered into a Code: 
field. If this parameter is disabled, the list can be displayed by selecting 
Suggestion List using the  power button associated with a Code field. 
Double-clicking a code in the list will replace the entered text with the 
selected code.

Adding a Code to either the Traverse/Sideshot Screen or GNSS Data 
Collection screen: 
On either of these screens, if you start typing text in the Code: field and the 
Show Suggestion List automatically parameter has been activated beforehand, 
then Survey Pro will automatically display a list of matching codes from the FXL 
file, compatible with the first letter or letters you have just entered, thus making 
it quicker to choose the code you want to associate with the measurement you 
are about to do.
If the Show Suggestion List automatically parameter has been deactivated, 
then no list of recently used codes will be prompted but tapping  will give 
access to the following:
• {List of the most recently used codes}: You may select one from the list if it’s 

the one you are looking for.
• Pick Code: Allows you to select a code that has not been used yet in the job. 

When selecting this option, a new screen is displayed that shows the 
complete list of codes stored in the selected FXL file. Both abbreviation and 
plain definition are shown for each code. Select a row from the list and then 
tap . Survey Pro will then come back to the previous screen. In the Code: 
field, you will see the abbreviation corresponding to the selected code. Note 
that the list of codes may be first sorted out by code group before selecting 
a code. This is done using the  button and then selecting a code group.
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• Add/Edit Code: Allows you to associate several codes to the point you are 
about to measure. In addition, for each code you choose, you can edit the 
workline command assigned to it. When several codes are selected, the 
Code: field looks like this:

• Suggestion List: Same as Pick Code above except that Survey Pro still 
shows the same screen and the list of codes is shown in a drop-down menu 
attached to the Code: field.

Associating a linework command to a code: Most of the codes may be 
completed with a workline command more accurately defining what the 
concerned point represents in your job. Below is the list of the available 
commands:

(These commands can be customized using the Feature Definition Manager installed with Survey 
Office.)

To add a linework command, do the following after you have added/edited a 
code using the Add/Edit Code option in the drop-down menu attached to the 
Code: field:

• Tap  in the corresponding line to open the list of commands.
• Select one and tap . The line then shows an icon specific to, and 

representative of the command you have just selected (see screen 
example).

Command Command Name

ST StartLine

END EndLine

STA StartTangentArc

ETA EndTangentArc

SNTA StartNonTangentArc

ENTA EndNonTangentArc

IG DoNotJoinLine

JPT JointToPointNumber

CL CloseLine

SSC StartSmoothCurve

ESC EndSmoothCurve

SR StartRectangle

SCC StartCircleCenter

SCE StartCircleEdge

H HorizontalOffset

V VerticalOffset
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Layers
Layers help you manage the data in a job. Any number of layers can exist in a job 
and any new objects (points, polyline, alignments) can be assigned to any 
particular layer.
The visibility of any layer can be toggled on and off, which gives full control over 
the data that is displayed in a map view. This is useful to reduce clutter in a job 
that contains several objects.
Layers can be added, deleted and renamed with the exception of Layer 0 and 
the Control Layer. Layer 0 is a special layer that must exist in every job for 
compatibility with AutoCAD and for storing objects not assigned to any other 
layer. The Control layer is a special layer used by Survey Pro to denote control 
points in the job. Control points are protected and cannot be modified.
Use the Power button located near the Layer field to manage your layers. Use 
the Set Active button on the Manage Layers screen to set the default layer used 
in your measurements. 

Quick Codes Function
The Quick Codes function is available in both Optical and GNSS Surveying. It is 
particularly useful when you have to collect a series of points for which you 
anticipate that a different description or code will have to be defined for each 
new point you collect. 
• To access the function, go to the main menu and tap Survey > Quick Codes.

The Quick Codes function allows you to quickly choose a description or code 
from the displayed set of up to 10 descriptions or codes. Whether Survey Pro 
shows a set of codes or descriptions depends on the selection you’ve made 
in Job > Settings > Coding.
By default, Survey Pro only contains a single set of descriptions or codes but, 
using the big scroll-down button next to the displayed set, you may create 
new sets with more of your own descriptions or codes. Using the same 
scroll-down button, you may also rename or delete an existing set.
When several sets exist in Survey Pro, use the scroll-down list to select the 
set from which to pick a description or code.

• To toggle between Descriptions and Codes, go back to Job > Settings > 
Coding and change the selection in the Code or Desc. field.

• To define or change the description or code attached to a cell, tap and hold 
the cell until Survey Pro shows a new screen allowing you to define or change 
the Description or Code. An empty cell means the cell has no Description or 
Code attached to it.

• To store a point with a Description or Code, enter the point name and then 
tap on the cell holding the Description or Code you wish to assign to the 
point. Alternately you can press on the corresponding numeric key (0 to 9) on 
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the keyboard (there is a number shown to the right of each cell indicating 
which numeric key to press to select the Description or Code held by that 
cell). The point is then stored right away.

Notes
Survey Pro lets you attach one or more notes to each of your points so you can 
freely add any comment you will find useful to better describe them. Once 
created, a note CANNOT be deleted.
While modifying a point, do the following to add a note: 
• Tap on the Notes tab.
• Tap on the Add Note button.
• Tap your note in the upper edit field.
• When finished, tap Write Now! to validate the note.
• Tap  to return to the Notes tab. The new note appears at the bottom of the 

list. The note header shows the date and time when the note was created.

Survey Pro allows you to customize the note editor so you can enter your notes 
more quickly. Up to16 buttons are made available for this purpose. Through each 
of them, you can preset up to 127 characters of text and/or numerals, The label 
of each button (5 characters max., also editable). should reflect the character 
string held by the button.
While creating or modifying a point, do the following to customize a button:
• Tap on the Notes tab.
• Tap on the Add Note button.
• Tap Customize.
• Tap on the button you want to customize (for example “C2”). This opens the 

Code Edit screen on which you can define a new character string for the 
button. You can also change the label if appropriate.

• Tap  to validate the new button definition and return to the previous 
screen.

• Tap Customize again to end the button definition sequence.
• If you now tap the button you have just defined, this will preset the edit field 

with the new text held by the button. You may complete or modify this text if 
necessary before tapping Write Now! to validate your entry.

• As previously, tap  to return to the Notes tab.

Note the presence of the History tab, which you can use to list all the notes you 
have entered previously. These can be listed either in alphabetical order, from 
the most recent to the oldest, or from the most to the least frequently used.
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Raw Data Viewer
The Raw Data Viewer lists every action performed in the current job since it was 
created. The reported actions are always listed from the oldest (top of the list) 
to the most recent one (bottom of the list).
By default, each action is represented in one line but you can extend the line by 
tapping on the “+” sign to read more details on this action. Conversely, you can 
collapse the line by tapping the “-” sign
When you open the Raw Data Viewer from Job > View/Edit Raw Data, the last 
action will be highlighted. If you access the Raw Data Viewer while you are 
editing a point (i.e. by tapping View Raw on the Derivation tab), the viewer will 
spot the action the point originates from (manual entry, measured point, 
imported point, etc.).

Raw Data Viewer Toolbox
The Raw Data Viewer is fitted with a toolbox that you can use as explained 
below.

Icon Function

Takes you to the first action logged in the job.

Takes you to the last action logged in the job.

Takes you back to the previous action you highlighted in the list of actions.

Valid only after you have used the left-arrow button just above. Allows you to scroll back 
through the different actions you went through previously with the left-arrow button.

Opens the “Find Point” function where you can define a search criterion (point name).

Valid only after the Find Point function has been set. Takes you to the next occurrence 
of the point name in the list.

Allows you to add a note as a new entry at the bottom of the list of actions. Adding a 
note in this case is done in the same way as when adding one for a point.

Instantly adds the current date & time in a new line at the bottom of the list of actions.
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Editing Manual Shots
All manual shots performed in traverse/sideshot, repetition shots or leveling 
(single- or three-wire) may be edited from within the Raw Data Viewer:
• In the Raw/Data Viewer, tap and hold the stylus on the desired observation 

and select Edit Manual Shot Data. This opens the Enter Shot Data window 
showing the measurements currently stored for this observation.

• Correct the measurements as desired and then tap .
Following this action, the observation is automatically updated with the 
measurements you have just modified and all the points affected by this 
change are re-calculated as well.

Managing Smart Targets In earlier versions of Survey Pro, there was a separate list for backsight and 
foresight targets. From Survey Pro 5.2, there is now a single list of optical 
targets, so you can choose to take an observation to any target from any 
measurement routine.
This enhancement makes certain routines, such as repetition, multiple 
sideshots and shoot from two ends, much easier to use.
With all optical targets now managed from a single list of targets, you will notice 
some changes to the way “height of target” edit fields are handled in the case 
where you have a fixed backsight target defined in the station setup: When you 
choose your fixed backsight target as the target for the current observation, the 
edit field disappears and the height of the fixed backsight target is shown in 
static text next to the smart target selector. This prevents you from changing 
the height of the fixed backsight target.
When you upgrade to Survey Pro 5.2 or higher, you will notice that all of your 
optical targets are now merged into a single target selection list. There is no 
longer a separate list of backsight and foresight targets.
To make sure you select the target you are actually using, Survey Pro shows an 
icon that clearly identifies its type. Below are examples of targets and the way 
Survey Pro represents them on the Traverse/Sideshot screen.

In the list of existing targets, the currently active one is shown with a green tick 
over it (e.g. Trimble MultiTrack).

Icon Target type Icon Target Type Icon Target Type

Generic Trimble AT360 Trimble MultiTrack

Reflectorless Trimble R10 360°

Trimble 360° Spectra Geospatial 360°
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Electronic Compass Survey Pro can integrate the use of an electronic compass if the model of data 
collector you are using if fitted with one.

Setting the Electronic Compass
Go to Job > Settings. If your data collector is fitted with a built-in electronic 
compass, a Compass tab can be selected from the Settings screen. Open this 
tab. Different functions can be performed from this tab:
• Check or clear the Enable data collector compass box to respectively enable 

or disable the use of the electronic compass in Survey Pro.
• Enter the magnetic declination (in degrees and fractions of a degree)
• If the compass is active, view the compass reading:

• Calibrate the compass. The calibration procedure is specific to the model of 
data collector used. Usually however, you are requested to rotate the data 
collector in the vertical and/or horizontal plane. The data collector will 
provide the necessary instructions on the screen as you progress, until the 
procedure is complete.

Using the Electronic Compass
Once running and if properly calibrated, the electronic compass will assist you  
in the following ways while using Survey Pro:
• The current value of heading will continuously be displayed in the upper-left 

corner of the active map (e.g. Compass Heading: 111°)
• In optical stakeout, North and south indicators will be placed on the compass 

screen.
• In GNSS stakeout, for which these indications already exist without an 

electronic compass running, the heading value given by the compass being 
more accurate than the one provided by the GNSS –especially when the rover 
is stationary or moving slowly– the N/S indicators shown on the stakeout 
screen are those derived from the electronic compass, and not from the 
GNSS.

While staking out a point with the electronic compass active, the  button on the 
stakeout screen gives access to the compass settings as well.
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Quick Pick
This tool provides a shortcut to preset Survey Pro functions/routines. When you 
tap on the yellow star, you have direct access to a list of Survey Pro functions 
(the Quick Pick list). Just tap on one of the items in that list to run the 
corresponding function.
A list of functions is defined by default, picked from the different Survey Pro 
menus. You can customize the list by selecting Edit Quick Pick at the bottom of 
the Quick Pick list. This opens the quick pick editor (Quick Pick Editor).

In the right-hand pane, you can read the currently active shortcuts (i.e. the 
Survey Pro functions listed when tapping on the yellow star). In the left-hand 
pane, you can read the list of available functions per menu. Use the Menu Items 
field to select the menu you want to pick functions from. In this list, the 
functions already defined as shortcuts in the Quick Pick list are shown in bold 
characters.
For example, you want to add View Report in the Quick Pick list:
• Select Job from the Menu Items field.
• Scroll down the list of functions available from that menu until you can select 

View Report in the list.
• Tap on the Add --> button. The View Report function is added at the bottom 

of the Quick Pick list. It can now be run directly from this list.
• Tap  to save your changes and close the quick pick editor.

Other buttons are available in the quick pick editor:
• <-- Remove: Use this button to remove the function selected in the right-

hand pane from the Quick Pick list.
• Defaults: Use this button to revert to the default Quick Pick list. Confirmation 

is required before the default Quick Pick is restored.
• Move Up / Move Down: Use this button to rearrange your Quick Pick list. The 

selected function is respectively moved by one position, up or down 
respectively.
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RTX Correction Service RTX™ (for Real Time eXtended) is a Trimble worldwide service delivering 
corrections to RTX-enabled GNSS receivers allowing them to compute 
centimeter-accurate positions without the need to work from a particular base.
With Survey Pro, RTX corrections are delivered via the Internet. With the offered 
service (CenterPoint™ RTX), accuracy is 3.8 cm after 30 minutes of convergence 
time1 (accuracy is 30 cm after 10 minutes, 20 cm after 15 minutes).
RTX supports GPS, GLONASS, QZSS and BeiDou constellations.

NOTE: RTX corrections will be received only if your data collector is connected to the 
Internet.

Using an RTX-enabled GNSS receiver with Survey Pro:
• In Survey Pro, select Manage Instruments from the GNSS icon in the 

command bar, and then tap on Add Receiver Profile.
• Scan for an RTX-enabled GNSS receiver through Bluetooth. Wait until the 

scan is complete.
• Select the receiver from the list of Bluetooth-detected receivers, tap Next>, 

choose a “network type” profile for this receiver and then tap Finish.

• In the Receiver Profiles list, select the newly added receiver and tap .

• Select “RTX” from the Setup Type scroll-down list and tap 
• Go back to the Survey menu and tap Start Survey.
• Select the receiver from the list of receiver profiles and tap Connect directly 

(you don’t need to specify the network from which RTX corrections are 
delivered).
Survey Pro then tests the RTX service subscription validity. If you have 10 or 
less days left, a warning message will pop up prompting you to take the 
necessary steps to renew the subscription. If the subscription has expired, 
another message will show up reporting this situation and the receiver will 
not be allowed to proceed.
If the subscription is still valid, the message “Waiting for RTX engine to 
initialize...”is displayed. This initialization step may take a while. In the 
meantime, you can set the antenna (model, height value, height type) and 
possibly start raw data recording for further post-processing (see in the 
lower part of the screen).

NOTE: A message will be reported if initialization fails, prompting you to try again.

1. The convergence time is the time required before the expected, nominal accuracy is achieved for the delivered RTX positions.
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After the RTX engine has initialized, the message “Waiting for position to 
converge” is displayed (this step usually takes more time than RTX engine 
initialization). When the position has converged, the message “Rover 
receiver is ready to set. Press [Finish] to continue”.

• Tap Finish. You can now start collecting data.

NOTE: Convergence is achieved when the computed HRMS has been less than the 
requested value for five epochs in a row. The requested value of HRMS is the one 
specified on the RTX tab in Job >Settings>Meas. Mode.
If the HRMS box is left unchecked, Survey Pro will use a default value of 5 cm for the 
HRMS to decide on whether the position has converged or not.

Using the Quick Start Button to Reduce Convergence Time
While waiting for the position to converge, you may – with some GNSS receivers 
only – speed up the process by using the Quick Start procedure:
• Make sure the antenna height is set at the right value.
• Tap on the Quick Start button.
• Pick a point from the job where to start initialization (the location of this 

point in the field must be visible). Its coordinates must be geodetic ones (in 
ITRF2008 epoch 2005.0).

• Move your receiver in the field to the selected point and keep it motionless 
right over this point.

• Tap on the Start button. This button is changed into a Stop button. Wait until 
the process is complete, which is effective when the Stop button is changed 
into a Done button. 

• Tap Done. You can now start collecting data.
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Memo for GNSS Users Assuming the following:
• A receiver profile has been created previously so you can use your RTK rover 

in a network.
• If you are using a “network rover”, a network has also been defined previously 

for the purpose of receiving corrections from an IP server. (No network 
profile needs to be created if you are using a “rover” receiving corrections 
from a base via radio.)

• A new job file needs to be created in which a known coordinate system and 
a geoid are used.

Then proceed as indicated below:
• Turn on your receiver.
• Start Survey Pro on the data collector.
• Create a job in which you select the coordinate system and geoid used.
• Tap the instrument icon and select Switch to GNSS.
• Go to Survey >Start Survey.
• Select the receiver profile prepared earlier for your rover.
• Select the network used (skip this step if you are using a “rover”, and not a 

“network rover”).
• Tap Connect.
• Wait until the rover receives data from the base. 
• Confirm/change the point where the base is located.
• Set acceptance criteria for all your measurements.
• Make sure the receiver continuously delivers a “Fixed” position solution. (You 

may also go to Survey > GNSS Status to check the GNSS reception status 
and then come back to Survey > Data Collection.)

• Start collecting your data (points, offset points, lines). Data may be collected 
using one epoch of data (always the case when collecting data along a line), 
or by averaging the position through a static occupation on each point.

• When finished, select End Survey on the Home screen.
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